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Our mission is to help
healthcare professionals
deliver better products
and services, and to
make life more rewarding
and dignified for those
who use our products.



General Information

HCPCS Codes Disclaimer

The reimbursement information provided herein is intended to provide
general information concerning coding of Hollister products only. Hollister
does not guarantee coverage or payment for any products. The ultimate
responsibility for proper coding, satisfying reimbursement requirements,
and obtaining reimbursement remains with the provider. Coding and
coverage policies and guidelines are complex, can vary from one carrier
or region to another, and are updated frequently. Providers should check
with their local carriers or intermediaries often and should consult with
counsel, a reimbursement specialist, and/or the DMEGS website for any
coding, coverage, reimbursement, or billing questions.

HCPCS codes shown in this Product Catalog are current as of January 2016.

Latex Statement

The specifications for the Hollister Continence Care products listed
below include natural rubber latex as a component; our suppliers
add natural rubber latex as part of the production process.

If a Hollister product(s) found in this catalog is not listed below,

the specification for that product(s) and packaging does not include
natural rubber latex as a component, and our component suppliers
do not add natural rubber as part of their production process.

Current Stock Numbers:

1051 9107 9207 B12R B12RB
1067 9108 9208 B14R B14RB
1084 9109 9209 B16R B16RB
9106 9206



How to Use The Hollister Product Catalog
Hollister has created this simplified product catalog to help our
customers find what they need in a quick and efficient manner.

Ifyou...

know the stock number (or stock series number)

Go to the numeric index at the back of the catalog on pages 160-161
to find the page number where it appears.

Ifyou...

know the product brand or series name

Go to the Table of Contents on pages 5, 6-7, 86, 106 and 116
to find the page number where it appears or reference the Product Name
Index on pages 162—164.

Ifyou...
know the HCPCS code

Go to the HCPCS Code Index at the back of the catalog on page 165.
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Medicare Allowables Quick Reference Guide

General Medicare Product Maximum Allowables of
Selected Ostomy Products

Two-Piece Pouching Systems Maximum Quantity per Month

Flat, Standard Wear Skin Barriers with Floating Flanges 20
Drainable Pouches 20
Closed Pouches 60
Urostomy Pouches 20
Irrigator Sleeves 4
One-Piece Pouching Systems Maximum Quantity per Month
Drainable Pouches with Flat, Standard Wear Skin Barriers 20
Closed Pouches with Flat, Standard Wear Skin Barriers 60
Stoma Caps 31
Pediatric Pouching Systems Maximum Quantity per Month
One-Piece Drainable and Urostomy Pouches 20
Two-Piece Skin Barriers 20
Two-Piece Drainable and Urostomy Pouches 20
Two-Piece Mini-Pouches 60
Pediatric Ostomy Belt 1
Accessories Maximum Quantity per Month
Skin Barrier Rings *
Skin Barrier Paste 40z
Stoma Powder 10 0z/6 months
Lubricating Deodorant *
Ostomy Belt 1
Skin Protective Wipes 150/6 months

*There is currently not a defined usual maximum quantity. Therefore individual consideration
will determine how many are allocated per month.
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Medicare Utilization Chart

Medicare’s Usual Maximum Quantity for Ostomy Supplies

The quantity of ostomy supplies needed by a patient is determined
primarily by the type of ostomy, its location, its construction, and

the condition of the skin surface surrounding the stoma. There will be
variation according to individual patient need and their needs may vary
over time. The table below lists the maximum number of items/units

of service that are usually medically necessary. The actual quantity
needed for a particular patient may be more or less than the amount
listed depending on the factors that affect the frequency of barrier and
pouch change. The medical necessity for use of a greater quantity of
supplies than the amounts listed must be clearly documented in the
patient’s medical record, and must be available upon request. If adequate
documentation is not provided when requested, the excess quantities will
be denied as not medically necessary.

Per LCD for Ostomy Supplies (L33828), NHIC effective 10-1-2015.

A4331  Extension drainage tubing, any type, any length, with *
connector/adapter, for use with urinary leg bag
or urostomy pouch, each

A4357 Bedside drainage bag, day or night, with or without 2 ea/mo
anti-reflux device, with or without tube, each

A4361 Ostomy faceplate, each 3 ea/6 mo

A4362  Skin barrier, solid, 4 x 4 or equivalent, each 20 ea/mo

A4363  Ostomy clamp, any type, replacement only, each *

A4364 Adhesive, liquid or equal, any type, per ounce 4 0z/mo

A4366 Ostomy vent, any type, each *

A4367 Ostomy belt, each 1 ea/mo

A4368 Ostomy filter, any type, each *

A4369  Ostomy skin barrier, liquid (spray, brush, etc.), per ounce 2 0z/mo

A4371  Ostomy skin barrier, powder, per ounce 10 02/6 mo

A4372  Ostomy skin barrier, solid 4 x 4 or equivalent, standard wear *
with built-in convexity, each

A4373  Ostomy skin barrier, with flange (solid, flexible, or accordion), *
with built-in convexity, any size, each

A4375 Ostomy pouch, drainable, with faceplate attached, plastic, each *

A4376  Ostomy pouch, drainable, with faceplate attached, rubber, each *

A4377  Ostomy pouch drainable for use on faceplate, 10 ea/mo
plastic, each

A4378  Ostomy pouch, drainable, for use on faceplate, rubber, each *

A4379  Ostomy pouch, urinary, with faceplate attached, plastic, each
A4380 Ostomy pouch, urinary, with faceplate attached, rubber, each

*

*

A4381  Ostomy pouch, urinary, for use with faceplate, plastic, each 10 ea/mo

A4382  Ostomy pouch, urinary, for use on faceplate,
heavy plastic, each

A4383  Ostomy pouch, urinary, for use on faceplate, rubber, each
A4384  Ostomy faceplate equivalent, silicone ring, each

A4385  Ostomy skin barrier, solid 4 x 4 or equivalent, extended wear,
without built-in convexity, each

A4387  Ostomy pouch, closed, with barrier attached, with built-in
convexity (one-piece), each

A4388  Ostomy pouch, drainable, with extended wear barrier
attached, (one-piece), each

A4389  Ostomy pouch, drainable, with barrier attached, with built-in
convexity (one-piece), each

* No established usual maximum, refer to Medicare Utilization Guidelines.

*

*



Medicare Utilization Chart

A4390

A4391

A4392

A4393

A4394

A4395

A4396
A4397
A4398
A4399
A4402
A4404
A4405
A4406
A4407

A4408

A4409

A4410

Ad411

A4412

A4413

Ad414

A4415

A4416

Ad417

A4418

A4419

A4420

Ad421
A4422

Ostomy pouch, drainable, with extended wear barrier *
attached, with built-in convexity (one-piece), each

Ostomy pouch, urinary, with extended wear barrier *
attached (one-piece), each

Ostomy pouch, urinary, with standard wear barrier *
attached, with built-in convexity (one-piece), each

Ostomy pouch, urinary, with extended wear barrier *
attached, with built-in convexity (one-piece), each

Ostomy deodorant, with or without lubricant, for use in *
ostomy pouch, liquid, per fluid ounce

Ostomy deodorant for use in ostomy pouch, solid, *
per tablet

Ostomy belt with peristomal hernia support *
Irrigation supply, sleeve, each 4 ea/mo
Ostomy irrigation supply, bag, each 2 a/6 mo
Ostomy irrigation supply, cone/catheter, with or without brush 2 ea/6 mo
Lubricant, per ounce 4 0z/mo
Ostomy ring, each 10 ea/mo
Ostomy skin barrier, non-pectin based, paste, per ounce 4 0z/mo
Ostomy skin barrier, pectin-based, paste, per ounce 4 0z/mo
Ostomy skin barrier, with flange (solid, flexible, or *

accordion), extended wear, with built-in convexity,

4 x 4 inches or smaller, each

Ostomy skin barrier, with flange (solid, flexible, or accordion), *
extended wear, with built-in convexity, larger than 4 x 4

inches, each

Ostomy skin barrier, with flange (solid, flexible, or accordion), *
extended wear, without built-in convexity, 4 x 4 inches

or smaller, each

Ostomy skin barrier, with flange (solid, flexible, or accordion), *
extended wear, without built-in convexity, larger than 4 x 4

inches, each

Ostomy skin barrier, solid 4 x 4 or equivalent, extended

wear, with built-in convexity, each *
Ostomy pouch, drainable, high output, for use on a

barrier with flange (two-piece system), without filter, each *
Ostomy pouch, drainable, high output, for use on a *
barrier with flange (two-piece system), with filter, each

Ostomy skin barrier, with flange (solid, flexible, or 20 ea/mo
accordion), without built-in convexity, 4 x 4 inches or

smaller, each

Ostomy skin barrier, with flange (solid, flexible, or 20 ea/mo
accordion), without built-in convexity, larger than

4 x 4 inches, each

Ostomy pouch, closed, with barrier attached, with filter 60 ea/mo
(one-piece), each

Ostomy pouch, closed, with barrier attached, with 60 ea/mo
built-in convexity, with filter (one-piece), each

Ostomy pouch, closed, without barrier attached, with 60 ea/mo
filter (one-piece), each

Ostomy pouch, closed, for use on barrier with 60 ea/mo
non-locking flange, with filter (two-piece), each

Ostomy pouch, closed, for use on barrier with locking 60 ea/mo
flange (two-piece), each

Ostomy supply; miscellaneous *

Ostomy absorbent material (sheet/pad/crystal packet)
for use in ostomy pouch to thicken liquid stomal
output, each

* No established usual maximum, refer to Medicare Utilization Guidelines.



A4423  Ostomy pouch, closed, for use on barrier with locking 60 ea/mo
flange, with filter (two-piece), each

A4424  Ostomy pouch, drainable, with barrier attached, with filter 20 ea/mo
(one-piece), each

A4425  Ostomy pouch, drainable, for use on barrier with 20 ea/mo
non-locking flange, with filter (two-piece system), each

A4426  Ostomy pouch, drainable, for use on barrier with 20 ea/mo
locking flange (two-piece system), each

A4427  Ostomy pouch, drainable, for use on barrier with 20 ea/mo
locking flange, with filter (two-piece system) each

A4428  Ostomy pouch, urinary, with extended wear barrier *

attached, with faucet-type tap with valve (one-piece), each

A4429  Ostomy pouch, urinary, with barrier attached, with built-in 20 ea/mo
convexity, with faucet-type tap with valve (one-piece), each

A4430 Ostomy pouch, urinary, with extended wear barrier *
attached, with built-in convexity, with faucet-type tap
with valve (one-piece), each

A4431  Ostomy pouch, urinary, with barrier attached, with 20 ea/mo
faucet-type tap, with valve (one-piece), each
A4432  Ostomy pouch, urinary, for use on barrier with 20 ea/mo

non-locking flange, with faucet-type tap with valve
(two-piece), each

A4433  Ostomy pouch, urinary, for use on barrier with 20 ea/mo
locking flange (two-piece), each
A4434  Ostomy pouch, urinary, for use on barrier with 20 ea/mo

locking flange, with faucet-type tap with valve
(two-piece), each
A4435 Ostomy pouch, drainable, high output, with extended *
wear barrier (one-piece system), with or without filter, each
A4450 Tape, non-waterproof, per 18 square inches 40 ea (18 sq in)/mo
A4452  Tape, waterproof, per 18 square inches 40 ea (18 sq in)/mo

A4455  Adhesive remover or solvent (for tape, cement, or other 16 02/6 mo
adhesive), per ounce

A4456  Adhesive remover, wipes, any type, each *

A5051  Ostomy pouch, closed, with barrier attached 60 ea/mo
(one-piece), each

A5052  Ostomy pouch, closed, without barrier attached, 60 ea/mo
(one-piece), each

A5053  Ostomy pouch, closed, for use on faceplate, each 60 ea/mo

A5054  Ostomy pouch, closed, for use on barrier with flange 60 ea/mo
(two-piece), each

A5055  Stoma Cap 31 ea/mo

A5056  Ostomy pouch, drainable, with extended wear barrier 40 ea/mo
attached, with filter, (one-piece), each

Ab057  Ostomy pouch, drainable, with extended wear barrier 40 ea/mo
attached, with built-in convexity, with filter, (one-piece), each

A5061  Ostomy pouch, drainable, with barrier attached 20 ea/mo
(one-piece), each

A5062 Ostomy pouch, drainable, without barrier attached 20 ea/mo
(one-piece), each

A5063 Ostomy pouch, drainable, for use on barrier with flange 20 ea/mo
(two-piece system), each

A5071  Ostomy pouch, urinary, with barrier attached 20 ea/mo
(one-piece), each

A5072  Ostomy pouch, urinary, without barrier attached 20 ea/mo
(one-piece), each

A5073  Ostomy pouch, urinary, for use on barrier with flange 20 ea/mo

(two-piece), each

* No established usual maximum, refer to Medicare Utilization Guidelines.
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Medicare Utilization Chart

HCPCS Long Description Quantity
A5081  Continent device, plug for continent stoma 31 ea/mo
A5082  Continent device, catheter for continent stoma 1 ea/mo
A5083  Continent device, stoma absorptive cover for continent stoma 150 ea/mo
A5093  Ostomy accessory, convex insert 10 ea/mo
A5102 Bedside drainage bottle with or without tubing, rigid or 2 ea/6 mo

expandable, each
A5120  Skin barrier, wipes or swabs, each 150 ea/6 mo
A5121  Skin barrier, solid, 6 x 6 or equivalent, each 20 ea/mo
A5122  Skin barrier, solid, 8 x 8 or equivalent, each 20 ea/mo
A5126  Adhesive or non-adhesive, disk or foam pad 20 ea/mo
A5131  Appliance cleaner, incontinence and ostomy 1 ea (16 0z btl)/mo
appliances, per 16 ounce
A6216  Gauze, non-impregnated, non sterile, pad size 16 sq in 60 ea/mo
or less, without adhesive border, each dressing
A9270 Non-covered item or service *

* No established usual maximum, refer to Medicare Utilization Guidelines.

2 DID YOU KNOW...

How to Size Hollister Ostomy Pouches

A properly-fitted pouching system is essential to minimize stomal and skin
irritation, and to obtain optimum pouch wear time. A stoma measuring
guide allows correct measurement of the stoma. Measure the stoma
accurately. Select the smallest barrier opening which fits comfortably
around the stoma without actually touching it. Too large of an opening
will leave skin exposed and could lead to skin irritation or erosion.

11
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Two-Piece
Pouching System

Hollister Ostomy. Details Matter.




The CeraPlus™ skin barrier

with Remois technology*

At Hollister, we realize the importance of healthy peristomal skin.

Our latest skin barrier is infused with ceramide, the skin’s naturally
occurring protection against dryness. The CeraPlus skin barrier is
designed to maintain adhesive properties, and features a proprietary
formulation designed to help protect the skin’s own moisture barrier.
The CeraPlus skin barrier from Hollister—because peristomal skin

deserves better.

Hollister Ostomy. Details Matter.

. “Remois is a technology of Alcare Co., Ltd.
Remois

See pages 14, 17, 18 for New Image Stock Numbers or contact your

Hollister Ostomy Sales Specialist for details.

% Hollister.

© 2016 Hollister Incorporated.



New Image Two-Piece Pouching System

Color Matching System

To help you select compatible New Image pouching system components,
every box label is color-coded. First, select the proper skin barrier; then
select a matching color-coded pouch (“red” skin barrier box label is
compatible to “red” pouch box label).

4
(102 mm)
Flat Skin Barriers with Integrated Floating Flange
1120x (CUT-TO-FIT) Box of 5
’ @ > CeraPlus (extended wear) Skin Barrier
» With Tape Border
HCPCS: A4409
Stock No Flange Size For Stomas Up To
11202 @& 1-3/4" (44 mm) 1-1/4” (32 mm)
11203 @ 2-1/4" (57 mm) 1-3/4” (44 mm)
11204 & 2-3/4" (70 mm) 2-1/4” (57 mm)
J 1510x (CUT-TO-FIT) Box of 5
SU_ ﬁ > CeraPlus (extended wear) Skin Barrier
— > Without Tape Border NEW
HCPCS for 15102, 15103: A4409
HCPCS for 15104: A4410
Stock No Flange Size For Stomas Up To
15102 @& 1-3/4" (44 mm) 1-1/4” (32 mm)
15103 @ 2-1/4 (57 mm) 1-3/4” (44 mm)
15104 & 2-3/4" (70 mm) 2-1/4” (57 mm)
¥ ;‘. 1460x (CUT-TO-FIT) Box of 5
' > Flextend (extended wear) Skin Barrier
> With Tape Border
HCPCS for 14602, 14603 & 14604: A4409
HCPCS for 14606: A4410
Stock No Flange Size For Stomas Up To
14602 @& 1-3/4" (44 mm) 1-1/4" (32 mm)
14603 @ 2-1/4" (57 mm) 1-3/4" (44 mm)
14604 @ 2-3/4" (70 mm) 2-1/4" (57 mm)
14606 4" (102 mm) 3-1/2" (89 mm)
' 1560x (CUT-TO-FIT) Box of 5
g > Flextend (extended wear) Skin Barrier
» Without Tape Border
HCPCS for 15602 & 15603: A4409
HCPCS for 15604: A4410
Stock No Flange Size For Stomas Up To
15602 @ 1-3/4" (44 mm) 1-1/4" (32 mm)
15603 @ 2-1/4" (57 mm) 1-3/4" (44 mm)
15604 @ 2-3/4" (70 mm) 2-1/4" (57 mm)
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Flat Skin Barriers with Integrated Floating Flange (continued)

1420x (CUT-TO-FIT) Box of 5
> FlexWear (standard wear) Skin Barrier
» With Tape Border
HCPCS for 14202, 14203 & 14204: A4414
HCPCS for 14206: A4415
Stock No Flange Size For Stomas Up To
14202 @ 1-3/4" (44 mm) 1-1/4" (32 mm)
14203 @ 2-1/4" (57 mm) 1-3/4" (44 mm)
14204 @ 2-3/4" (70 mm) 2-1/4" (57 mm)
14206 4" (102 mm) 3-1/2" (89 mm)
X (CUT-TO-FIT) 0X 0!
- 1520 Box of 5
i > FlexWear (standard wear) Skin Barrier
» Without Tape Border
HCPCS for 15202 & 15203: A4414
HCPCS for 15204: A4415
Stock No Flange Size For Stomas Up To
15202 @ 1-3/4" (44 mm) 1-1/4" (32 mm)
15203 @ 2-1/4" (57 mm) 1-3/4" (44 mm)
15204 @ 2-3/4" (70 mm) 2-1/4" (57 mm)
~ 1470x (PRE-SIZED) Box of 5
L8 > Flextend (extended wear) Skin Barrier
" » With Tape Border
HCPCS: A4409
Stock No Flange Size Barrier Opening
14701 @ 1-3/4" (44 mm) 5/8" (16 mm)
14702 @ 1-3/4" (44 mm) 3/4" (19 mm)
14703 @ 1-3/4" (44 mm) 7/8" (22 mm)
14704 @ 1-3/4" (44 mm) 1" (25 mm)
14705 @ 1-3/4" (44 mm) 1-1/8" (29 mm)
14706 @ 1-3/4" (44 mm) 1-1/4" (32 mm)
14707 @ 2-1/4" (57 mm) 1-3/8" (35 mm)
14708 @ 2-1/4" (57 mm) 1-1/2" (38 mm)
14709 @ 2-1/4" (57 mm) 1-3/4" (44 mm)
. 1610x (PRE-SIZED) Box of 5
> Flextend (extended wear) Skin Barrier
— » Without Tape Border
HCPCS: A4409
Stock No Flange Size Barrier Opening
16101 @ 1-3/4" (44 mm) 5/8" (16 mm)
16102 1-3/4" (44 mm) 3/4" (19 mm)
16103 @ 1-3/4" (44 mm) 7/8" (22 mm)
16104 @ 1-3/4" (44 mm) 1" (25 mm)
16105 @ 1-3/4" (44 mm) 1-1/8" (29 mm)
16106 @ 1-3/4" (44 mm) 1-1/4" (32 mm)
16107 @ 2-1/4" (57 mm) 1-3/8" (35 mm)
16108 @ 2-1/4" (57 mm) 1-1/2" (38 mm)




New Image Two-Piece Pouching System

Flat Skin Barriers with Integrated Floating Flange (continued)

1430x (PRE-SIZED) Box of 5
@ﬁ > FlexWear (standard wear) Skin Barrier
» With Tape Border

HCPCS: A4414
Stock No Flange Size Barrier Opening
14301 @ 1-3/4" (44 mm) 5/8" (16 mm)
14302 @ 1-3/4" (44 mm) 3/4" (19 mm)
14303 @ 1-3/4" (44 mm) 7/8" (22 mm)
14304 @ 1-3/4" (44 mm) 1" (25 mm)
14305 @ 1-3/4" (44 mm) 1-1/8" (29 mm)
14306 @ 1-3/4" (44 mm) 1-1/4" (32 mm)
14307 @ 2-1/4" (57 mm) 1-3/8" (35 mm)
14308 @ 2-1/4" (57 mm) 1-1/2" (38 mm)
14309 @ 2-1/4" (57 mm) 1-3/4" (44 mm)
=, o 1640x (PRE-SIZED) Box of 5

- > FlexWear (standard wear) Skin Barrier
SR - Without Tape Border

HCPCS: A4414
Stock No Flange Size Barrier Opening
16401 @ 1-3/4” (44 mm) 5/8” (16 mm)
16402 @ 1-3/4" (44 mm) 3/4” (19 mm)
16403 @ 1-3/4” (44 mm) 7/8” (22 mm)
16404 @ 1-3/4” (44 mm) 17 (25 mm)
16405 @ 1-3/4” (44 mm) 1-1/8” (29 mm)
16406 @ 1-3/4” (44 mm) 1-1/4” (32 mm)
16407 @ 2-1/4” (57 mm) 1-3/8” (35 mm)
16408 @ 2-1/4" (57 mm) 1-1/2” (38 mm)
: 1410x (SHAPE-TO-FIT) Box of 5

o’ Q > Formaflex (extended wear) Skin Barrier
» With Tape Border

HCPCS: A4409
Stock No Flange Size For Stomas Up To
14102 @ 1-3/4” (44 mm) 1/27-1-1/4” (32 mm)
14103 @ 2-1/4” (57 mm) 1/2"-1-11/16" (43 mm)
14104 @ 2-3/4” (70 mm) 5/8"-2-1/4" (57 mm)

2  DID YOU KNOW...

A True Original

The Hollister integrated floating flange—as featured
in the New Image two-piece pouching system—offers
optimal flexibility and security for you and your
patients. The first of its kind, this integrated
floating flange helps relieve pressure on

the tender postoperative or soft abdomen
while offering an easy-to-use, low-profile
solution patients can continue to use after
they transition home. Included in all flat and
convex New Image skin barriers.
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Convex Skin Barriers with Integrated Floating Flange

1140x (CUT-TO-FIT)

Box of 5

> CeraPlus (extended wear) Skin Barrier ( bONVEX

» With Tape Border

HCPCS: A4407
Stock No Flange Size For Stomas Up To
11402 @ 1-3/4” (44 mm) 1” (25 mm)
11403 @ 2-1/4” (57 mm) 1-1/2” (38 mm)
11404 @& 2-3/4” (70 mm) 2" (51 mm)
" 1530x (CUT-TO-FIT) Box of 5
M > CeraPlus (extended wear) Skin Barrier (
» Without Tape Border CONVEX
HCPCS for 15302, 15303: A4407 NEW
HCPCS for 15304: A4408
Stock No Flange Size For Stomas Up To
15302 @& 1-3/4” (44 mm) 1" (25 mm)
15303 @ 2-1/4” (57 mm) 1-1/2” (38 mm)
15304 @& 2-3/4” (70 mm) 2" (51 mm)
F . 1480x (CUT-TO-FIT) Box of 5
g > Flextend (extended wear) Skin Barrier (
» With Tape Border CONVEX
HCPCS: A4407
Stock No Flange Size For Stomas Up To
14802 @ 1-3/4” (44 mm) 1" (25 mm)
14803 @ 2-1/4" (57 mm) 1-1/2” (38 mm)
14804 @ 2-3/4” (70 mm) 2" (51 mm)
- 1580x (CUT-TO-FIT) Box of 5
M > Flextend (extended wear) Skin Barrier .
» Without Tape Border < convex
HCPCS for 15802 & 15803: A4407
HCPCS for 15804: A4408
Stock No Flange Size For Stomas Up To
15802 @ 1-3/4” (44 mm) 17 (25 mm)
15803 @ 2-1/4” (57 mm) 1-1/2” (38 mm)
15804 @& 2-3/4” (70 mm) 2" (51 mm)
! e 1340x (CUT-TO-FIT) Box of 5
> FlexWear (standard wear) Skin Barrier =
> With Tape Border < convex
UPGRADED DESIGN
HCPCS: A4373 See page 31 for details
Stock No Flange Size For Stomas Up To
13402 @ 1-3/4” (44 mm) 1” (25 mm)
13403 @ 2-1/4” (57 mm) 1-1/2” (38 mm)
13404 @& 2-3/4” (70 mm) 2" (51 mm)
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New Image Two-Piece Pouching System

Convex Skin Barriers with Integrated Floating Flange (continued)

ﬁ 1540x (CUT-TO-FIT) Box of 5
h > FlexWear (standard wear) Skin Barrier -
» Without Tape Border ( CONVEX
HCPCS: A4373
Stock No Flange Size For Stomas Up To
15402 @ 1-3/4" (44 mm) " (25 mm)
15403 @ 2-1/4 (57 mm) 1-1/2" (38 mm)
15404 @ 2-3/4" (70 mm) 2" (51 mm)
g e 1150x (PRE-SIZED) Box of 5
> CeraPlus (extended wear) Skin Barrier
. » With Tape Border (CONVEX
HCPCS: A4407
Stock No Flange Size Barrier Opening
11503 @& 1-3/4" (44 mm) 7/8" (22 mm)
11504 @& 1-3/4" (44 mm) 1" (25 mm)
11505 @ 2-1/4 (57 mm) 1-1/8" (29 mm)
11506 @& 2-1/4" (57 mm) 1-1/4” (32 mm)
139xx (PRE-SIZED) Box of 5
g > Flextend (extended wear) Skin Barrier (
. > With Tape Border - CONVEX
UPGRADED DESIGN
HCPCS: A4407 See page 31 for details
Stock No Flange Size Barrier Opening
13901 @ 1-3/4" (44 mm 5/8" (16 mm
13902 @ 1-3/4" (44 mm 3/4” (19 mm
13903 @ 1-3/4" (44 mm 7/8" (22 mm
13904 @ 1-3/4 (44 mm 1" (25 mm
13905 @ 2-1/4” (57 mm 1-1/8” (29 mm
13906 @ 2-1/4" (57 mm 1-1/4" (32 mm
13907 @ 2-1/4" (57 mm 1-3/8" (35 mm
13908 @D 2-1/4" (57 mm 1-1/2" (38 mm
13909 @ 2-3/4" (70 mm 1-5/8” (41 mm
13910 @ 2-3/4" (70 mm 1-3/4” (44 mm
13911 @ 2-3/4 (70 mm 2" (51 mm

2 | DID YOU KNOW...

Convex Skin Barrier Options

The New Image two-piece pouching system delivers several skin barrier
options to fit a variety of patient needs. Built-in convexity options provide
extra security for recessed and flush stomas, and soft peristomal skin.
Convex skin barriers are also available with and without tape.




Convex Skin Barriers with Integrated Floating Flange (continued)

n 1590x (PRE-SIZED) Box of 5
> Flextend (extended wear) Skin Barrier ( CONVEX

» Without Tape Border

HCPCS: A4407
Stock No Flange Size Barrier Opening
15903 @& 1-3/4” (44 mm) 7/8” (22 mm)
15904 @& 1-3/4 (44 mm) 1" (25 mm)
15905 @ 2-1/4” (57 mm) 1-1/8” (29 mm)
15906 @ 2-1/4" (57 mm) 1-1/4” (32 mm)

o 1350x (PRE-SIZED) Box of 5
> FlexWear (standard wear) Skin Barrier .
g‘ » With Tape Border ( CONVEX

UPGRADED DESIGN

HCPCS: A4373 See page 31 for details
Stock No Flange Size Barrier Opening
13503 @ 1-3/4" (44 mm) 7/8" (22 mm)
13504 @ 134 (44 mm) 1" (25 mm)
13505 @ 2-1/4” (57 mm) 1-1/8” (29 mm)
13506 @ 2-1/4” (57 mm) 1-1/4” (32 mm)

u @ 1550x (PRE-SIZED) Box of 5

> FlexWear (standard wear) Skin Barrier (
» Without Tape Border - CONVEX

HCPCS: A4373
Stock No Flange Size Barrier Opening
15503 @ 1-3/4” (44 mm) 7/8" (22 mm)
15504 @ 1-3/4” (44 mm) 1" (25 mm)
15505 @ 2-1/4” (57 mm) 1-1/8” (29 mm)
15506 @ 2-1/4” (57 mm) 1-1/4” (32 mm)

Looking for

1440x,149xx,1450x?

Go to page 30 to see these stock
numbers and the upgraded
version that we recommend.

Original stock numbers can still be ordered.
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New Image Two-Piece Pouching System

Drainable Pouches

1818x/1819x Box of 10
» Drainable Pouch
o » With Integrated AF300 Filter
i > Lock 'n Roll Microseal Closure
» Odor-Barrier Rustle-Free Film
» With Belt Tabs
» With ComfortWear Panels
- Transparent — Body Side Only
- Beige — Both Sides

HCPCS: A4425
Transparent Beige Flange Pouch
Stock No Stock No Size Length
18192 18182 @ 1-3/4” (44 mm) 12" (30 cm)
18193 18183 @ 2-1/4 57 mm) 12" (30 cm)
18194 18184 @& 234 (70 mm) 12" (30 cm)
1828x/1829x Box of 20

» Drainable Mini-Pouch

» With Integrated AF300 Filter

> Lock 'n Roll Microseal Closure

» Odor-Barrier Rustle-Free Film

» With Belt Tabs

» With ComfortWear Panels
- Transparent — Body Side Only
- Beige — Both Sides

HCPCS: A4425
Transparent Beige Flange Pouch
Stock No Stock No Size Length
18292 18282 @ 1-3/4” (44 mm) 7" (18 cm)
18293 18283 @ 2-1/4” (57 mm) 7" (18 cm)
18294 18284 @ 234 70 mm) 7" (18 cm)
1811x/1813x/1800x Box of 10

» Drainable Pouch
> Without Integrated Filter
F > Lock 'n Roll Microseal Closure
» Odor-Barrier Rustle-Free Film — Transparent and Beige
» Odor-Barrier Film — Ultra-Clear
> With Belt Tabs
» With ComfortWear Panels
- Transparent and Ultra-Clear — Body Side Only
- Beige — Both Sides

HCPCS: A5063

Ultra-Clear Transparent  Beige Flange Pouch
Stock No Stock No  Stock No Size Length
18002 18132 18112 @ 1-3/4” (44 mm) 12" (30 cm)
18003 18133 18113 @ 2-1/4" (57 mm) 12" (30 cm)
18004 18134 18114 @ 2-3/4" (70 mm) 12 (30 cm)
18006 — — 4" (102 mm) 2" (30 cm)
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Drainable Pouches (continued)

e Each box of New Image pouches includes one disposal
bag per pouch for discreet disposal.

- 1814x/1816x Box of 10
- > Drainable Pouch Includes 1 clamp
1 > With Integrated AF300 Filter
> Clamp Closure
» Odor-Barrier Rustle-Free Film
» With Belt Tabs
—_— » With ComfortWear Panels
- Transparent — Body Side Only
- Beige — Both Sides
HCPCS: A4425
Transparent Beige Flange Pouch
Stock No Stock No Size Length
18162 18142 @ 1-3/4" (44 mm) 12” (30 cm)
18163 18143 @ 2-1/4" (57 mm) 12" (30 cm)
18164 18144 @ 2-3/4” (70 mm) 12" (30 cm)
1810x/1812x/1817x Box of 10
» Drainable Pouch Includes 1 clamp
» Without Integrated Filter
> Clamp Closure
» Odor-Barrier Rustle-Free Film — Transparent and Beige
» Qdor-Barrier Film — Ultra-Clear
e > With Belt Tabs
» With ComfortWear Panels
- Transparent and Ultra-Clear — Body Side Only
- Beige — Both Sides
HCPCS: A5063
Ultra-Clear Transparent  Beige Flange Pouch
Stock No Stock No  Stock No Size Length
18172 18102 18122 @ 1-3/4” (44 mm) 12" (30 cm)
18173 18103 18123 @ 2-1/4" (57 mm) 12" (30 cm)
18174 18104 18124 @ 2-3/4" (70 mm) 12" (30 cm)
18176 — — 4”(102mm) 12" (30 cm)
1820x Box of 10
> Drainable Mini-Pouch Includes 1 clamp
» Without Integrated Filter
» Clamp Closure
» Qdor-Barrier Rustle-Free Film
— > With Belt Tabs
» With ComfortiWear Panels — Both Sides
HCPCS: A5063
Beige Flange Pouch
Stock No Size Length
18202 @& 1-3/4" (44 mm) 9" (23 cm)
18203 @ 2-1/4" (57 mm) 9" (23 cm)
18204 @& 2-3/4" (70 mm) 9" (23 cm)
DID YOU KNOW...

* Most boxes of urostomy pouches include one urostomy tube

adapter. The 189xx series comes with two adapters.
e Cutting guides are provided for all cut-to-fit barriers.
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New Image Two-Piece Pouching System

High Output Drainable Pouches

1801x Box of 10
» Drainable Pouch

» Without Integrated Filter

» Soft Tap

» Qdor-Barrier Film

» With Belt Tabs

» With ComfortiWear Panel — Body Side Only

HCPCS: A4412
Ultra-Clear Flange Pouch
Stock No Size Length
18012 @ 1-3/4" (44 mm) 12" (30 cm)
18013 @ 2-1/4" (57 mm) 12” (30 cm)
18014 @ 2-3/4 (70 mm) 12” (30 cm)
18016 4” (102 mm) 12” (30 cm)
Closed Pouches
- 1836x/1837x Box of 60
} » Closed Pouch
EI" » With Integrated AF300 Filter
] » Odor-Barrier Rustle-Free Film
> With Belt Tabs
» With ComfortWear Panels
- Transparent — Body Side Only
- Beige — Both Sides
HCPCS: A4419
Transparent Beige Flange Pouch
Stock No Stock No Size Length
18362 18372 @ 1-3/4 (44 mm) 9” (23 cm)
18363 18373 @ 2-1/4” (57 mm) 9” (23 cm)
18364 18374 @ 2-3/4" (70 mm) 9” (23 cm)
1832x Box of 30
» Closed Pouch
> With Integrated AF300 Filter
» With Belt Tabs
» With QuietWWear Pouch Material
HCPCS: A4419
Beige Flange Pouch
Stock No Size Length
18322 @ 1-3/4 (44 mm) 9” (23 cm)
18323 @ 2-1/4” (57 mm) 9” (23 cm)
18324 @ 2-3/4 (70 mm) 9” (23 cm)
DID YOU KNOW...

New Image Two-Piece Pouching System Features

QuietWear Material for Enhanced Discretion

Hollister Ostomy offers many choices for patients—including
the unique option of QuietWear pouch material on select closed pouches
that reduces the noise that can be experienced with other pouches.
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Closed Pouches (continued)

=y 1838x/1839x Box of 60
'-': i > Closed Mini-Pouch
- » With Integrated AF300 Filter
» With Belt Tabs
» With ComfortWear Panels
- Transparent — Body Side Only
- Beige — Both Sides
HCPCS: A4419
Transparent Beige Flange Pouch
Stock No Stock No Size Length
18382 18392 @ 1-3/4” (44 mm) 7" (18 cm)
18383 18393 @ 2-1/4 57 mm) 7" (18 cm)
18384 18394 @& 234 (70 mm) 7" (18 cm)
1833x Box of 30
1873x Box of 60
- > Closed Pouch
_— » Without Integrated Filter
> With Belt Tabs
» With QuietiWear Pouch Material
HCPCS: A5054
Beige Beige
Stock No Stock No Flange Pouch
Box of 30 Box of 60 Size Length
18332 18732 @ - 3/4 (44 mm) 9" (23 cm)
18333 18733 @ 2-1/4” (57 mm) 9" (23 cm)
18334 18734 @ - /4 (70 mm) 9" (23 cm)
= 1835x Box of 30
"~ 1875x Box of 60
- - o
h‘-‘ " > Closed Mini-Pouch
» Without Integrated Filter
» Qdor-Barrier Rustle-Free Film
> With Belt Tabs
» With ComfortiWear Panels — Both Sides
HCPCS: A5054
Beige Beige
Stock No Stock No Flange Pouch
Box of 30 Box of 60 Size Length
18352 18752 @ 1-3/4” (44 mm) 7" (18 cm)
18353 18753 @ 2-1/4” (57 mm) 7" (18 cm)
18354 18754 @ 234 (70 mm) 7" (18 cm)

Irrigator Sleeve - see page 73
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New Image Two-Piece Pouching System

Urostomy Pouches

1890x/1891x/1892x Box of 10
» Urostomy Pouch Includes 2 adapters
> Anti-Reflux Valve

» Qdor-Barrier Rustle-Free Film

! » Odor-Barrier Film — Ultra-Clear

» With Belt Tabs

- > With ComfortiWear Panels
- Transparent and Ultra-Clear — Body Side Only
- Beige — Both Sides
HCPCS: A4432
Ultra-Clear Transparent  Beige Flange Pouch
Stock No Stock No  Stock No Size Length
18922 18902 18912 @& 1-3/4" (44 mm) 9" (23 cm)
18923 18903 18913 @ 2-1/4” (57 mm) 9" (23 cm)
18924 18904 18914 @& 2-3/4" (70 mm) 9" (23 cm)

The original Urostomy series of
1840x/1841x/1842x

has evolved to
1890x/1891x/1892x

Our 1890x series of New Image urostomy pouches

feature a softer, more streamlined tap with attached cap
designed to help provide increased comfort. Plus, a unique
multi-chamber design helps distribute urine evenly in the
pouch, for a more discreet profile. The1890x series is our

most advanced urostomy pouching system ever.
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Non Sterile Kits — Drainable

1900x Box of 5
' Colostomy/lleostomy Kit includes:

> (1) 1420x FlexWear Skin Barrier with Tape Border

> (1) 1800x (Lock 'n Roll Microseal Closure) Ultra-Clear
iy, > (1) 7767 Loop Ostomy Bridge (in 19006 only)

> Single-Use Package

HCPCS for 19002, 19003 & 19004: A5063 + A4414
HCPCS for 19006: A5063 + A4415

Ultra-Clear Flange
Stock No Size For Stomas Up To
19002 @ 1-3/4 (44 mm) 1-1/4” (32 mm)
19003 @ 2-1/4" (57 mm) 1-3/4” (44 mm)
19004 @& 2-3/4" (70 mm) 2-1/4” (57 mm)
19006 4" (102 mm) 3-1/2" (89 mm)
1910x Box of 5
- - Colostomy/lleostomy Kit includes:
> (1) 1420x FlexWear Skin Barrier with Tape Border
—1 > (1) 1817x (Clamp Closure) Ultra-Clear

> (1) 7767 Loop Ostomy Bridge (in 19106 only)
» Single-Use Package

HCPCS for 19102, 19103 & 19104: A5063 + A4414
HCPCS for 19106: A5063 + A4415

Ultra-Clear Flange

Stock No Size For Stomas Up To

19102 @ 1-3/4" (44 mm) 1-1/4” (32 mm)

19103 @ 2-1/4" (57 mm) 1-3/4” (44 mm)

19104 @& 2-3/4" (70 mm) 2-1/4” (57 mm)

19106 4" (102 mm) 3-1/2" (89 mm)
1930x Box of 5

- Colostomy/lleostomy Kit includes:
Cj— > (1) 1410x FormaFlex Skin Barrier with Tape Border

> (1) 1800x (Lock 'n Roll Microseal Closure) Ultra-Clear
> Single-Use Package

HCPCS: A5063 + A4409

Ultra-Clear Flange

Stock No Size For Stomas Up To
19303 @ 2-1/4" (57 mm) 1-3/4” (44 mm)
19304 @& 2-3/4" (70 mm) 2-1/4” (57 mm)
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New Image Two-Piece Pouching System

Non Sterile Kits — Urostomy

1920x Box of 5
' 1:1 Urostomy Kit includes:
> (1) 1460x Flextend Skin Barrier with Tape Border
— > (1) 1842x (Ultra-Clear Pouch Film)
. > (1) 7331

> Single-Use Package
HCPCS: A4432 + A4409

Ultra-Clear Flange

Stock No Size For Stomas Up To

19202 @ 1-3/4" (44 mm) 1-1/4" (32 mm)

19203 @ 2-1/4" (57 mm) 1-3/4" (44 mm)

19204 @ 2-3/4” (70 mm) 2-1/4” (57 mm)
1940x Box of 5

i 4 G Urostomy Kit includes:

> (1) 1410x FormaFlex Skin Barrier with Tape Border
"a— - > (1) 1842x (Ultra-Clear Pouch Film)
- > (1) 7331 Urostomy Drain Tube Adapter
> Single-Use Package

HCPCS: A4432 + A4409

Ultra-Clear Flange

Stock No Size For Stomas Up To
19402 @ 1-3/4” (44 mm) 1-1/4” (32 mm)
19403 @ 2-1/4 (57 mm) 1-3/4” (44 mm)
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Sterile Kits — Drainable

1905x Box of 5
Colostomy/lleostomy Kit includes:

> (1) 1420x FlexWear Skin Barrier with Tape Border

> (1) 1800x (Lock 'n Roll Microseal Closure) Ultra-Clear

y, > (1) 7767 Loop Ostomy Bridge (in 19056 only)
> Single-Use Package
HCPCS for 19052, 19053 & 19054: A5063 + A4414
HCPCS for 19056: A5063 + A4415
Ultra-Clear Flange
Stock No Size For Stomas Up To
19052 @ 1-3/4 (44 mm) 1-1/4” (32 mm)
19053 @ 2-1/4" (57 mm) 1-3/4” (44 mm)
19054 @& 2-3/4" (70 mm) 2-1/4” (57 mm)
19056 4" (102 mm) 3-1/2" (89 mm)
1915x Box of 5
- Colostomy/lleostomy Kit includes: 1 clamp per kit
> (1) 1420x FlexWear Skin Barrier with Tape Border
“e= . » (1)1817x (Clamp Closure) Ultra-Clear
> (1) 7767 Loop Ostomy Bridge (in 19156 only)
» Single-Use Package
HCPCS for 19152, 19153 & 19154: A5063 + A4414
HCPCS for 19156: A5063 + A4415
Ultra-Clear Flange
Stock No Size For Stomas Up To
19152 @ 1-3/4 (44 mm) 1-1/4” (32 mm)
19153 @ 2-1/4" (57 mm) 1-3/4” (44 mm)
19154 @& 2-3/4" (70 mm) 2-1/4” (57 mm)
19156 4" (102 mm) 3-1/2" (89 mm)
1935x Box of 5

Colostomy/lleostomy Kit includes:

> (1) 1520x FlexWear Skin Barrier without Tape Border
> (1) 1800x (Lock 'n Roll Microseal Closure) Ultra-Clear
> Single-Use Package

HCPCS for 19353: A5063 & A4414
HCPCS for 19353: A5063 & A4415

Ultra-Clear Flange

Stock No Size For Stomas Up To
19353 @ 2-1/4" (57 mm) 1-3/4” (44 mm)
19354 @ 2-3/4” (70 mm) 2-1/4" (57 mm)
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New Image Two-Piece Pouching System

Sterile Kits — Urostomy

1925x Box of 5
' G Urostomy Kit includes:
> (1) 1460x Flextend Skin Barrier with Tape Border
> (1) 1842x (Ultra-Clear Pouch Film)
> (1) 7331
> Single-Use Package

HCPCS: A4432 + A4409

Ultra-Clear Flange

Stock No Size For Stomas Up To
19252 @ 1-3/4" (44 mm) 1-1/4" (32 mm)
19253 @ 2-1/4" (57 mm) 1-3/4” (44 mm)
19254 @ 2-3/4" (70 mm) 2-1/4” (57 mm)

1950x Box of 5
' G Urostomy Kit includes:
\_ - » (1) 15603 Flextend Skin Barrier without Tape Border
- > (1) 18423 Ultra-Clear Pouch Film
' > (1) 7331
» Single-Use Package

HCPCS: A4432 & A4409

Ultra-Clear Flange
Stock No Size For Stomas Up To
19503 @ 2-1/4" (57 mm) 1-3/4” (44 mm)




New Image
Two-Piece
Pouching System

Important reference
information regarding the list
of original stock numbers and
the upgraded versions that
we recommend.

Hollister Ostomy. Details Matter.




Original Stock Numbers

Convex Skin Barriers with Integrated Floating Flange

Box of 5

< conwex

1440x (CUT-TO-FIT)
> FlexWear (standard wear) Skin Barrier
> With Tape Border

HCPCS: A4373

Stock No Flange Size For Stomas Up To
14402 @ 1-3/4" (44 mm) 17 (25 mm)
14403 @ 2-1/4” (57 mm) 1-1/2” (38 mm)
14404 @& 234 (70 mm) 2" (51 mm)
149xx (PRE-SIZED) Box of 5
° > Flextend (extended wear) Skin Barrier C
il > With Tape Border CONVEX
HCPCS: A4407
Stock No Flange Size Barrier Opening
14901 @ 1-3/4” (44 mm 5/8" (16 mm)
14902 @& 1-3/4” (44 mm 3/4” (19 mm)
14903 @ 1-3/4” (44 mm 7/8” (22 mm)
14904 @ 1-3/4 (44 mm 17 (25 mm)
14905 @ 2-1/4" (57 mm 1-1/8” (29 mm)
14906 @ 2-1/4” (57 mm 1-1/4” (32 mm)
14907 @ 2-1/4” (57 mm 1-3/8” (35 mm)
14908 @ 2-1/4” (57 mm 1-1/2” (38 mm)
14909 @ 2-3/4” (70 mm 1-5/8” (41 mm)
14910 @ 2-3/4” (70 mm 1-3/4” (44 mm)
14911 @& 2-3/4" (70 mm 2" (51 mm)
o e 1450x (PRE-SIZED) Box of 5
> FlexWear (standard wear) Skin Barrier
> With Tape Border (CONVEX
HCPCS: A4373
Stock No Flange Size Barrier Opening
14503 @ 1-3/4" (44 mm) 7/8" (22 mm)
14504 @ 1-3/4" (44 mm) 1" (25 mm
14505 @ 2-1/4" (57 mm) 1-1/8” (29 mm)
14506 @ 2-1/4” (57 mm) 1-1/4” (32 mm)

New Recommended Stock Numbers

Convex Skin Barriers with Integrated Floating Flange

Box of 5

< conex

1340x (CUT-TO-FIT)
> Flex\Wear (standard wear) Skin Barrier
> With Tape Border

HCPCS: A4373

Stock No Flange Size For Stomas Up To
13402 @ 1-3/4” (44 mm) 17 (25 mm)
13403 @ 2-1/4” (57 mm) 1-1/2” (38 mm)
13404 @ 2-3/4” (70 mm) 2" (51 mm)
139xx (PRE-SIZED) Box of 5
> Flextend (extended wear) Skin Barrier C
» With Tape Border CONVEX
HCPCS: A4407
Stock No Flange Size Barrier Opening
13901 @ 1-3/4 (44 mm 5/8” (16 mm)
13902 @ 1-3/4" (44 mm 3/4” (19 mm)
13903 @ 1-3/4" (44 mm 7/8” (22 mm)
13904 @ 1-3/4" (44 mm 17 (25 mm)
13905 @ 2-1/4 (57 mm 1-1/8” (29 mm)
13906 @ 2-1/4 (57 mm 1-1/4" (32 mm)
13907 @ 2-1/4 (57 mm 1-3/8” (35 mm)
13908 @ 2-1/4 (57 mm 1-1/2” (38 mm)
13909 @ 2-3/4 (70 mm 1-5/8” (41 mm)
13910 @ 2-3/4" (70 mm 1-3/4” (44 mm)
13911 @ 2-3/4" (70 mm 2" (51 mm)
1350x (PRE-SIZED) Box of 5
> FlexWear (standard wear) Skin Barrier (
» With Tape Border CONVEX
HCPCS: A4373
Stock No Flange Size Barrier Opening
13503 @ 1-3/4” (44 mm) 7/8” (22 mm)
13504 @ 1-3/4" (44 mm) 17 (25 mm)
13505 @ 2-1/4” (57 mm) 1-1/8” (29 mm)
13506 @ 2-1/4” (57 mm) 1-1/4” (32 mm)

All the benefits you like and trust in the original now with an upgraded skin barrier design.

- Tapered barrier edges to help provide increased comfort
- No change in skin barrier application
- Same HCPCS code

- New flexible plastic release liner covers both the skin barrier
and the adhesive border to help provide improved ease of use

Upgraded skin barrier design to help increase comfort and help improve ease of use:

Original Stock
umbers
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One-Piece
Pouching System

Hollister Ostomy. Details Matter.




Upgraded

Product Design

Select Premier One-Piece
Pouching Systems feature two
important product updates:

=

e Lock ’n Roll microseal closure with ribbed
strips to facilitate ease of use, and transparent
flap for increased security

e Upgraded skin barrier design to help increase

comfort and help improve ease of use:

- New flexible plastic release liner
covers both the skin barrier and the
adhesive border to help provide
improved ease of use

- Tapered barrier edges to help provide
increased comfort

- No change in skin barrier application

- Same HCPCS code

Look for the QUM callout box next to these

stock numbers.

Go to page 42-45 and 52 for more detail.

For more information, contact your
Hollister Ostomy sales representative.

% Hollister
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Premier One-Piece Pouching System

Drainable Pouches with Flat Barriers

8901 (CUT-TO-FIT)

> Drainable Pouch

> CeraPlus (extended wear) Skin Barrer
e » With Tape Border

» With Integrated AF300 Filter

> Lock 'n Roll Microseal Closure

» Qdor-Barrier Rustle-Free Film

» With ComfortWear Panels — Both Sides

HCPCS: A5056

Box of 10

Beige w/Viewing Option

Stock No For Stomas Up To Pouch Length

8901 2-1/2" (64 mm) 12" (30 cm)
= 8931 (CUT-TO-FIT) Box of 10

> Drainable Pouch

> CeraPlus (extended wear) Skin Barrer
» With Tape Border

» Without Integrated AF300 Filter

> Lock 'n Roll Microseal Closure

» Qdor-Barrier Rustle-Free Film

» With ComfortiWear Panels — Body Side Only

HCPCS: A4388
Ultra-Clear
Stock No For Stomas Up To Pouch Length
8931 2-1/2" (64 mm) 12" (30 cm)
8331/8371 (CUT-TO-FIT) Box of 10

» Drainable Pouch

> Flextend (extended wear) Skin Barrier
i » With Tape Border

» With Integrated AF300 Filter

> Lock ’n Roll Microseal Closure

» Qdor-Barrier Rustle-Free Film

» With ComfortiWear Panels — Body Side Only

- Transparent — Body Side Only

- Beige with Viewing Option — Both Sides

HCPCS: A5056

Transparent  Beige w/Viewing Option
Stock No Stock No For Stomas Up To

Pouch Length

8331 8371 (ED 2-1/2" (64 mm)

12" (30 cm)

8531/8551 (CUT-TO-FIT)
» Drainable Pouch
> Flextend (extended wear) Skin Barrier
» With Tape Border
» Without Integrated Filter
> Lock 'n Roll Microseal Closure
> Odor-Barrier Rustle-Free Film — Beige
» Qdor-Barrier Film — Ultra-Clear
» With ComfortWear Panels
- Beige — Both Sides
- Ultra-Clear — Body Side Only

HCPCS: A4388

Ultra-Clear Beige
Stock No Stock No For Stomas Up To

Box of 10

Pouch Length

8531 8551 2-1/2" (64 mm)

12" (30 cm)




Drainable Pouches with Flat Barriers (continued)

8631/8651 (CUT-TO-FIT) Box of 10
» Drainable Pouch Includes 1 clamp
> Flextend (extended wear) Skin Barrier

» With Tape Border

» Without Integrated Filter

> Clamp Closure

> QOdor-Barrier Rustle-Free Film — Transparent

» Qdor-Barrier Film — Ultra-Clear

» With ComfortWear Panels — Body Side Only

HCPCS: A4388
Ultra-Clear Transparent
Stock No Stock No For Stomas Up To Pouch Length
8651 8631 2-1/2" (64 mm) 12" (30 cm)
=% 8641 (CUT-TO-FIT) Box of 10
> Drainable Mini-Pouch Includes 1 clamp

> Flextend (extended wear) Skin Barrier
» With Tape Border
» Without Integrated Filter
—_— > Clamp Closure
» Qdor-Barrier Rustle-Free Film
» With ComfortWear Panels — Body Side Only

HCPCS: A4388
Transparent
Stock No For Stomas Up To Pouch Length
8641 2-1/2" (64 mm) 9" (23 cm)
8081/8181/8381 (CUT-TO-FIT) Box of 10

» Drainable Pouch
> FlexWear (standard wear) Skin Barrier
- » With Tape Border
» With Integrated AF300 Filter
> Lock 'n Roll Microseal Closure
» Qdor-Barrier Rustle-Free Film
» With ComfortWear Panels
- Transparent — Body Side Only
- Beige and Beige with Viewing Option — Both Sides

HCPCS: A4424
Transparent Beige Beige w/Viewing Option
Stock No  Stock No Stock No For Stomas Up To  Pouch Length
8081 8181 8381 (ED 2-1/2" (64 mm) 12" (30 cm)
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Premier One-Piece Pouching System

Drainable Pouches with Flat Barriers (continued)
- 8031 (CUT-TO-AT) Box of 10

- > Drainable Pouch
; r o > FlexWear (standard wear) Skin Barrier
— » With Tape Border
» Without Integrated Filter
> Lock 'n Roll Microseal Closure
> Qdor-Barrier Film
» With ComfortWear Panels — Body Side Only
HCPCS: A5061
Ultra-Clear
Stock No For Stomas Up To Pouch Length
8031 2-1/2" (64 mm) 12" (30 cm)
= 8131 (CUT-TO-FAI) Box of 10
pifer > Drainable Pouch Includes 1 clamp
= > FlexWear (standard wear) Skin Barrier
"'LEJ » With Tape Border

» Without Integrated Filter
> Clamp Closure
- > Odor-Barrier Film
» With ComfortWear Panels — Body Side Only

HCPCS: A5061

Ultra-Clear
Stock No For Stomas Up To Pouch Length
8131 2-1/2" (64 mm) 12" (30 cm)
88300/88400 (CUT-TO-FIT) Box of 10
> Drainable Pouch
» SoftFlex (standard wear) Skin Barrier
» Without Tape Border
» With Integrated AF300 Filter
> Lock 'n Roll Microseal Closure
» Qdor-Barrier Rustle-Free Film
» With Comfort\Wear Panels
- Transparent — Body Side Only
- Beige — Both Sides
HCPCS: Ad4424
Transparent Beige
Stock No Stock No For Stomas Up To Pouch Length
88400 88300 2-1/8" (55 mm) 12" (30 cm)

DID YOU KNOW... \

o Cut-to-fit products have a 1/2” (13 mm) starter hole and can be
used as a pre-sized product for some small stomas (excludes
Pouchkins products)

o Cutting guides are provided for all cut-to-fit barriers

 Drainable pouches without an integrated closure include one pouch
clamp per box

e We do not recommend the use of skin protective wipes (Hollister
Stock No 7917) or other brands to be used with the extended wear
skin barriers, as they may decrease wear time




Drainable Pouches with Flat Barriers (continued)

Transparent
Stock No

88800/88700 (CUT-TO-FIT)

» Drainable Mini-Pouch

> SoftFlex (standard wear) Skin Barrier

» Without Tape Border

> With Integrated AF300 Filter

> Lock 'n Roll Microseal Closure

» Odor-Barrier Rustle-Free Film

» With ComfortWear Panels
- Transparent — Body Side Only
- Beige — Both Sides

HCPCS: A4424

Beige
Stock No For Stomas Up To

Box of 20

Pouch Length

88800

88700 2-1/8" (55 mm) 7" (18 om)

Transparent
Stock No

Box of 10

88302/88402 (OVAL CUT-TO-FIT)

» Drainable Pouch

> SoftFlex (standard wear) Skin Barrier

» Without Tape Border

> With Integrated AF300 Filter

> Lock 'n Roll Microseal Closure

» Odor-Barrier Rustle-Free Film

» With ComfortWear Panels
- Transparent — Body Side Only
- Beige — Both Sides

HCPCS: A4424

Beige

Stock No For Stomas Up To Pouch Length

88402

88302 3x2.5" (75 mm x 65 mm) 12" (30 cm)

Ultra-Clear
Stock No

88401 (CUT-TO-FIT)

» Drainable Pouch

> SoftFlex (standard wear) Skin Barrier

» Without Tape Border

» Without Integrated Filter

> Lock 'n Roll Microseal Closure

» Odor-Barrier Film

» With ComfortiWear Panels — Body Side Only

HCPCS: A5061

Box of 10

For Stomas Up To Pouch Length

88401

2-1/2" (64 mm) 12" (30 cm)

Ultra-Clear
Stock No

88501 (CUT-TO-FIT)

> Drainable Pouch

> SoftFlex (standard wear) Skin Barrier
» Without Tape Border

» Without Integrated Filter

> Clamp Closure

» Odor-Barrier Film

» With ComfortiWear Panels — Body Side Only

HCPCS: A5061

Box of 10
Includes 1 clamp

For Stomas Up To Pouch Length

88501

2-1/2" (64 mm) 12" (30 cm)
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Premier One-Piece Pouching System

Drainable Pouches with Flat Barriers (continued)

89xX (PRE-SIZED)

» Drainable Pouch

» CeraPlus (extended wear) Skin Barrer
.y » With Tape Border

» With Integrated AF300 Filter

> Lock 'n Roll Microseal Closure

» Odor-Barrier Rustle-Free Film

» With ComfortiWear Panels — Both Sides

HCPCS: A5056

Box of 10

Beige w/Viewing Option
Stock No Barrier Opening Pouch Length
8925 1” (25 mm) 12" (30 cm)
8930 1-3/16” (30 mm) 12" (30 cm)
8935 1-3/8” (35 mm) 12" (30 cm)
8940 1-9/16” (40 mm) 12" (30 cm)

853x/855X (PRE-SIZED) Box of 10

» Drainable Pouch

— > Flextend (extended wear) Skin Barrier
T » With Tape Border
» Without Integrated Filter
o > Lock ’n Roll Microseal Closure
» Qdor-Barrier Rustle-Free Film
» With ComfortWear Panels
- Transparent — Body Side Only
- Beige — Both Sides

HCPCS: A4388
Transparent Beige
Stock No Stock No Barrier Opening Pouch Length
8532 8552 1" (25 mm) 12" (30 cm)
8538 8558 1-1/4" (32 mm) 12" (30 cm)
8533 8553 1-1/2" (38 mm) 12" (30 cm)
8539 8559 1-3/4" (44 mm) 12" (30 cm)

863X (PRE-SIZED) Box of 10

» Drainable Pouch Includes 1 clamp

> Flextend (extended wear) Skin Barrier

» With Tape Border

» Without Integrated Filter

a > Clamp Closure

» Odor-Barrier Rustle-Free Film

» With ComfortiWear Panels — Body Side Only

HCPCS: A4388
Transparent
Stock No Barrier Opening Pouch Length
8637 3/4" (19 mm) 12" (30 cm)
8632 1" (25 mm) 12" (30 cm)
8638 1-1/4" (32 mm) 12" (30 cm)
8633 1-1/2" (38 mm) 12" (30 cm)
8639 1-3/4" (44 mm) 12" (30 cm)
8634 2" (51 mm) 12" (30 cm)
8635 2-1/2" (64 mm) 12" (30 cm)




Drainable Pouches with Flat Barriers (continued)

[ ==

864X (PRE-SIZED)

> Drainable Mini-Pouch
> Flextend (extended wear) Skin Barrier
» With Tape Border

» Without Integrated Filter

> Clamp Closure

» Odor-Barrier Rustle-Free Film

» With ComfortiWear Panels — Both Sides

Box of 10

Includes 1 clamp

HCPCS: A4388
Beige
Stock No Barrier Opening Pouch Length
8647 3/4" (19 mm) 9" (23 cm)
8642 1" (25 mm) 9" (23 cm)
8648 1-1/4" (32 mm) 9" (23 cm)
8643 1-1/2" (38 mm) 9" (23 cm)
8649 1-3/4" (44 mm) 9" (23 cm)
8644 2" (51 mm) 9" (23 cm)
- 80xx/81xX (PRE-SIZED) Box of 10
» Drainable Pouch
. > FlexWear (standard wear) Skin Barrier
» With Tape Border
» With Integrated AF300 Filter
> Lock 'n Roll Microseal Closure
» Odor-Barrier Rustle-Free Film
» With ComfortWear Panels
- Transparent — Body Side Only
- Beige — Both Sides
HCPCS: A4424
Transparent Beige
Stock No Stock No Barrier Opening Pouch Length
8025 8125 1" (25 mm) 12" (30 cm)
8030 8130 1-3/16" (30 mm) 12" (30 cm)
8035 8135 1-3/8" (35 mm) 12" (30 cm)
8040 8140 1-9/16" (40 mm) 12" (30 cm)
883xx/884xx (PRE-SIZED) Box of 10
» Drainable Pouch
» SoftFlex (standard wear) Skin Barrier
» Without Tape Border
» With Integrated AF300 Filter
> Lock 'n Roll Microseal Closure
» Qdor-Barrier Rustle-Free Film
» With ComfortWear Panels
- Transparent — Body Side Only
- Beige — Both Sides
HCPCS: A4424
Transparent Beige
Stock No Stock No Barrier Opening Pouch Length
88425 88325 1" (25 mm) 12" (30 cm)
88430 88330 1-3/16" (30 mm) 12" (30 cm)
88435 88335 1-3/8" (35 mm) 12" (30 cm)
88440 88340 1-9/16" (40 mm) 12" (30 cm)
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Premier Soft Convex Pouching System

Designed to stay secure, no matter what shape the body takes.

When it comes to finding the right solution for
patients, fit comes first. Comfort and ease-of-use
are also essential to help ensure positive
outcomes—in the hospital and after patients
leave your care.

Hollister Ostomy presents Premier soft

convex—a pouching system that delivers

both convex support and flexibility. The skin
barrier is designed to conform to the body, without
compromising fit. Belt tabs and a tape-bordered
barrier help provide extra security. And the new
viewing option offers a convenient way to help
position the pouch and observe output.

Discover the new shape of convexity today.

See pages 41, 43 and 44 for stock number information
or contact your Hollister Ostomy Sales Specialist
for details.

£ Hollister

Hollister Ostomy. Details Matter.™

The Hollister logo, Premier and “Hollister Ostomy. Details Matter.”
are trademarks of Hollister Incorporated.

© 2016 Hollister Incorporated.



Premier One-Piece Pouching System

Drainable Pouches with Flat Barriers (continued)

887xx (PRE-SIZED) Box of 20
» Drainable Mini-Pouch

> SoftFlex (standard wear) Skin Barrier

» Without Tape Border

> With Integrated AF300 Filter

> Lock 'n Roll Microseal Closure

» Odor-Barrier Rustle-Free Film

» With ComfortiWear Panels — Both Sides

HCPCS: A4424
Beige
Stock No Barrier Opening Pouch Length
88725 17 (25 mm) 7 (18 cm)
88730 1-3/16” (30 mm) 7" (18 cm)
88735 1-3/8” (35 mm) 7" (18 cm)
88740 1-9/16” (40 mm) 7" (18 cm)
Drainable Pouches with Convex Barriers

895xx (CUT-TO-FIT) Box of 5

> Drainable Pouch SOFT

> Soft Convex - lEh e

- > CeraPlus (extended wear) Skin Barrier m

> With Tape Border

> With Integrated AF300 Filter

> Lock 'n Roll Microseal Closure

» Qdor-Barrier Rustle-Free Film

> With Belt Tabs

» With ComfortWear Panels — Both Sides

HCPCS Code: A5057
Beige w/Viewing Option
Stock No For Stomas Up To Pouch Length
8954 1" (25 mm) 12 (30 cm)
8958 1-1/2" (38 mm) 12" (30 cm)
89511 2-1/8" (55 mm) 12" (30 cm)

857x/867x (CUT-TO-FIT) Box of 5

» Drainable Pouch — SOFT

» Soft Convex < coNvEX

= > Flextend (extended wear) Skin Barrier

» With Tape Border

> With Integrated AF300 Filter

> Lock 'n Roll Microseal Closure

> With Belt Tabs

» With ComfortWear Panels

- Ultra-Clear — Body Side Only
- Beige with Viewing Option — Both Sides

HCPCS: A5057
Ultra-Clear  Beige w/Viewing Option
Stock No Stock No For Stomas Up To Pouch Length
8574 8674 17 (13-25 mm) 12" (30 cm)
8578 8678 11/2" (13-38 mm) 12" (30 cm)
85711 86711 21/8” (13-55 mm) 12” (30 cm)

4
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Premier One-Piece Pouching System

Drainable Pouches with Convex Barriers (continued)

891x (CUT-TO-FIT)

» Drainable Pouch

> CeraPlus (extended wear) Skin Barrier
- » With Tape Border

» With Integrated AF300 Filter

> Lock 'n Roll Microseal Closure

» Odor-Barrier Rustle-Free Film

» With Belt Tabs

» With ComfortWear Panels — Both Sides

HCPCS Code: A5057

Box of 5

< conex

Beige w/Viewing Option

Stock No For Stomas Up To Pouch Length

8914 17 (25 mm) 12" (30 cm)

8918 1-1/2” (38 mm) 12" (30 cm)

89111 2" (51 mm) 12" (30 cm)
898x (CUT-TO-FIT) Box of 5

» Drainable Pouch

» CeraPlus (extended wear) Skin Barrier < convex

- » With Tape Border
» Without Integrated AF300 Filter
> Lock 'n Roll Microseal Closure
> Odor-Barrier Rustle-Free Film
» With Belt Tabs

» With ComfortiWear Panels — Body Side Only

HCPCS Code: A4390

Ultra-Clear

Stock No For Stomas Up To Pouch Length

8984 1" (25 mm) 12" (30 cm)

8988 1-1/2” (38 mm) 12" (30 cm)

89811 2" (51 mm) 12" (30 cm)
827xx/854xx (CUT-TO-FIT) Box of 5

» Drainable Pouch

> Flextend (extended wear) Skin Barrier
- » With Tape Border

> With Integrated AF300 Filter

> Lock 'n Roll Microseal Closure

» Odor-Barrier Rustle-Free Film

» With Belt Tabs

<< convex

UPGRADED
DESIGN

» With ComfortiWear Panels — Body Side Only

- Transparent — Body Side Only

- Beige with Viewing Option — Both Sides

HCPCS Code: A5057

Transparent  Beige w/Viewing Option

Stock No Stock No For Stomas Up To Pouch Length
8274 8544 1" (25 mm) 12" (30 cm)
8278 8548 1-1/2" (38 mm) 12" (30 cm)
82711 85411 2" (51 mm) 12" (30 cm)




Drainable Pouches with Convex Barriers (continued)

821xx/824xx (CUT-TO-FIT)

» Drainable Pouch

> Flextend (extended wear) Skin Barrier

» With Tape Border

» Without Integrated Filter

> Lock 'n Roll Microseal Closure

» Odor-Barrier Rustle-Free Film

» With Belt Tabs

» With ComfortWear Panels
- Transparent — Body Side Only
- Beige — Both Sides

Box of 5

< convex

UPGRADED
DESIGN

HCPCS: A4390
Transparent Beige
Stock No Stock No For Stomas Up To Pouch Length
8244 8214 17 (25 mm) 12" (30 cm)
8248 8218 1-1/2” (38 mm) 12" (30 cm)
82411 82111 2" (51 mm) 12" (30 cm)
8262xx (CUT-TO-FIT) Box of 5

> Drainable Pouch
> Flextend (extended wear) Skin Barrier
» With Tape Border
» Without Integrated Filter
» Clamp Closure

_— » Qdor-Barrier Rustle-Free Film
> With Belt Tabs

Includes 1 clamp

< convex

UPGRADED
DESIGN

*Skin barrier design only

» With ComfortiWear Panels — Body Side Only

HCPCS: A4390
Transparent
Stock No For Stomas Up To Pouch Length
82624 1" (25 mm) 12" (30 cm)
82628 1-1/2" (38 mm) 12" (30 cm)
826211 2" (51 mm) 12" (30 cm)
896X (PRE-SIZED) Box of 5
» Drainable Pouch SOFT
> Soft Convex CONVEX
- > CeraPlus (extended wear) Skin Barrier W
> With Tape Border
> With Integrated AF300 Filter
> Lock 'n Roll Microseal Closure
» Qdor-Barrier Rustle-Free Film
» With Belt Tabs
» With ComfortWear Panels — Both Sides
HCPCS: A5057
Beige w/Viewing Option
Stock No Barrier Opening Pouch Length
8960 3/4” (19 mm) 12" (30 cm)
8961 7/8" (22 mm) 12" (30 cm)
8962 1" (25 mm) 12" (30 cm)
8963 1-1/8" (29 mm) 12" (30 cm)
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Premier One-Piece Pouching System

Drainable Pouches with Convex Barriers (continued)

866X (PRE-SIZED) Box of 5

» Drainable Pouch - SOFT

> Soft Convex < CoNvEX
- > Flextend (extended wear) Skin Barrier

» With Tape Border m

» With Integrated AF300 Filter

> Lock ’n Roll Microseal Closure

» With Belt Tabs

» With ComfortWear Panels — Both Sides

HCPCS: A5057
Beige w/Viewing Option

Stock No Barrier Opening Pouch Length
8661 7/8” (22 mm) 12" (30 cm)
8662 1" (25 mm) 12" (30 cm)
8663 1-1/8" (29 mm) 12" (30 cm)
8664 1-1/4” (32 mm) 12” (30 cm)
8665 1-1/2" (38 mm) 12" (30 cm)
8666 1-3/4” (44 mm) 12" (30 cm)

899X (PRE-SIZED) Box of 5

> Drainable Pouch (

> CeraPlus (extended wear) Skin Barrier CONVEX

- » With Tape Border

> With Integrated AF300 Filter

> Lock 'n Roll Microseal Closure

» Odor-Barrier Rustle-Free Film

> With Belt Tabs

» With ComfortWear Panels — Both Sides

HCPCS: A5057
Beige w/Viewing Option
Stock No Barrier Opening Pouch Length
8990 3/4" (19 mm) 12" (30 cm)
8991 7/8 (22 mm) 12" (30 cm)
8992 1" (25 mm) 12" (30 cm)
8993 1-1/8” (29 mm) 12" (30 cm)

828x/829x (PRE-SIZED) Box of 5

» Drainable Pouch -

> Flextend (extended wear) Skin Barrier ( CONVEX
» With Tape Border

> Without Integrated Filter UPGRADED
> Lock 'n Roll Microseal Closure DESIGN
» Odor-Barrier Rustle-Free Film

» With Belt Tabs

» With ComfortWear Panels

- Transparent — Body Side Only
- Beige — Both Sides

HCPCS: A4390

Transparent Beige
Stock No Stock No Barrier Opening Pouch Length
8280 8290 3/4” (19 mm) 12" (30 cm)
8281 8291 7/8" (22 mm) 12" (30 cm)
8282 8292 17 (25 mm) 12" (30 cm)
8283 8293 1-1/8” (29 mm) 12" (30 cm)
8284 8294 1-1/4” (32 mm) 12" (30 cm)
8285 8295 1-3/8” (35 mm) 12" (30 cm)
8286 8296 1-1/2" (38 mm) 12" (30 cm)

— 8297 1-5/8” (41 mm) 12" (30 cm)
8288 — 1-3/4” (44 mm) 12" (30 cm)
8289 — 2" (51 mm) 12" (30 cm)
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Drainable Pouches with Convex Barriers (continued)

8261x (PRE-SIZED) Box of 5
» Drainable Pouch Includes 1 clamp
> Flextend (extended wear) Skin Barrier

» With Tape Border ( CONVEX

> Without Integrated Filter UPGRADED
g > Clamp CIo_sure . DESIGN
o > QOdor-Barrier Rustle-Free Film N
» With Belt Tabs *Skin barrier design only
> With ComfortWear Panels — Body Side Only
HCPCS: A4390
Transparent
Stock No Barrier Opening Pouch Length
82610 3/4” (19 mm) 12" (30 cm)
82611 7/8" (22 mm) 12" (30 cm)
82612 1" (25 mm) 12" (30 cm)
82613 1-1/8" (29 mm) 12" (30 cm)
82614 1-1/4" (32 mm) 12" (30 cm)
82615 1-3/8” (35 mm) 12" (30 cm)
82616 1-1/2" (38 mm) 12" (30 cm)
82617 1-5/8" (41 mm) 12" (30 cm)
82618 1-3/4” (44 mm) 12" (30 cm)
82619 2" (51 mm) 12" (30 cm)

High Output Drainable Pouches

80070/80110 (CUT-TO-FIT) Box of 10
> Non Sterile, Drainable Pouch
> Flextend (extended wear) Skin Barrier — Flat

- » Without Tape Border
> With Soft Tap
» With Access Window
» Qdor-Barrier Film
» With ComfortWear Panels — Body Side Only
> Without Starter Hole
HCPCS: A4435
Ultra-Clear
Stock No For Stomas Up To Pouch Length
80070 2-3/4" (70 mm) 12" (30 cm)
80110 4-1/3" (110 mm) 12" (30 cm)
* 81070/81110 (CUT-TO-FIT) Box of 5
T » Sterile, Drainable Pouch
> Flextend (extended wear) Skin Barrier — Flat
» Without Tape Border
» With Soft Tap
> With Access Window
> Qdor-Barrier Film
» With ComfortiWear Panels — Body Side Only
» Without Starter Hole
HCPCS: A4435
Ultra-Clear
Stock No For Stomas Up To Pouch Length
81070 2-3/4" (70 mm) 12" (30 cm)
81110 4-1/3" (110 mm) 12" (30 cm)
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Premier One-Piece Pouching System

Closed Pouches

82300/82400 (CUT-TO-FIT) Box of 30
> Closed Pouch
. > SoftFlex (standard wear) Skin Barrier — Flat
i F » Without Tape Border
> With Integrated AF300 Filter
» Qdor-Barrier Rustle-Free Film
» With ComfortWear Panels

- Transparent — Body Side Only
- Beige — Both Sides

HCPCS: A4416
Transparent Beige
Stock No Stock No For Stomas Up To Pouch Length
82400 82300 2-1/8" (55 mm) 9" (23 cm)
82302/82402 (OVAL CUT-TO-FIT) Box of 30

J » Closed Pouch
» SoftFlex (standard wear) Skin Barrier — Flat
» Without Tape Border
L-:‘ » With Integrated AF300 Filter
» Odor-Barrier Rustle-Free Film
» With ComfortWear Panels

- Transparent — Body Side Only
- Beige — Both Sides

HCPCS: A4416
Transparent Beige
Stock No Stock No For Stomas Up To Pouch Length
82402 82302 3x2.5" (75 mm x 65 mm) 9" (23 cm)
82100/82500 (CUT-TO-FIT) Box of 30
) > Closed Mini-Pouch
. > SoftFlex (standard wear) Skin Barrier — Flat
L% » Without Tape Border
» With Integrated AF300 Filter
» Odor-Barrier Rustle-Free Film
» With ComfortWear Panels
- Transparent — Body Side Only
- Beige — Both Sides
HCPCS: A4416
Transparent Beige
Stock No Stock No For Stomas Up To Pouch Length
82500 82100 2-1/8" (55 mm) 7" (18 cm)
823xx (PRE-SIZED) Box of 30

> Closed Pouch
| » SoftFlex (standard wear) Skin Barrier — Flat
i.‘ » Without Tape Border

» With Integrated AF300 Filter

» Qdor-Barrier Rustle-Free Film

» With ComfortWear Panels — Both Sides

HCPCS: A4416
Beige
Stock No Barrier Opening Pouch Length
82325 1" (25 mm) 9" (23 cm)
82330 1-3/16" (30 mm) 9" (23 cm)
82335 1-3/8" (35 mm) 9" (23 cm)
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Closed Pouches (continued)

821xx (PRE-SIZED) Box of 30
- » Closed Mini-Pouch
pagt > SoftFlex (standard wear) Skin Barrier — Flat
L » Without Tape Border
> With Integrated AF300 Filter
» Qdor-Barrier Rustle-Free Film
» With ComfortWear Panels — Both Sides
HCPCS: A4416
Beige
Stock No Barrier Opening Pouch Length
82125 1" (25 mm) 7" (18 cm)
82130 1-3/16" (30 mm) 7" (18 cm)
82135 1-3/8" (35 mm) 7" (18 cm)
Stoma Cap
1796 (PRE-SIZED) Box of 30
» Stoma Cap
» SoftFlex (standard wear) Skin Barrier — Flat
» Without Tape Border
» With Integrated Filter
» Odor-Barrier Film
HCPCS: A5055
Beige
Stock No Barrier Opening Size
1796 1-15/16" (50 mm) 4" (102 mm)

Urostomy Pouches with Flat Barriers

8440/8450/8460 (CUT-TO-FIT) Box of 10
-' » Urostomy Pouch Includes 1 adapter
> Anti-Reflux Valve
> Flextend (extended wear) Skin Barrier
» With Tape Border
» Qdor-Barrier Rustle-Free Film
» Odor-Barrier Film — Ultra-Clear
» With ComfortWear Panels
- Transparent and Ultra Clear — Body Side Only
- Beige — Both Sides

HCPCS: A4428
Ultra-Clear  Transparent Beige
Stock No Stock No Stock No For Stomas Up To  Pouch Length
8450 8460 8440 2-1/2" (64 mm) 9" (23 cm)
u 844x/846x (PRE-SIZED) Box of 10
= » Urostomy Pouch Includes 1 adapter

" » Anti-Reflux Valve
> Flextend (extended wear) Skin Barrier
» With Tape Border
» Qdor-Barrier Rustle-Free Film
» With ComfortWear Panels
- Transparent — Body Side Only
- Beige — Both Sides

HCPCS: A4428

Transparent Beige

Stock No Stock No Barrier Opening Pouch Length
8467 8447 3/4" (19 mm) 9" (23 ¢cm)
8462 8442 1" (25 mm) 9" (23 cm)
8468 8448 1-1/4" (32 mm) 9" (23 ¢cm)
8463 8443 1-1/2" (38 mm) 9" (23 cm)
8469 8449 1-3/4" (44 mm) 9" (23 cm)
8464 8444 2" (51 mm) 9" (23 cm)
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Premier One-Piece Pouching System

Urostomy Pouches with Convex Barriers
ﬂ 847x/843x (CUT-TO-FIT)

Box of 5

» Urostomy Pouch Includes 1 adapter

[ S > Anti-Reflux Valve
> Flextend (extended wear) Skin Barrier
» With Tape Border
» Qdor-Barrier Rustle-Free Film
» With Belt Tabs
» With ComfortWear Panels
- Transparent — Body Side Only
- Beige — Both Sides

<< convex

HCPCS: A4430
Transparent Beige
Stock No Stock No For Stomas Up To Pouch Length
8474 8434 1" (25 mm) 9" (23 cm)
8478 8438 1-1/2" (38 mm) 9" (23 cm)
84711 84311 2" (51 mm) 9" (23 cm)
848x/849x (PRE-SIZED) Box of 5
q » Urostomy Pouch Includes 1 adapter

[ » Anti-Reflux Valve
> Flextend (extended wear) Skin Barrier
» With Tape Border
» Odor-Barrier Rustle-Free Film
» With Belt Tabs
» With ComfortWear Panels
- Transparent — Body Side Only
- Beige — Both Sides

< convex

HCPCS: A4430
Transparent Beige
Stock No Stock No Barrier Opening Pouch Length
8480 8490 1/2" (13 mm) 9" (23 cm)
8481 8491 5/8" (16 mm) 9" (23 cm)
8482 8492 3/4" (19 mm) 9" (23 cm)
8483 8493 7/8" (22 mm) 9" (23 cm)
8484 8494 1" (25 mm) 9" (23 cm)
8485 8495 1-1/8" (29 mm) 9" (23 cm)
8486 8496 1-1/4" (32 mm) 9" (23 cm)
8487 8497 1-3/8" (35 mm) 9" (23 cm)
8488 8498 1-1/2" (38 mm) 9" (23 cm)
8489 8499 1-3/4" (44 mm) 9" (23 cm)
Non Sterile Kits — Drainable

89001 (CUT-TO-FIT) Box of 5 Kits

Colostomy/lleostomy Kit Includes:

> (1) 88401 SoftFlex (standard wear) Skin Barrier

» Without Tape Border

r » Without Integrated Filter
> Lock ’n Roll Microseal Closure
» Single-Use Package
HCPCS: A5061
Ultra-Clear
Stock No For Stomas Up To Pouch Length
89001 2-1/2" (64 mm) 12" (30 cm)




Non Sterile Kits — Drainable (continued)

fa__,_ﬂ

Ultra-Clear
Stock No

89002 (CUT-TO-FIT)
Colostomy/lleostomy Kit Includes:
> (1) 88501 SoftFlex (standard wear) Skin Barrier
» Without Tape Border

» Without Integrated Filter

» Single-Use Package

89002

e

Ultra-Clear
Stock No

89003 (CUT-TO-FIT)
Colostomy/lleostomy Kit Includes:
> (1) 8651 Flextend (extended wear) Skin Barrier
» With Tape Border

» Without Integrated Filter

> Single-Use Package

89003

=

e —

v

Ultra-Clear
Stock No

89004 (CUT-TO-FIT)
Colostomy/lleostomy Kit Includes:
> (1) 8531 Flextend (extended wear) Skin Barrier
» With Tape Border

» Without Integrated Filter

> Lock 'n Roll Microseal Closure

» Single-Use Package

89004

Non Sterile Kits

5
i

sipd

Ultra-Clear
Stock No

89005 (CUT-TO-FIT)
Urostomy Kit Includes:
> (1) 8450 Flextend (extended wear) Skin Barrier
» With Tape Border

1 adapter per kit

» Single-Use Package

89005







Premier One-Piece
Pouching System

Important reference

information regarding the list

of original stock numbers and the
upgraded versions that

we recommend.
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Original Stock Numbers

New Recommended Stock Numbers

Drainable Pouches with Convex Barrier ‘G CONVEX
858xX (CUT-TO-FIT) Box of 5
> Flextend Skin Barrier, With Tape Border, With Integrated AF300 Filter,

Lock ‘n Roll Closure
HCPCS Code: A5057

Transparent

Stock No For Stomas Up To Pouch Length
8584 17 (25 mm) 12" (30 cm)
8588 1-1/2” (38 mm) 12" (30 cm)
85811 2" (51 mm) 12" (30 cm)
850xx/852xx (CUT-TO-FIT) Box of 5

> Flextend Skin Barrier, With Tape Border, Without Integrated Filter,
Lock ‘n Roll Closure

HCPCS: A4390

Transparent Beige

Stock No Stock No For Stomas Up To Pouch Length
8524 8504 1" (25 mm) 12" (30 cm)
8528 8508 1-1/2” (38 mm) 12" (30 cm)
85211 85011 2" (51 mm) 12" (30 cm)
862xx (CUT-TO-FIT) Box of 5

> Flextend Skin Barrier, With Tape Border, Without Integrated Filter, Clamp Closure
HCPCS: A4390

Transparent

Stock No For Stomas Up To Pouch Length
8624 17 (25 mm) 12" (30 cm)
8628 1-1/2” (38 mm) 12" (30 cm)
86211 2" (51 mm) 12" (30 cm)
851xx/859x (PRE-SIZED) Box of 5

> Flextend Skin Barrier, With Tape Border, Without Integrated Filter,
Lock 'n Roll Closure

HCPCS: A4390
Transparent Beige
Stock No Stock No Barrier Opening Pouch Length
8510 8590 3/4” (19 mm) 12" (30 cm)
8511 8591 7/8” (22 mm) 12" (30 cm)
8512 8592 1" (25 mm) 12" (30 cm)
8513 8593 1-1/8” (29 mm) 12" (30 cm)
8514 8594 1-1/4” (32 mm) 12" (30 cm)
8515 8595 1-3/8” (35 mm) 12" (30 cm)
85116 8596 1-1/2" (38 mm) 12" (30 cm)
— 8597 1-5/8” (41 mm) 12" (30 cm)
85118 — 1-3/4” (44 mm) 12" (30 cm)
85119 8599 2" (51 mm) 12" (30 cm)
861X (PRE-SIZED) Box of 5

> Flextend Skin Barrier, With Tape Border, Without Integrated Filter, Clamp Closure
HCPCS: A4390

Transparent

Stock No Barrier Opening Pouch Length
8610 3/4” (19 mm) 12" (30 cm)
8611 7/ " (22 mm) 12" (30 cm)
8612 1" (25 mm) 12" (30 cm)
8613 1-1/8” (29 mm) 12" (30 cm)
8614 1-1/4” (32 mm) 12" (30 cm)
8615 1-3/8” (35 mm) 12" (30 cm)
8616 1-1/2” (38 mm) 12" (30 cm)
8617 1-5/8” (41 mm) 12" (30 cm)
8618 1-3/4” (44 mm) 12" (30 cm)
8619 2" (51 mm) 12" (30 cm)
52

»

»

Drainable Pouches with Convex Barrier ‘G CONVEX
827xx/854xx (CUT-TO-FIT) Box of 5
> Flextend Skin Barrier, With Tape Border, With Integrated AF300 Filter,

Lock ‘n Roll Microseal Closure
HCPCS Code: A5057

Transparent  Beige w/Viewing Option

Stock No Stock No For Stomas Up To Pouch Length

8274 8544 17 (25 mm) 12” (30 cm)

8278 8548 1-1/2” (38 mm) 127 (30 cm)

82711 85411 2" (51 mm) 12" (30 cm)
*See page 42 for full product details

821xx/824xx (CUT-TO-FIT) Box of 5

> Flextend Skin Barrier, With Tape Border, Without Integrated Filter,
Lock ‘n Roll Microseal Closure
HCPCS: A4390

Transparent Beige

Stock No Stock No For Stomas Up To Pouch Length

8244 8214 1" (25 mm) 12" (30 cm)

8248 8218 1-1/2" (38 mm) 12" (30 cm)

82411 82111 2" (51 mm) 12" (30 cm)
*See page 43 for full product details

8262xx (CUT-TO-FIT) Box of 5

> Flextend Skin Barrier, With Tape Border, Without Integrated Filter, Clamp Closure
HCPCS: A4390

Transparent

Stock No For Stomas Up To Pouch Length

82624 1" (25 mm) 12" (30 cm)

82628 1-1/2" (38 mm) 12" (30 cm)

826211 2" (51 mm) 12" (30 cm)
*See page 43 for full product details

828x/829x (PRE-SIZED) Box of 5

> Flextend Skin Barrier, With Tape Border, Without Integrated Filter,
Lock ‘n Roll Microseal Closure
HCPCS: A4390

Transparent Beige
Stock No Stock No Barrier Opening Pouch Length
8280 8290 3/4” (19 mm) 12" (30 cm)
8281 8291 7/8" (22 mm) 12" (30 cm)
8282 8292 17 (25 mm) 12" (30 cm)
8283 8293 1-1/8” (29 mm) 12” (30 cm)
8284 8294 1-1/4” (32 mm) 127 (30 cm)
8285 8295 1-3/8” (35 mm) 127 (30 cm)
8286 8296 1-1/2” (38 mm) 12" (30 cm)
— 8297 1-5/8” (41 mm) 12" (30 cm)
8288 — 1-3/4” (44 mm) 12" (30 cm)
8289 — 2" (51 mm) 12" (30 cm)
*See page 44 for full product details
8261x (PRE-SIZED) Box of 5

> Flextend Skin Barrier, With Tape Border, Without Integrated Filter, Clamp Closure
HCPCS: A4390

Transparent

Stock No Barrier Opening Pouch Length
82610 3/4” (19 mm) 12" (30 cm)
82611 7/8” (22 mm) 12" (30 cm)
82612 1" (25 mm) 12" (30 cm)
82613 1-1/8" (29 mm) 12" (30 cm)
82614 1-1/4" (32 mm) 12" (30 cm)
82615 1-3/8" (35 mm) 12" (30 cm)
82616 1-1/2” (38 mm) 12" (30 cm)
82617 1-5/8” (41 mm) 12" (30 cm)
82618 1-3/4” (44 mm) 12" (30 cm)
82619 2" (51 mm) 12” (30 cm)

*See page 45 for full product details
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Pouchkins

Pediatric
Pouching System

Hollister Ostomy. Details Matter.




Pouchkins Pediatric Pouching System

Premie Pouch

3777 (CUT-TO-FIT) Box of 15
» Use as a Premie Closed or Drainable Pouch

> SoftFlex (standard wear) Skin Barrier — Flat

» Without Tape Border

» Without Starter Hole

» Without Integrated Filter

» Odor-Barrier Film

» Soft Wire Closure (if converted to a drainable pouch)

» Without Comfort\/ear Panels

HCPCS: A5052 + A4362

Ultra-Clear
Stock No For Stomas Up To Pouch Length
3777 5/8" (15 mm) 4-1/2" (11.5 cm)

Newborn Pouch

3778 (CUT-TO-FIT) Box of 15
» Newborn Pouch; Use With or Without the Drain Valve

» SoftFlex (standard wear) Skin Barrier — Flat

» Without Tape Border

» Without Integrated Filter

» Soft Wire Closure (if converted to a drainable pouch)

» Odor-Barrier Film

> Without Comfort\/ear Panels

HCPCS: A5062 + A4362

Ultra-Clear
Stock No For Stomas Up To Pouch Length
3778 1-3/8" x 7/8" (35 mm x 22 mm) 6-1/2" (16 cm)

One-Piece Pouches

3796 (CUT-TO-FIT) Box of 10
» Drainable Pouch
\ _)I' » SoftFlex (standard wear) Skin Barrier — Flat
> Without Starter Hole
» Without Tape Border
> Without Integrated Filter
> Lock 'n Roll Microseal Closure
» Odor-Barrier Rustle-Free Film
» With ComfortiWear Panels — Body Side Only

HCPCS: A5061

Transparent
Stock No For Stomas Up To Pouch Length
3796 1-1/2" (38 mm) 6-1/2" (16 cm)
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Pouchkins Pediatric Pouching System

One-Piece Pouches (continued)

il 3795 (CUT-TO-FIT) Box of 10
» Drainable Pouch
,:-"':-. > SoftFlex (standard wear) Skin Barrier — Flat

» Without Starter Hole

» Without Tape Border

» With Integrated AF300 Filter

> Lock ’n Roll Microseal Closure

» Qdor-Barrier Rustle-Free Film

> With ComfortWear Panels — Body Side Only

HCPCS: A4424
Transparent
Stock No For Stomas Up To Pouch Length
3795 2" (51 mm) 7" (18 cm)
3797 (CUT-TO-FIT) Box of 10
| » Urostomy Pouch
e » Anti-Reflux Valve
» SoftFlex (standard wear) Skin Barrier — Flat
» Without Starter Hole
» Without Tape Border
» Qdor-Barrier Rustle-Free Film
» With ComfortiWear Panels — Body Side Only
HCPCS: A5071
Transparent
Stock No For Stomas Up To Pouch Length
3797 1-1/2" (38 mm) 8-3/4" (22 cm)

2 DID YOU KNOW...

Pouchkins SoftFlex Skin Barrier

 Designed to be gentle on sensitive infant skin
* No starter hole, which enables the opening to be

placed where needed j A
© No tape by design
e Flexible and sized for babies and children . i

* None of the Pouchkins pediatric pouching systems
are made with natural rubber latex
o Any 1-3/4” New Image pouch will fit this skin barrier




Two-Piece Skin Barrier

&)

3761 (CUT-TO-FIT) Box of 5
> SoftFlex (standard wear) Skin Barrier — Flat

> Without Starter Hole

» Without Tape Border

HCPCS: A4414
Transparent
Stock No Flange Size For Stomas Up To
3761 @ 1-3/4" (44 mm) 1-1/4" (32 mm)

Two-Piece Pouches

3799 Box of 10
» Drainable Pouch

> Without Integrated Filter

> Lock 'n Roll Microseal Closure

» Qdor-Barrier Rustle-Free Film

» With Belt Tabs

» With ComfortWear Panel — Body Side Only

HCPCS: A5063

Transparent
Stock No Flange Size Pouch Length
3799 @ 1-3/4" (44 mm) 6-1/2" (16 cm)
18292/18282 Box of 20
& » Drainable Pouch
» With Integrated AF300 Filter
> Lock 'n Roll Microseal Closure
» Odor-Barrier Rustle-Free Film
» With Belt Tabs
» With ComfortWWear Panel
- Transparent — Body Side Only
- Beige — Both Sides
HCPCS: A4425
Transparent Beige Pouch
Stock No Stock No Flange Size Length
18292 18282 @ 1-3/4" (44 mm) 7" (18 cm)
B 18382/18392 Box of 60
[ > Closed Mini-Pouch

o W
ok
¥

> With Integrated AF300 Filter

» Odor-Barrier Rustle-Free Film

» With Belt Tabs

» With ComfortWear Panels
- Transparent — Body Side Only
- Beige — Both Sides

HCPCS: A4419
Transparent Beige Pouch
Stock No Stock No Flange Size Length
18382 18392 @& 1-3/4" (44 mm) 7" (18 cm)
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Pouchkins Pediatric Pouching System

Two-Piece Pouches (continued)

18402/18412 Box of 10
Do » Urostomy Pouch
T A » QOdor-Barrier Rustle-Free Film
LT » With Belt Tabs
> With ComfortWear Panels
- Transparent — Body Side Only
- Beige — Both Sides

HCPCS: A4432
Transparent Beige Pouch
Stock No Stock No Flange Size Length
18402 18412 & 1-3/4" (44 mm) 9" (23 cm)
Pediatric Ostomy Belt

3774 Single Unit

> Ostomy Belt

- White Color

HCPCS: A4367
Stock No Length
3774 10"- 17" (25 cm-43 cm)

2 DID YOU KNOW...

Shadow Buddies

e Exclusive to Hollister, Shadow Buddies
dolls are special friends for children who
have had or will have ostomy surgery

e Great teaching tool to help with education
and care giving

e Huggable dolls with heart-shaped eyes
and a stoma provide comfort

To order, see page 150.

Shadow Buddies is a trademark of The Shadow Buddies Foundation
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Hollister understands that no two people or stomas
are alike —and that barrier rings can play a
critical role in helping ensure the best outcome

for your patients

Whether you choose flat or convex, slim or regular,
round or oval—Adapt barrier rings:

e Are designed to be stretched or shaped

e Help prevent ostomy output from getting under
the pouch seal, which may reduce leakage and
skin irritation

e Can be cut or stacked together to improve the
fit of the pouching system

e Are designed for extended wear

e Are alcohol free, so there is no sting from alcohol
when applied to broken or irritated skin

Talk to your Hollister ostomy representative
about the full line of Adapt barrier rings.

2% Hollister

Hollister Ostomy. Details Matter.

The Hollister logo, Adapt, and “Hollister Ostomy.
Details Matter.” are trademarks of
Hollister Incorporated.

© 2016 Hollister Incorporated.



Ostomy Accessories

Adapt Skin Barrier Accessories

4 u 78xx Box of 10
» Barrier Rings (Flat)
w > Flextend M (extended wear) Material
HCPCS: A4385
Stock No Outer Diameter Thickness
7805 2" (48 mm) 4.5 mm
7815 2" (48 mm) 2.3 mm
7806 4" (98 mm) 2.3 mm
795xx Box of 10

» Convex Barrier Rings
> Flextend (extended wear) Material

f=1
gﬂ'

<< convex

HCPCS: A4411
Stock No Inner Diameter
79520 13/16" (20 mm) — can be stretched to 1" (25 mm)
79530 1-3/16" (30 mm) — can be stretched to 1-3/8" (35 mm)
79540 1-9/16" (40 mm) — can be stretched to 1-3/4" (45 mm)
796xx Box of 10
» Oval Convex Barrier Rings
0 {0 > Flextend (extended wear) Material < comex
HCPCS: A4411
Stock No Inner Diameter
79601 7/8" x 1-1/2" (22 mm x 38 mm)
— can be stretched to 1-1/8" x 1-3/4" (27 mm x 43 mm)
79602 1-3/16" x 1-7/8 (30 mm x 48 mm)
— can be stretched to 1-3/8" x 2-1/8" (35 mm x 53 mm)
79603 1-1/2" x 2-3/16" (38 mm x 56 mm)
— can be stretched to 1-3/4" x 2-3/8" (43 mm x 61 mm)
“ 79400 Box of 10
» Barrier Strips -
\\“‘\, > Flextend (extended wear) Material NOSTING
HCPCS: A4385
Stock No Size Length
79400 60 g 5-1/8" (13 cm)
Adapt Skin Barrier Paste
79300/79301
L
HCPCS: A4406
Stock No Description Quantity
79300 2.1 0z (60 g) tube Box of 1
79301 0.5 0z (14 g) tube Box of 20
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Easy adhesive

removal from

any angle.

Adapt Medical Adhesive Remover Spray
Stock Number 7737

With its silicone-based, alcohol-free formulation,

the Hollister Adapt medical adhesive remover spray

delivers an efficient solution for barrier removal

without the sting caused by alcohol.

It features innovative 360° spray technology to
deliver controlled, quiet spraying from any angle,
with minimal waste.

No-sting adhesive removal just got easier.

Talk to your Hollister Ostomy Sales Specialist about
making no-sting adhesive removal simpler with
Adapt medical adhesive remover spray.

Featuring a pressurized
bag, the new can

delivers convenient,

all-angle spraying.

Hollister

Hollister Ostomy. Details Matter.

© 2016 Hollister Incorporated.



Ostomy Accessories

Adapt Stoma Powder
7906 Box of 1
o HCPCS: A4371
Stock No Description
7906 10z (28.3 g) puff bottle

Adapt Odor Eliminator and Lubricant
% 78500/78501
L

HCPCS Code: A4394

Stock No Description Quantity
78500 8 0z (236 mL) bottle Box of 1
78501 0.27 oz (8 mL) packet 50 Packets/Box
Adapt Ostomy Belts

# .:3'!5; 7300/7299 Box of 10

. HCPCS: A4367

Beige

Stock No Size

7300 23"-43" (58 cm-109 cm) Medium
7299 34"-65" (86 cm-165 cm) Large

Adapt Adhesives and Removers

- 7760 1 Box
- » Universal Remover Wipes 50 Wipes Each
&t » For Adhesives and Barriers
. » Silicone Based
HCPCS: A4456
Stock No
7760
7737 Box of 1
= > Medical Adhesive Remover
F: > Silicone Based
HCPCS: A4455
Stock No Description
7737 1.7 0z (50 mL) 360 degree spray can
7730 Box of 1
> Medical Adhesive
E > Improves Adhesive Contact Between Skin and Barrier
- HCPCS: A4364
Stock No  Description
7730 3.2 0z (90 g) spray can
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Ostomy Accessories

Skin Prepping Product
iy = - 7917 1 Box
e » Skin Protective Wipes 50 Wipes Each
- HCPCS: A5120
Stock No
7917

Flextend (extended wear) Skin Barrier

8800
8801

HCPCS for 8800: A4385
HCPCS for 8801: A5122

Stock No Size
8800 4x4" (10 cmx 10 cm) Box of 5
8801 8x 8" (20 cm x 20 cm) Box of 3

Hydrofera Blue Foam Dressing

» Highly absorptive bacteriostatic foam dressing

» Broad spectrum activity against microorganisms commonly
ﬂ found in wounds, including MRSA and VRE

» Compatible for use with enzymatic debriders

» Does not harm growth factors

Stock No HCPCS Outer Diameter Quantity/Box

HBRF2650 AG209 2-1/2" (64 mm) 10

Caution: Federal (USA) law restricts this device to sale by or on the order of a physician
or licensed healthcare professional.

Odor Eliminators

773x
E » m9 Qdor Eliminator Spray
" HCPCS: No Code
Stock No (unscented) Description Quantity
7732 2 0z (60 mL) pump spray Box of 12
7733 8 0z (240 mL) pump spray Box of 6
(Green Apple
Stock No Scented)  Description Quantity
7734 2 0z (60 mL) pump spray Box of 12
7735 8 0z (240 mL) pump spray Box of 6
771X
E » m9 Odor Eliminator Drops
HCPCS: A4394
Stock No Description Quantity
7715 10z (30 mL) bottle Box of 12
7717 8 0z (240 mL) bottle Box of 6




Cleaner/Decrystallizer

7736 Box of 12
» m9 Cleaner/Decrystallizer
- » Cleans Urinary Drainage Systems
» pH Balanced and Non-Acidic
> Free Wash Bottle Included

HCPCS: A5131
Stock No Description
7736 16 0z (480 mL) bottle

Drainable Pouch Clamp

g s 8770 Box of 20

HCPCS: A4363
Stock No Color
8770 Beige

Urostomy Drain Tube Adapter
7331 Box of 10

HCPCS: A4421
Stock No
7331

Hollister Universal Catheter Access Port

9779 Box of 8
1 i » Graduated nipple and punch allows introduction
of catheter or drain through pouch
» Sterile
Stock No
9779




Ostomy Accessories

Other Accessories
Loop Ostomy Bridge

&~ ) 7767 Box of 20
» Sterile
HCPCS: A4421

Stock No
7767

Replacement Filters

C% 7766 Box of 5 Packs
(0], » For use with 366x, 383x and 389x
» 1 pack contains 20 Filters and 2 Plugs
HCPCS: A4368
Stock No
7766

Bedside Drainage Collection System with Anti-Reflux Valve

9839 Box of 20
» Sample Port

» Sterile Fluid Pathway

I HCPCS: A4357

Stock No Description

9839 68 0z (2000 mL) Capacity

Skin Barrier Pastes and Powders

Q 7910 Box of 12
> Karaya 5 Paste
HCPCS: A4405
Stock No Description
7910 4.5 0z (135 mL) tube
ﬁ 7905 Box of 12
> Karaya 5 Powder
HCPCS: A4371
Stock No Description
7905 2.5 0z (75 mL) puff bottle

Skin Barriers

7800 Box of 5
> Premium (standard wear) Skin Barrier

HCPCS: A4362

Stock No Size

7800 4x4”(10cmx 10 cm)

7700 Box of 5
> HolliHesive (standard wear) Skin Barrier

HCPCS: A4362

Stock No Size

7700 4x 4" (10cmx 10 cm)
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Irrigation Products

General Information

» Similar to an enema with the water being placed into the stoma.

» Routine irrigation is recommended to be done on doctor’s orders (to
regulate emptying the bowel at a scheduled time).

» Appropriate for some people with sigmoid or descending colostomies.

> Not appropriate for people with urostomy or ileostomy.

> Allow approximately one hour for irrigation procedure.

‘r‘ 721 Box of 1
s | > Cone Irrigator Kit Includes:
! > (1) Irrigator

> (1) Stoma Cone with Connector

> (1) Cleaning Brush

HCPCS: A4398 + A4399

Stock No
7721
Kj 7723 Box of 10
» Stoma Cone with Connector
> Replacement Unit
HCPCS: A4399
Stock No
7723
i 1460x (CUT-TO-FIT) Box of 5
' m > Flextend (extended wear) Skin Barrier
» With Tape Border
HCPCS: A4409
Stock No Flange Size For Stomas Up To
14602 @ 1-3/4” (44 mm) 1-1/4” (32 mm)
14603 @ 2-1/4” (57 mm) 1-3/4" (44 mm)
14604 @& 2-3/4" (70 mm) 2-1/4” (57 mm))
1815x Box of 5
» Drainable Irrigator Sleeve to be used
with New Image Two-Piece System
» With Belt Tabs
_ > Includes Clamp
©0 = HCPCS: A4397
Transparent
Stock No Flange Size Sleeve Length
18152 @ 1-3/4” (44 mm) 30" (76 cm)
18153 @ 2-1/4” (57 mm) 30" (76 cm)
18154 @& 2-3/4" (70 mm) 30" (76 cm)
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Irrigation Products

7728/7724 Box of 20
> |rrigator Sleeve with Belt Tabs
» Includes Clamp

HCPCS: A4397
Stock No Opening Size Sleeve Length
7728 2" (51 mm) 22" (56 cm)
7724 3" (76 mm) 22" (56 cm)
7300/7299 Box of 10
» Ostomy Belts
HCPCS: A4367
Beige
Stock No Size
7300 23"-43" (58 cm-109 cm) Medium
7299 34"-65” (86 cm-165 cm) Large

e

7740 Box of 10
> Adapt Stoma Lubricant
» For Use with Stoma Irrigator

HCPCS: A4402
Stock No Description
7740 4 0z (120 mL) bottle




CenterPointLock Two-Piece Pouching System

Letter Matching System

To help you select compatible CenterPointLock two-piece system

components, every CenterPointLock system product box label features

a letter designation: ®, ©, @, ®, or ©. Once you've selected a

CenterPointlLock two-piece system skin barrier, select a pouch, irrigator

drain, or stoma cap with a matching letter on the box label.

Flat Skin Barriers with Floating Flange

872x (CUT-TO-FIT) Box of 5

> Flextend (extended wear) Skin Barrier, Tape Border

HCPCS: A4409
Stock No Letter Match Flange Size For Stomas Up To
8727 ® 1-1/2" (38 mm) 1" (25 mm)
8722 ) 1-3/4" (44 mm) 1-1/4" (32 mm)
8723 ) 2-1/4" (57 mm) 1-3/4" (44 mm)
8724 ® 2-3/4" (70 mm) 2-1/4" (57 mm)

875X (CUT-TO-FIT) Box of 5

> Flextend (extended wear) Skin Barrier,

Without Tape Border

HCPCS FOR 8752, 8753 & 8757: A4409

HCPCS FOR 8754: A4410
Stock No Letter Match Flange Size For Stomas Up To
8752 0) 1-3/4" (44 mm) 1-1/4" (32 mm)
8753 0) 2-1/4" (57 mm) 1-3/4" (44 mm)
8754 ® 2-3/4" (70 mm) 2-1/4" (57 mm)

372X (CUT-TO-FIT) Box of 5

> FlexWear (standard wear) Skin Barrier, Tape Border

HCPCS FOR 3722-3724 & 3727: Ad4414

HCPCS FOR 3726: A4415
Stock No Letter Match Flange Size For Stomas Up To
3727 ® 1-1/2" (38 mm) 1" (25 mm)
3722 ) 1-3/4" (44 mm) 1-1/4" (32 mm)
3723 () 2-1/4" (57 mm) 1-3/4" (44 mm)
3724 ® 2-3/4" (70 mm) 2-1/4" (57 mm)
3726 ) 4" (102 mm) 3-1/2" (89 mm)

376X (CUT-TO-FIT) Box of 5

» SoftFlex (standard wear) Skin Barrier,

Without Tape Border

HCPCS FOR 3762, 3763 & 3767: Ad414

HCPCS FOR 3764 & 3766: A4415
Stock No Letter Match Flange Size For Stomas Up To
3767 ® 1-1/2" (38 mm) 1" (25 mm)
3762 0) 1-3/4" (44 mm) 1-1/4" (32 mm)
3763 ©) 2-1/4" (57 mm) 1-3/4" (44 mm)
3764 ® 2-3/4" (70 mm) 2-1/4" (57 mm)
3766 ) 4" (102 mm) 3-1/2" (89 mm)

Note: New Image and CenterPointl.ock

pouching systems are

not interchangeable.
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CenterPointLock Two-Piece Pouching System

Flat Skin Barriers with Floating Flange (continued)

370x (CUT-TO-FIT)

Box of 5

> HolliHesive (standard wear) Skin Barrier, Tape Border

HCPCS FOR 3702-3704 & 3707: A4414

HCPCS FOR 3706: A4415

Stock No Letter Match Flange Size For Stomas Up To
3707 ® 1-1/2" (38 mm) up to 3/4" (19 mm)
3702 0] 1-3/4" (44 mm) up to 1" (25 mm)
3703 ©) 2-1/4" (57 mm) up to 1-1/2" (38 mm)
3704 ® 2-3/4" (70 mm) upto 2" (51 mm)
3706 o) 4"(102mm)  upto 3-1/4" (82 mm)
874X (PRE-SIZED) Box of 5
> Flextend (extended wear) Skin Barrier, Tape Border
HCPCS: A4409
Stock No Letter Match Flange Size Barrier Opening
8743 ® 1-1/2" (38 mm) 7/8" (22 mm)
8744 ® 1-1/2" (38 mm) 1" (25 mm)
8745 O 1-3/4" (44 mm) 1-1/8" (29 mm)
8746 0) 1-3/4" (44 mm) 1-1/4" (32 mm)
8747 ©) 2-1/4" (57 mm) 1-3/8" (35 mm)
8748 ©) 2-1/4" (57 mm) 1-1/2" (38 mm)
374x (PRE-SIZED) Box of 5
> FlexWear (standard wear) Skin Barrier, Tape Border
HCPCS: Ad414
Stock No Letter Match Flange Size Barrier Opening
3747 ® 1-1/2" (38 mm) 3/4" (19 mm)
3742 ® 1-1/2" (38 mm) 1" (25 mm)
3748 0) 1-3/4" (44 mm) 1-1/4" (32 mm)
3743 ©) 2-1/4" (57 mm) 1-1/2" (38 mm)
3749 @ 2-1/4" (57 mm) 1-3/4" (44 mm)
Convex Skin Barriers with Floating Flange
877x (CUT-TO-FIT) Box of 5

> Flextend (extended wear) Skin Barrier,

Convex, Tape Border

<< convex

HCPCS: A4407
Stock No Letter Match Flange Size Barrier Opening
8774 O 1-3/4" (44 mm) 1" (25 mm)
8778 @ 2-1/4" (57 mm) 1-1/2" (38 mm)
87711 ® 2-3/4" (70 mm) 2" (51 mm)
873X (PRE-SIZED) Box of 5

> Flextend (extended wear) Skin Barrier,

Convex, Tape Border

< convex

HCPCS: A4407
Stock No Letter Match Flange Size Barrier Opening
8731 ® 1-1/2" (38 mm) 5/8" (16 mm)
8732 ® 1-1/2" (38 mm) 3/4" (19 mm)
8733 0] 1-3/4" (44 mm) 7/8" (22 mm)
8734 0) 1-3/4" (44 mm) 1" (25 mm)
8735 ) 2-1/4" (57 mm) 1-1/8" (29 mm)
8736 @ 2-1/4" (57 mm) 1-1/4" (32 mm)
8737 @ 2-1/4" (57 mm) 1-3/8" (35 mm)
8738 @ 2-1/4" (57 mm) 1-1/2" (38 mm)




Convex Skin Barriers with Floating Flange (continued)

373X (PRE-SIZED) Box of 5
> FlexWear (standard wear) Skin Barrier, (
Convex, Tape Border - CONVEX

HCPCS: A4373
Stock No Letter Match Flange Size Barrier Opening
3730 ® 1-1/2" (38 mm 1/2" (13 mm)
3731 ® 1-1/2" (38 mm 5/8" (16 mm)
3732 ® 1-1/2" (38 mm 3/4" (19 mm)
3733 0) 1-3/4" (44 mm 7/8" (22 mm)
3734 0) 1-3/4" (44 mm 1" (25 mm)
3735 @ 2-1/4" (57 mm 1-1/8" (29 mm)
3736 ©) 2-1/4" (57 mm 1-1/4" (32 mm)
3737 ©} 2-1/4" (57 mm 1-3/8" (35 mm)
3738 ©) 2-1/4" (57 mm 1-1/2" (38 mm)
3739 ® 2-3/4" (70 mm 1-5/8" (41 mm)
37310 ® 2-3/4" (70 mm 1-3/4" (44 mm)
37311 ® 2-3/4" (70 mm 2" (51 mm)
Drainable Pouches
‘© 389x/383x Box of 10
» Drainable Pouch, Replaceable Filter,
Clamp Closure, Odor-Barrier Rustle-Free Film, Belt Tabs,
- Without ComfortiWear Panels. Includes 1 Bag of 20 Hollister
Replacement Filters and 2 Plugs, #7766
HCPCS: A4425 + A4368
Transparent Beige Letter Flange Pouch
Stock No Stock No Match Size Length
3897 3837 ® 1-1/2" (38 mm) 12" (30 cm)
3892 3832 0} 1-3/4" (44 mm) 12" (30 cm)
3893 3833 ©) 2-1/4" (57 mm) 12" (30 cm)
3894 3834 ® 2-3/4" (70 mm) 12" (30 cm)
881x Box of 10

» Drainable Pouch, Without Integrated Filter,
Clamp Closure, Odor-Barrier Rustle-Free Film,
Belt Tabs, ComfortWear Panels — Both Sides

HCPCS: A5063

Beige Letter Flange Pouch
Stock No Match Size Length
8817 ® 1-1/2" (38 mm) 12" (30 cm)
8812 0} 1-3/4" (44 mm) 12" (30 cm)
8813 @ 2-1/4" (57 mm) 12" (30 cm)
8814 ® 2-3/4" (70 mm) 12" (30 cm)

380x/381x Box of 10

» Drainable Pouch, Without Integrated Filter,
Clamp Closure, Odor-Barrier Rustle-Free Film,
Belt Tabs, Without Comfort\//ear Panels

HCPCS: A5063

Transparent Beige Letter Flange Pouch
Stock No Stock No Match Size Length
3807 3817 ® 1-1/2" (38 mm) 11" (28 cm)
3802 3812 0) 1-3/4" (44 mm) 11" (28 cm)
3803 3813 ©) 2-1/4" (57 mm) 11" (28 cm)
3804 3814 ® 2-3/4" (70 mm) 11" (28 cm)
3806 — O 4" (102 mm) 11" (28 cm)
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CenterPointLock Two-Piece Pouching System

Drainable Pouches (continued)

387x Box of 10
» High Output Drainable Pouch, Without Integrated Filter,
Clamp Closure, Odor-Barrier Film, Belt Tabs
Without ComfortWear Panels

HCPCS: A4412
Transparent Letter Flange Pouch
Stock No Match Size Length
3872 0] 1-3/4" (44 mm) 16" (40 cm)
3873 @ 2-1/4" (57 mm) 16" (40 cm)
3874 ® 2-3/4" (70 mm) 16" (40 cm)
384x Box of 10

» Drainable Mini-Pouch, Without Integrated
Filter, Clamp Closure, Odor-Barrier Rustle-Free Film,
Belt Tabs, Without Comfort\//ear Panels

HCPCS: A5063

Beige Letter Flange Pouch
Stock No Match Size Length
3847 ® 1-1/2" (38 mm) 9" (23 cm)
3842 0] 1-3/4" (44 mm) 9" (23 cm)
3843 @ 2-1/4" (57 mm) 9" (23 cm)
3844 ® 2-3/4" (70 mm) 9" (23 cm)

Closed Pouches

834x Box of 15
» Closed Pouch, Integrated Filter, Odor-Barrier Rustle-Free Film,
Belt Tabs, ComfortWear Panels — Both Sides

HCPCS: A4419
Beige Letter Flange Pouch
Stock No Match Size Length
8347 ® 1-1/2" (38 mm) 7-1/2" (19 cm)
8342 0} 1-3/4" (44 mm) 7-1/2" (19 cm)
8343 @ 2-1/4" (57 mm) 7-1/2" (19 cm)
8344 ® 2-3/4" (70 mm) 7-1/2" (19 cm)

334x Box of 15

» Closed Pouch, Integrated Filter, Odor-Barrier
Rustle-Free Film, Belt Tabs, Without ComfortiWear Panels

HCPCS: A4419
Beige Letter Flange Pouch
Stock No Match Size Length
3347 ® 1-1/2" (38 mm) 9" (23 cm)
3342 0] 1-3/4" (44 mm) 9" (23 cm)
3343 ) 2-1/4" (57 mm) 9" (23 cm)
3344 ® 2-3/4" (70 mm) 9" (23 cm)
Urostomy Pouches

890x Box of 10

» Urostomy Pouch, Odor-Barrier Rustle-Free
Film, Belt Tabs, Comfort\//ear Panels — Both Sides

HCPCS: A4432
Beige Letter Flange Pouch
Stock No Match Size Length
8902 (0] 1-3/4" (44 mm) 9" (23 ¢cm)
8903 @ 2-1/4" (57 mm) 9" (23 cm)
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Urostomy Pouches (continued)

390x Box of 10
» Urostomy Pouch, Odor-Barrier Rustle-Free
Film, Belt Tabs, Without ComfortWear Panels

HCPCS: A4432
Transparent Letter Flange Pouch
Stock No Match Size Length
3907 ® 1-1/2" (38 mm) 9" (23 cm)
3902 ) 1-3/4" (44 mm) 9" (23 cm)
3903 ©) 2-1/4" (57 mm) 9" (23 cm)
3904 ® 2-3/4" (70 mm) 9" (23 cm)
Stoma Cap

340x Box of 25

» Stoma Cap, Integrated Filter, Odor-Barrier
Rustle-Free Film Without ComfortWear Panels

HCPCS: A5055

Beige Letter Flange Pouch
Stock No Match Size Length
3407 ® 1-1/2" (38 mm) 4-1/2" (11 cm)
3402 0} 1-3/4" (44 mm) 4-1/2" (11 cm)
3403 @ 2-1/4" (57 mm) 4-1/2" (11 cm)
3404 ® 2-3/4" (70 mm) 4-1/2" (11 cm)
Irrigator Sleeve

382x Box of 5

> Irrigator Sleeve, Belt Tabs

> Includes clamp

HCPCS: A4397
Transparent Letter Flange Pouch
Stock No Match Size Length
3827 ® 1-1/2" (38 mm) 30" (76 cm)
3822 0} 1-3/4" (44 mm) 30" (76 cm)
3823 @ 2-1/4" (57 mm) 30" (76 cm)
3824 ® 2-3/4" (70 mm) 30" (76 cm)
3826 © 4" (102 mm) 30" (76 cm)

73



Karaya 5 One-Piece Pouching System

Drainable Pouches

366X (PRE-SIZED) Box of 10

» Drainable Pouch, Karaya 5 (standard wear)
Skin Barrier— Convex, Tape Border, Replaceable Filter, Pouch
Clamp Closure, Odor-Barrier Rustle-Free Film, Belt Tabs,
Without ComfortWear Panels. Includes 1 Bag of 20 Hollister
Replacement Filters and 2 Plugs, #7766

HCPCS: A4389 + A4368 < convex
Transparent Pouch Pouch
Stock No Size Barrier Opening Length
3662 1" (25 mm) 5/8" (16 mm) 12" (30 cm)
3668 1-1/4" (32 mm) 7/8" (22 mm) 12" (30 cm)
3663 1-1/2" (38 mm) 1-1/8" (29 mm) 12" (30 cm)
3669 1-3/4" (44 mm) 1-3/8" (35 mm) 12" (30 cm)
3664 2" (51 mm) 1-1/2" (38 mm) 12" (30 cm)
3665 2-1/2" (64 mm) 2" (51 mm) 12" (30 cm)

360x (PRE-SIZED) Box of 10

» Drainable Pouch, Karaya 5 (standard wear)
Skin Barrier— Convex, Tape Border, Without Integrated Filter,
Pouch Clamp Closure, Odor-Barrier Rustle-Free Film, Belt
Tabs, Without Comfort\//ear Panels

HCPCS: A4389 < convex
Transparent Pouch Pouch
Stock No Size Barrier Opening Length
3608 1-1/4" (32 mm) 7/8" (22 mm) 12" (30 cm)
3603 1-1/2" (38 mm) 1-1/8" (29 mm) 12" (30 cm)
3609 1-3/4" (44 mm) 1-3/8" (35 mm) 12" (30 cm)
3604 2" (51 mm) 1-1/2" (38 mm) 12" (30 cm)
3605 2-1/2" (64 mm) 2" (51 mm) 12" (30 cm)
3606 3" (76 mm) 2-1/2" (64 mm) 12" (30 cm)

323X (PRE-SIZED) Box of 30

» Drainable Mini-Pouch, Karaya 5 (standard wear)
Skin Barrier— Convex, Tape Border, Without Integrated Filter,
Pouch Clamp Closure, Odor-Barrier Film, Belt Tabs, Without

ComfortWear Panels

HCPCS: A4389 << comvex
Transparent Pouch Pouch
Stock No Size Barrier Opening Length
3232 1" (25 mm) 5/8" (16 mm) 9" (23 cm)
3238 1-1/4" (32 mm) 7/8" (22 mm) 9" (23 cm)
3233 1-1/2" (38 mm) 1-1/8" (29 mm) 9" (23 cm)
3239 1-3/4" (44 mm) 1-3/8" (35 mm) 9" (23 cm)
3234 2" (51 mm) 1-1/2" (38 mm) 9" (23 cm)

322X (PRE-SIZED) Box of 30

» Drainable Pouch, Karaya 5 (standard wear)
Skin Barrier— Convex, Tape Border, Without Integrated Filter,
Pouch Clamp Closure, Odor-Barrier Film, Belt Tabs, Without

ComfortWear Panels

HCPCS: A4389 < comex
Transparent Pouch Pouch
Stock No Size Barrier Opening Length
3222 1" (25 mm) 5/8" (16 mm) 12" (30 cm)
3228 1-1/4" (32 mm) 7/8" (22 mm) 12" (30 cm)
3223 1-1/2" (38 mm) 1-1/8" (29 mm) 12" (30 cm)
3229 1-3/4" (44 mm) 1-3/8" (35 mm) 12" (30 cm)
3224 2" (51 mm) 1-1/2" (38 mm) 12" (30 cm)
3225 2-1/2" (64 mm) 2" (51 mm) 12" (30 cm)
3226 3" (76 mm) 2-1/2" (64 mm) 12" (30 cm)
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Drainable Pouches (continued)

327x (PRE-SIZED) Box of 30
» Drainable Pouch, Karaya 5 (standard wear)

Skin Barrier— Convex, Tape Border, Without Integrated Filter,

Pouch Clamp Closure, Odor-Barrier Film, Belt Tabs, Without
ComfortWear Panels

HCPCS: A4389 < convex
Transparent Pouch Pouch
Stock No Size Barrier Opening Length
3278 1-1/4" (32 mm) 7/8" (22 mm) 16" (40 cm)
3273 1-1/2" (38 mm) 1-1/8" (29 mm) 16" (40 cm)
3279 1-3/4" (44 mm) 1-3/8" (35 mm) 16" (40 cm)
3274 2" (51 mm) 1-1/2" (38 mm) 16" (40 cm)
3275 2-1/2" (64 mm) 2" (51 mm) 16" (40 cm)
3276 3" (76 mm) 2-1/2" (64 mm) 16" (40 cm)
Closed Pouches

332x (PRE-SIZED) Box of 30

» Closed Pouch, Karaya 5 (standard wear)
Skin Barrier— Convex, Tape Border, Integrated Filter,
Odor-Barrier Film, Belt Tabs, Without ComfortWear Panels

HCPCS: Ad417 < convex
Transparent Pouch Pouch
Stock No Size Barrier Opening Length
3328 1-1/4" (32 mm) 7/8" (22 mm) 9" (23 cm)
3323 1-1/2" (38 mm) 1-1/8" (29 mm) 9" (23 cm)
3329 1-3/4" (44 mm) 1-3/8" (35 mm) 9" (23 cm)
3324 2" (51 mm) 1-1/2" (38 mm) 9" (23 cm)
3325 2-1/2" (64 mm) 2" (51 mm) 9" (23 cm)
3326 3" (76 mm) 2-1/2" (64 mm) 9" (23 cm)

716X (PRE-SIZED) Box of 30

» Closed Pouch, Karaya 5 (standard wear)
Skin Barrier— Convex, Without Tape Border, Without
Integrated Filter, Odor-Barrier Film, Belt Tabs, Without
ComfortWear Panels

HCPCS: A4387 < convex
Transparent Pouch Pouch
Stock No Size Barrier Opening Length
7168 1-1/4" (32 mm) 7/8" (22 mm) 9" (23 cm)
7163 1-1/2" (38 mm) 1-1/8" (29 mm) 9" (23 cm)
7169 1-3/4" (44 mm) 1-3/8" (35 mm) 9" (23 cm)
7164 2" (51 mm) 1-1/2" (38 mm) 9" (23 cm)
7165 2-1/2" (64 mm) 2" (51 mm) 9" (23 cm)
7166 3" (76 mm) 2-1/2" (64 mm) 9" (23 cm)

Urostomy Pouches

143X (PRE-SIZED) Box of 10
» Urostomy Pouch, Karaya 5 (standard wear)
Skin Barrier— Convex, Tape Border, Odor-Barrier Film,
Belt Tabs, Without ComfortWear Panels

HCPCS: A4429 < convex
Transparent Pouch Pouch
Stock No Size Barrier Opening Length
1432 1"(25 mm) 5/8"(16 mm) 9" (23 cm)
1438 1-1/4"(32 mm) 7/8"(22 mm) 9" (23 cm)
1433 1-1/2"(38 mm) 1-1/8"(29 mm) 9" (23 cm)
1439 1-3/4" (44 mm) 1-3/8"(35 mm) 9" (23 cm)
1434 2"(51 mm) 1-1/2"(38 mm) 9" (23 cm)
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Other One-Piece Pouching Systems

Stoma Cap
318x (PRE-SIZED)

HCPCS: A5055

Box of 30

» Stoma Cap, Tape Adhesive, Integrated Filter,
Odor-Barrier Film, Without ComfortWear Panels

Beige

Stock No Opening Size
3184 2" (51 mm) 4-1/4" (11 cm)
3186 3" (76 mm) 4-1/4" (11 cm)

Discontinued Products (Stock Numbers)

Classic Product Line One-Piece Closed Mini, 7” Pouch

> Pre-Sized, With Adhesive Tape, With Integrated Filter
HCPCS: A4418

Transparent

Stock No Barrier Opening Pouch Length
3142 1" (25 mm) 7" (18 cm)
3143 1-1/2" (38 mm) 7" (18 cm)
3148 1-1/4” (32 mm) 7" (18 cm)
3144 2" (51 mm) 7" (18 cm)
3149 1-3/4” (44 mm) 7" (18 cm)

Hollister Incorporated

1.800.323.4060



Alternative Product Recommendation (Stock Numbers)

Premier One-Piece Closed Mini 7” Pouch

» Pre-Sized, SoftFlex skin barrier, Without Tape, With Integrated AF300 Filter

HCPCS: A4416

Beige
Stock No Barrier Opening Pouch Length

Note: Try Premier Stock No 82500 (Cut-to-Fit) when a transparent pouch is preferred
82125 1" (25 mm) 7" (18 cm)

Note: Try Premier Stock No 82500 (Cut-to-Fit) when a transparent pouch
and larger barrier opening is preferred

82135 1-3/8” (35 mm) 77 (18 om)

Note: Try Premier Stock No 82500 (Cut-to-Fit) when a transparent pouch
and smaller barrier opening is preferred

82130 1-3/16” (30 mm) 77 (18 om)

> Cut-to-Fit, SoftFlex skin barrier, Without Tape, With Integrated AF300 Filter

Transparent

Stock No For Stomas Up To Pouch Length
82500 2-1/8” (55 mm) 7" (18 cm)
82500 2-1/8" (55 mm) 9" (23 cm)
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Enterocutaneous

Fistula
Management

Hollister Ostomy. Details Matter.



Enterocutaneous Fistula Management

Key Goals for Nursing Management

e Protect the skin — The output from a fistula can be very irritating to
the skin. Broken skin contributes to pain and discomfort. A skin barrier
can protect the skin from contact with the drainage.

e Contain the output — If the output is minimal, gauze dressings may
be sufficient for containment. However, if the volume of the output from
the fistula is significant or frequently overwhelms the dressing, a pouch
may be more appropriate. Using a pouch can be more efficient and can
protect healthcare providers from exposure to bodily fluids.

e Measure the output — With a high output fistula, loss of fluids
and electrolytes can be a major concern. Measuring the drainage is
easier using a pouching system. Sometimes connecting a pouch to a
bedside collector can relieve the stress on the pouch, so the wear time
improves.

e Manage costs — Care of fistulas can be costly in terms of supplies
and human resources. Using a pouching system and appropriate
accessories can be more cost-effective and manageable than frequent
dressing changes.

e Control odor — Containment of the drainage in a pouching system,
even in small quantities, can manage odor effectively. Other accessory
products can also assist with odor control when the pouch is changed
or emptied.

e Provide patient comfort — Effectively managing a fistula can
contribute to patient dignity. Protecting the skin, collecting the
discharge, containing costs, and controlling odor all contribute to
patient comfort.

Reimbursement by Medicare

Reimbursement for fistula management under the Medicare program
is described in the Surgical Dressings Policy Article. Specifically the
article states:

“Surgical dressings are covered when either of the following criteria
are met:

1. They are required for the treatment of a wound caused by, or
treated by, a surgical procedure; or

2. They are required after debridement of a wound.”
The article goes on to explain:

“Examples of situations in which dressings are noncovered under the
Surgical Dressings benefit are:

a. Drainage from a cutaneous fistula which has not been caused by
or treated by a surgical procedure”

For information see The Fistula Management Care Tip on www.hollister.com

Sources: Local Coverage Article: Surgical Dressings - Policy Article - Effective October 2015 (A52491); NHIC, Inc.

Bryant RA, Management of Drain Sites and Fistulas in Acute and Chronic Wounds: Nursing Management.
Mosby Year Book, 1992.

Toth PE, et al, Fistula Management in Fecal and Urinary Divisions: Management Principles. Colwell, Goldberg,
Camel (eds.) Mosby, 2004
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Enterocutaneous Fistula Management

High Output Drainable Pouches
80070/80110 See Page 45

I"_r > Non Sterile, Drainable Pouch
h. "= > Flextend (extended wear) Skin Barrier — Flat
> Without Tape
» With Soft Tap
» With Access Window
» Odor-Barrier Film
» With ComfortiWear Panel — Body Side Only

HCPCS: A6154

i - 81070/81110 See Page 45
i".r > Sterile, Drainable Pouch
“ww’ > Flextend (extended wear) Skin Barrier — Flat

» Without Tape

» With Soft Tap

> With Access Window

» Odor-Barrier Film

» With ComfortiWear Panel — Body Side Only

HCPCS: A6154

Wound Drainage Collectors

970x/977x

» For Management of Draining Wounds, Fistulae,
or Draining Tube Sites

> Available With and Without FlexWear (standard wear)
Skin Barriers — Flat

» Sterile and Non Sterile Drainable Pouches

» Qdor-Barrier Film

» With Access Window

» Reclosable Cap

» Without Starter Hole

HCPCS: A6154
With Barrier: Non Sterile

Stock No Description Quantity/Box
9773 Small (for wounds up to 3") 10
9776 Medium (for wounds up to 3-3/4") 10
9778 Large (for wounds up to 4” x 8”) 3

With Barrier: Sterile

Stock No Description Quantity/Box
9701 Small (for wounds up to 3”) 5
9702 Medium (for wounds up to 3-3/4") 5
9703 Large (for wounds up to 4” x 8”) 3

Without Barrier: Sterile

Stock No Description Quantity/Box
9772 Small (for wounds up to 3") 10
9775 Medium (for wounds up to 3-3/4") 10
9777 Large (for wounds up to 4" x 8”) 3

Universal Catheter Access Port

9779 See Page 65
1 l » Graduated Nipple and Punch Allows Introduction
of Catheter or Drain Through Pouch
> Sterile
Stock No Quantity/Box
9779 8
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Pouchkins Pediatric Pouches

\ 3778/3796/3795/3797 See Page 55-56
> |deal for Small, Hard to Pouch Locations or Where Volume
L J of Output is Low

Adapt Barrier Rings
7805/7815/7806 See Page 61

u ﬂ > Adapt Barrier Rings (Flat)

> Flextend M (extended wear) Material

s 79520/79530/79540 See Page 61
ﬂ » Adapt Convex Barrier Rings
L= JS Flextend (extended wear) Material ( CONVEX
ﬂ, 79601/79602/79603 See Page 61
0 » Adapt Oval Convex Barrier Rings .
#» > Flextend (extended wear) Material ( CONVEX
Adapt Paste
79300 See Page 61

- Ef:__ » Use to Caulk Uneven Skin Contours
> Use to Help Prevent Drainage Getting Under Skin Barrier
of Pouch

Adapt Medical Adhesive Spray

7730 See Page 63
3 > Helps Improve Pouch Seal in Difficult Locations
- » Spray on Adhesive Side of Pouching System
Adapt Stoma Powder
7906 See Page 63
F=- > Helps to Dry Moist Irritated Skin for a Better Pouch Seal
m9 Spray
7733 See Page 64
= > Odor Eliminator Spray

=
L]

Bedside Drainage Collector

9839 See Page 66
> |deal for High Volume, Liquid Discharge
» Provides Larger Container for Collection of Fluid
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Glossary  Ostomy Care

AF300 Filter: “AF” stands for air flow and “300” represents the 300
mm? air flow surface area on every AF300 filter.

CeraPlus Skin Barrier: An extended wear skin barrier that has all the
basic characteristics of an ostomy skin barrier (adhesion, absorption,and
erosion resistance) and is infused with ceramide.

Closed Pouch: A pouch without a spout or a clamp. Quick and easy
to discard. It must be removed to be emptied.

Colostomy: An ostomy (surgical opening) created in the colon, part
of the large intestine.

ComfortWear Pouch Material: Lining over the plastic of the pouch to
enhance comfort and discretion. The soft pouch panels may be on one
or both sides of the pouch.

Convex Skin Barrier: Convex products curve outward toward the
peristomal skin to increase the depth of the skin barrier. This outward
curving is designed to promote a good seal between the ostomy
pouching system and the skin where flat skin barriers would be
unsuccessful.

Cut-to-Fit Skin Barrier: A skin barrier that can be cut to the right size
and shape for the stoma.

Drainable Pouch: A pouch with an opening at the bottom. An integrated
closure or clamp is used to keep the pouch closed until it is time to
empty it.

Enterocutaneous Fistula: An abnormal connection between the
intestine and the skin.

Extended Wear Skin Barrier: Skin barriers with special additives that
achieve a stronger adhesive seal and are more resistant to breakdown.
Skin barrier of choice for urostomies and ileostomies. It is not
recommended to use skin-prepping agents under extended wear

skin barriers.

Filter: Releases gas but not odor from a pouch. The key performance
factors of any filter are air flow, deodorization, and liquid protection.

Flange: The plastic ring in a two-piece ostomy system that is used
to connect the two parts together.

Flat Skin Barrier: Skin barriers that may be used when the stoma
protrudes from the abdomen.

Flextend Skin Barrier: An extended wear skin barrier that is durable
and offers high resistance to erosion. It swells when it comes in contact
with liquid to help form a seal between the skin and the stoma.

It offers strong adhesion and flexibility.

FlexWear Skin Barrier: A standard wear skin barrier that provides
moderate adhesion, and offers a good balance of durability and
gentleness. It is designed to be worn more than one day and tends to
hold its shape in the presence of fluids.

Floating Flange: Allows for fingers to be put under the flange for
support while attaching the pouch to the barrier on a two-piece
pouching system. The New Image two-piece pouching system has an
integrated floating flange.




FormaFlex Skin Barrier: An extended wear skin barrier which is
resistant to discharge. It has the ability to be stretched to fit the size and
shape of the stoma without the use of scissors. Found as an option in
the New Image two-piece system.

lleostomy: An ostomy (surgical opening) created in the small intestine.

Irrigation: A procedure used to control the time of elimination from
colostomy. It is not for everyone and requires special equipment
and teaching.

Karaya 5 Skin Barrier: Karaya is a natural skin barrier that is well-
suited for thin, fragile, and sensitive skin or in some cases where irritant
dermatitis has occurred. It is mildly adhesive and needs a belt or tape
to secure the pouching system.

Lock ’n Roll Microseal Closure: An integrated system for closing the
bottom of drainable pouches. This system utilizes plastic interlocking
microseals to create a secure closure. Found on New Image, Premier,
and Pouchkins drainable pouches.

Odor-Barrier Pouch: Features pouch film that is resistant to odor permeation.
The odor-barrier feature increases confidence when wearing a pouch.

Pre-Sized Skin Barrier: A skin barrier that is already cut to the
proper size if stoma is round.

QuietWear Pouch Material: Material comprised of a pouch film and
ComfortWear panel that are laminated together. This special design
results in the reduction of the pouch rustling noise.

Rustle-Free Pouch: Rustle-Free Pouch provides for ultimate discretion
since the pouch does not make noise during normal wear.

Shape-To-Fit: A skin barrier that can be stretched to the shape and
size of the stoma. This skin barrier does not require use of a scissors.
A possible choice when the stoma is not round or still changing sizes.

Skin Barrier: Portion of the pouching system that protects the skin from
contact with the discharge. It also provides an adhesive attachment for
the pouching system to the body. Examples include Flextend, FlexWear,
SoftFlex, and FormafFlex skin barriers.

SoftFlex Skin Barrier: A standard wear skin barrier, which has an
adhesive that is gentle to the skin, and allows for frequent pouch
changes. It offers lower erosion resistance, and is thin and flexible without
compromising security.

Standard Wear Skin Barrier: Provides a gentle adhesive attachment to the
skin. These skin barriers absorb less and disintegrate faster than extended
wear skin barriers. Examples include FlexWWear and SoftFlex skin barriers.

Stoma: The place where the drainage comes out of the body when you
have an ostomy. The stoma is red, moist and does not have feeling.

Urostomy: An ostomy (surgical opening) created to drain urine.

Urostomy Pouch: Pouch with a drain tap at the bottom so urine
can be emptied quickly and easily.

Wear Time: The length of time a product can be worn before failure.
Wear time varies widely based upon a variety of factors.
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VaPro

Touch Free Hydrophilic
Intermittent Catheter

A child’s first priority is to be a child. As a parent, you can
accomplish that by introducing VaPro touch free catheters into
his or her daily routine. Sized for pediatric use, and designed for
comfort and easy handling, it makes intermittent catheterization a
simple part of your little one’s life, right from the start.

To request a sample, call 888.740.8889 or visit
hollister.com/vapro

. Continence Care
% HOHlSter People First

The Hollister logo and VaPro are trademarks of Hollister Incorporated
© 2016 Hollister Incorporated. 922839-0316
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General Information

HCPCS Codes Disclaimer

The reimbursement information provided herein is intended to provide
general information concerning coding of Hollister products only. Hollister
does not guarantee coverage or payment for any products. The ultimate
responsibility for proper coding, satisfying reimbursement requirements,
and obtaining reimbursement remains with the provider. Coding and
coverage policies and guidelines are complex, can vary from one carrier
or region to another, and are updated frequently. Providers should check
with their local carriers or intermediaries often and should consult with
counsel, a reimbursement specialist, and/or the DMEGS website for any
coding, coverage, reimbursement, or billing questions.

HCPCS codes shown in this Product Catalog are current as of January 2016.
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Medicare Utilization Chart

Medicare’s Usual Maximum Quantity for Urological Supplies

The quantity of urological supplies needed by a patient is determined by
many factors. There will be variation according to individual need and
their needs may vary over time. The table below lists the maximum
number of items/units of service that are medically necessary. The actual
quantity needed for a particular patient may be more or less than the
amount listed. The medical necessity for use of a greater quantity of
supplies than the amounts listed must be clearly documented in the
patient’s medical record, and must be available upon request.

Per LCD for Urological Supplies (L33803), NHIC effective 10-1-2015.

A4217  Sterile water/saline, 500 mL *

A4310 Insert tray without drainage bag and without 1 tray/insertion
catheter (accessories only)

A4311  Insertion tray without drainage bag with indwelling 1 tray/insertion

catheter, foley type, two-way latex with coating (Teflon,
silicone, silicone elastomer, or hydrophilic, etc.)

A4312 Insertion tray without drainage bag with indwelling 1 tray/insertion
catheter, foley type, two-way all silicone

A4313  Insertion tray without drainage bag with indwelling 1 tray/insertion
catheter, foley type, three-way, for continuous irrigation

A4314 Insertion tray with drainage bag with indwelling 1 ea/mo

catheter, foley type, two-way latex with coating (Teflon,
silicone, silicone elastomer, or hydrophilic, etc.)

A4315  Insertion tray with drainage bag with indwelling 1 ea/mo
catheter, foley type, two-way, all silicone
A4316 Insertion tray with drainage bag with indwelling 1 ea/mo

catheter, foley type, three-way, for continuous irrigation
A4320 Irrigation tray with bulb or piston syringe, any purpose
A4321  Therapeutic agent for urinary catheter irrigation
A4322 Irrigation syringe, bulb, or piston, each

A4326 Male external catheter with integral
collection chamber, any type, each

A4327 Female external urinary collection device; meatal cup, each 1 ea/wk
A4328 Female external urinary collection device; pouch, each 1 ea/day

A4331 Extension drainage tubing, any type, any length, with *
connector/adapter, for use with urinary leg bag or
urostomy pouch, each

A4332  Lubricant, individual sterile packet, each 200 ea/mo

A4333  Urinary catheter anchor device, adhesive skin 3 ea/wk
attachment, each

A4334  Urinary catheter anchoring device, leg strap, each 1 ea/mo

A4335  Incontinence supply; miscellaneous *

A4336 Incontinence supply, urethral insert, any type, each *

A4338 Indwelling catheter; foley type, two-way latex with coating 1 ea/mo
(Teflon, silicone, silicone elastomer, or hydrophilic, etc.), each

A4340 Indwelling catheter; specialty type, (€.g., coudé, mushroom, 1 ea/mo
wing, etc.), each

A4344  Indwelling catheter, foley type, two-way, all silicone, each 1 ea/mo

A4346 Indwelling catheter; foley type, three-way for continuous 1 ea/mo
irrigation, each

A4349 Male external catheter, with or without adhesive, 35 ea/mo

disposable, each

* No established usual maximum, refer to Medicare Utilization Guidelines.



A4351

A4352

A4353
A4354
A4355

A4356

A4357

A4358

A4360

A4402
A4450
A4452
A4455

A4520
A4456
A4554
A5102

A5105
A5112

A5113
A5114
A5131

A5200

A9270

Intermittent urinary catheter; straight tip, with or without 200 ea/mo
coating (Teflon, silicone, silicone elastomer, or hydrophilic,

etc.), each

Intermittent urinary catheter; coudé (curved) tip, with or 200 ea/mo
without coating (Teflon, silicone, silicone elastomeric, or

hydrophilic, etc.), each

Intermittent urinary catheter, with insertion supplies 200 ea/mo
Insertion tray with drainage bag but without catheter 1 ea/mo
Irrigation tubing set for continuous bladder irrigation 1 ea/day
through a three-way indwelling foley catheter, each

External urethral clamp or compression device 1 ea/3 mo
(not to be used for catheter clamp), each

Bedside drainage bag, day or night, with or without 2 ea/mo
anti-reflux device, with or without tube, each

Urinary drainage bag, leg or abdomen, vinyl, with or 2 ea/mo
without tube, with straps, each

Disposable external urethral clamp or compression device, NC
with pad and/or pouch, each

Lubricant, per ounce *
Tape, non-waterproof, per 18 square inches 10 units (18 sq in)/mo
Tape, waterproof, per 18 square inches 10 units (18 sq in)/mo

Adhesive remover or solvent (for tape, cement, or other adhesive),
per ounce

Incontinence garment, any type (e.g., brief, diaper), each *
Adhesive remover, wipes, any type, each NC
Disposable underpads, all sizes *
Bedside drainage bottle with or without tubing, rigid or 1ea/3mo
expandable, each

Urinary suspensory with leg bag, with or without tube, each *
Urinary drainage bag, leg or abdomen, latex, with or 1 ea/mo
without tube, with straps, each

Leg strap; latex, replacement only, per set *
Leg strap, foam or fabric, replacement only, per set *
Appliance cleaner, incontinence and ostomy 1(16 02)/mo
appliances, per 16 ounce

Percutaneous catheter/tube anchoring device, adhesive *

skin attachment
Non-covered item or service

* No established usual maximum, refer to Medicare Utilization Guidelines.

Note: Intermittent catheterization using a sterile intermittent catheter kit (A4353) is
covered when the patient requires catheterization and the beneficiary meets one of
the following criteria (1-5):

1) The beneficiary resides in a nursing facility

2) The beneficiary is immunosuppressed, for example (not all-inclusive): on a

regimen of immunossuppressive drugs post-transplant, on cancer chemotherapy,

has AIDS, has a drug-induced state such as chronic oral corticosteriod use

3) The beneficiary has radiologically documented vesico-urethral reflux while on a
program of intermittent catheterization

4) The beneficiary is a spinal-cord-injured-female with neurogenic bladder who is
pregnant (for duration of pregnancy only)

5) The beneficiary has had distinct, recurrent urinary tract infections, while on a
program of sterile intermittent catheterization with A4351/A4352 and sterile
lubricant A4332, twice within the 12 months prior to the initiation of sterile
intermittent catheter kits.
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Intermittent Catheters

VaPro Touch Free Hydrophilic Intermittent Catheter

73xxx Box of 30
— > Protective Tip

> Protective Sleeve

> Pre-Hydrated, Ready to Use

> Coudé Tip

» Smooth Eyelets

> Not Made with Natural Rubber Latex

HCPCS: A4352
Stock No Length (inches) Size Description
73124 16 12 Fr Coudé
73144 16 14 Fr Coudé
73164 16 16 Fr Coudé
“a 74xxx Box of 30

> Protective Tip

> Protective Sleeve

» Pre-Hydrated, Ready to Use

> Integrated 1000 mL Collection Bag
» Smooth Eyelets

> Not Made with Natural Rubber Latex

o o

HCPCS: A4353
Stock No Length (inches) Size Description
74122 8 12 Fr Straight
74142 8 14 Fr Straight
74124 16 12 Fr Straight
74144 16 14 Fr Straight

VaPro Plus Pocket Touch Free Hydrophilic Intermittent Catheter

T1xxx-30 Box of 30
» Full Length Touch Free Catheter
in a Pocket Size Package
53 1 > Protective Slesve

> Integrated 1000 mL Collection Bag
» Smooth Eyelets

» Not Made with Natural Rubber Latex
> Protective Tip

HCPCS: A4353
Stock No Length (inches) Size Description
71082-30 8 8 Fr Straight
71102-30 8 10 Fr Straight
71122-30 8 12 Fr Straight
71142-30 8 14 Fr Straight
71084-30 16 8 Fr Straight
71104-30 16 10 Fr Straight
71124-30 16 12 Fr Straight
71144-30 16 14 Fr Straight
71164-30 16 16 Fr Straight
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It’s kind of a big deal.

Advance Plus Pocket

Touch Free Intermittent Catheter System
Same product, same reimbursement, 60% smaller package

Discreet. Convenient. Easy to Use.

e Compact packaging for convenient storage and carrying
e A gel reservoir to help eliminate the need for additional lubrication
¢ An integrated collection bag to help you catheterize anytime, anywhere
e A protective tip to help the catheter bypass environmental bacteria

For more information, visit
hollister.com/advanceplus

% Hollister

Caution: Federal (USA) law restricts this device for sale by or
on the order of a physician or licensed healthcare professional.
Refer to Instructions for Use for contraindications, warnings,
precautions, and possible complications.



Intermittent Catheters

Advance Plus Touch Free Intermittent Catheter System

N 94xxx/95XXX Box of 100
= =" » 16” length

> Gel Reservoir

> Protective Tip

> 1500 mL Collection Bag with Large Handle

» Smooth Eyelets

> Not Made with Natural Rubber Latex

HCPCS: A4353
Stock No Size Description
94064 6 Fr Straight
94084 8 Fr Straight
94104 10 Fr Straight
94124 12 Fr Straight
94144 14Fr Straight
94164 16 Fr Straight
94184 18 Fr Straight
95124 12 Fr Coudé
95144 14 Fr Coudé
95164 16 Fr Coudé

Advance Plus Pocket Touch Free Intermittent Catheter System

93xxx Box of 100
" » Pocket Size is the same product
‘ as 94xxx in a Smaller Package

HCPCS: A4353
Stock No Size Description
93104 10 Fr Pocket
93124 12 Fr Pocket
93144 14 Fr Pocket
93164 16 Fr Pocket

Advance Plus Touch Free Intermittent Catheter Kit

' " 96XXX/97XXX Box of 100
— =" » Kit Contains Gloves, Underpad Drape,

o =l and Benzalkonium Chloride Swabsticks

e
HCPCS: A4353

Stock No Size Description
96064 6 Fr Straight
96084 8 Fr Straight
96104 10 Fr Straight
96124 12 Fr Straight
96144 14 Fr Straight
96164 16 Fr Straight
96184 18 Fr Straight
97124 12Fr Coudé
97144 14 Fr Coudé
97164 16 Fr Coudé
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Intermittent Catheters

Apogee HC Hydrophilic Intermittent Catheter

’ 90xxx/91xxx Box of 30
» Smooth Insertion
> Simple To Use
» More Control
' » Not Made with Natural Rubber Latex

HCPCS: A4351 for all except
HCPCS: A4352 for 91226, 91426, 91626

Stock No Length Size Description
91006 6 10 Fr Straight
91206 6 12 Fr Straight
91406 6 14 Fr Straight
90810 10 8 Fr Straight
91010 10 10 Fr Straight
91216 16 12 Fr Straight
91416 16 14 Fr Straight
91616 16 16 Fr Straight
91816 16 18 Fr Straight
91226 16 12 Fr Coudé
91426 16 14 Fr Coudé
91626 16 16 Fr Coudé

2 DID YOU KNOW...

Apogee HC Hydrophilic Intermittent Catheter offers

trusted quality at a more affordable price

e Hydrophilic coating creates a slippery, smooth surface when
activated with water

* More control provided by the sliding sleeve

e Simple to use burstable sterile water pack
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Intermittent Catheters

Apogee Family of Intermittent Catheters

I 1 10XX/1XXXX Box of 30
» Smooth Eyelets Box of 50
» Not Made with Natural Rubber Latex (unless noted)
| HCPCS: A4351 for all except
HCPCS: A4352 for 10826, 11026, 11226, 11426, 11626,
[ 11826 and 1087

Apogee IC Intermittent Catheters, Firm Style

Length
Stock No (inches) Size
10806 6 ok
11006 6 10 Fr
11206 6 e
11406 6 14 Fr
11446* 6 14 Fr
10810 10 8
11010 10 10 Fr
10616 16 6k
10816 16 8Fr
11016 16 10 Fr
11216 16 12 Fr
11416 16 14Fr
11616 16 16 Fr
11816 16 18 Fr

*No funnel - Qty: 30/box

Apogee IC Intermittent Catheters, Firm Coudé Style

Length
Stock No (inches) Size
10826 16 SFr
11026 16 10 Fr
11226 16 12 Fr
11426 16 14 Fr
11626 16 16 Fr
11826 16 18 Fr

Qty: 30/box

Apogee Intermittent Catheters, Other Styles

Length
Stock No (inches) Size Style
1036 16 10Fr Soft
1046 16 12Fr Soft
1061 16 14 Fr Soft
1083 16 16 Fr Soft
1049 16 12 Fr  Firm, Curved Package
1065 16 14 Fr Firm, Curved Package
1074A 16 14 Fr Soft, Curved Package
1087 16 16 Fr Firm, Coudé, Curved Package
1051 16 12Fr Red Rubber Latex*
1067 16 14 Fr Red Rubber Latex*
1084 16 16 Fr Red Rubber Latex*

Qty: 30/box except curved package: 50/box
*Caution: This product contains natural rubber latex which may cause allergic reactions.



Intermittent Catheters

Apogee Plus System
e Bxxx Case of 100
~= » 16" length

> Protective Tip

> Pre-lubricated

» Smooth Eyelets

» 1500 mL Collection Bag

» Not Made with Natural Rubber Latex (unless noted)

HCPCS: A4353
Stock No Size Description
B8F 8 Fr Firm
B10F 10 Fr Firm
B12F 12 Fr Firm
B14F 14 Fr Firm
B16F 16 Fr Firm
B18F 18 Fr Firm
B12C 12 Fr Coudé
B14C 14 Fr Coudé
B16C 16 Fr Coudé
B12S 12Fr Soft
B14S 14 Fr Soft
B14R 14 Fr Red Rubber Latex*
B16R 16 Fr Red Rubber Latex*
B14F-Female 14 Fr, 6" Firm

*Caution: This product contains natural rubber latex which may cause allergic reactions.

Apogee Plus System Kit

BxxxB Case of 100
18 > 16” length
mes——_ > Protective Tip
= » Pre-lubricated
= > Smooth Eyelets
L _alie 1500 mL Collection Bag
» Kit Contains Gloves, Underpad Drape,
Gauze, and PVP Swabsticks
» Not Made with Natural Rubber Latex (unless noted)

HCPCS: A4353
Stock No Size Description
B6FB 6 Fr Firm
B8FB 8 Fr Firm
B10FB 10 Fr Firm
B12FB 12Fr Firm
B14FB 14 Fr Firm
B16FB 16 Fr Firm
B18FB 18 Fr Firm
B12CB 12Fr Coudé
B14CB 14 Fr Coudé
B16CB 16 Fr Coudé
B12SB 12Fr Soft
B14SB 14 Fr Soft
B12RB 12 Fr Red Rubber Latex*
B14RB 14 Fr Red Rubber Latex*
B16RB 16 Fr Red Rubber Latex*
B14FB-Female 14 Fr, 6" Firm

*Caution: This product contains natural rubber latex which may cause allergic reactions.
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Male External Catheters

InView Male External Catheters

974xx/975xx/976xx Box of 30
974xx-100/975xx-100/976xx-100 Box of 100
> Self-Adhesive

» Clear Material Enables Monitoring of Skin

> Not Made with Natural Rubber Latex

HCPCS: A4349
SPECIAL: shorter length sheath

Stock No  Stock No
Box of 30 Box of 100 Color Size

97425 97425-100 ] 25mm
— 97429 97429-100 | 29 mm
97432 97432-100 ] 32mm
97436 97436-100 | 36 mm
97441 97441-100 | 41 mm
STANDARD: the daily catheter for general use
Stock No  Stock No
Box of 30 Box of 100 Color Size
97525 97525-100 | 25 mm
— 97529 97529-100 | 29 mm
97532 97532-100 ] 32 mm
97536 97536-100 | 36 mm
97541 97541-100 u 41 mm

EXTRA: 70% more adhesive than Standard for added security

Stock No  Stock No
Box of 30 Box of 100 Color Size

97625 97625-100 ] 25 mm
— 97629 97629-100 ] 29 mm
97632 97632-100 u 32 mm
97636 97636-100 u 36 mm
97641 97641-100 u 41 mm

Extended Wear Male External Catheter
920x Box of 30

e 5 s Self-Adhesive
> Unique Inner Flap
> Easy Applicator Collar

» Contains Natural Rubber Latex

HCPCS: A4349
Stock No Color Size
9206 | 22 mm-25 mm
9207 | 26 mm-30 mm
9208 u 31 mm-35mm
9209 L 36 mm-39 mm

Caution: This product contains natural rubber latex which may cause allergic reactions.

Everyday Male External Catheter

910x Box of 30
. ' » Self-Adhesive
» Easy Applicator Collar

\l » Contains Natural Rubber Latex

HCPCS: A4349
Stock No Color Size
9106 | 22 mm-25 mm
9107 ] 26 mm-30 mm
9108 ] 31 mm-35 mm
9109 L 36 mm-39 mm

Caution: This product contains natural rubber latex which may cause allergic reactions.



Leg Bag Systems

Vented Urinary Leg Bag Combination Pack

9645/9655 Box of 10
> Includes:
(1) Vented Urinary Leg Bag — Medium or Large
(1) Extension Tubing with Vacuum Relief Valve, (18” Long,
Oval, 11/32” Effective Inside Diameter), with Connector
@ (1) Pair, Fabric Leg Bag Straps — Medium (23” Long,
1-1/8” Wide)
> Not Made with Natural Rubber Latex, Contains Sterile Components

HCPCS: A4358

Stock No Description Length Width
9645 Medium — 18 oz (540 mL) 10" 4-1/4”
9655 Large — 30 0z (900 mL) 11-1/8” 5"
Urinary Leg Bag
9814/9805 Box of 10
> Includes:

(1) Urinary Leg Bag — Medium or Large
> Not Made with Natural Rubber Latex

HCPCS: A9270
- HCPCS: A4358 (if straps are added)
Stock No Description Length Width
9814 Medium — 18 oz (540 mL) 10" 4-1/4"
9805 Large — 30 0z (900 mL) 11-1/8" 5"
Urinary Leg Bag Combination Pack
9348/9349 Box of 12

> Includes:
(1) Urinary Leg Bag — Medium or Large
(1) Extension Tubing (18" Long, Oval, 11/32" Effective Inside
Diameter) with Connector
(1) Pair, Fabric Leg Bag Straps — Medium
(23" Long, 1-1/8" Wide)
&= » Not Made with Natural Rubber Latex; Contains Sterile

Components
HCPCS: A4358
Stock No Description Length Width
9348 Medium — 18 oz (540 mL) 10" 4-1/4"
9349 Large — 30 0z (900 mL) 11-1/8" 5"
DID YOU KNOW... !

Hollister Leg Bags Offer Many Benefits: 5

o Comfort with soft, vinyl material

 Discreet profile with pleats

e Strap security with wide, woven fabric

o Minimal dexterity needed with easy-to-operate drain valve

© Reduced risk of pressure with protected strap connection buttons
© Helps decrease urine back flow with anti-reflux valve
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Leg Bag Accessories

Fabric Leg Bag Straps

9342/9343 10 Pair
> Not Made with Natural Rubber Latex

HCPCS: A5114

Stock No Description Length Width
9342 Small 15" 1-1/8"
9343 Medium 23" 1-1/8"

Extension Tubing

9345/9346 Box of 10
» Kink-resistant with Connector
Oval, 11/32" Effective Inside Diameter
» Thermoplastic Elastomer, Not Made with Natural Rubber Latex

HCPCS: A4331

Stock No Description Length
9345 Non Sterile 18"
9346 Sterile 18"




Collection Systems

Bedside Drainage Collection System with Anti-Reflux Valve

Stock No

9839

» Sample Port

» Sterile Fluid Pathway

> Not Made with Natural Rubber Latex
HCPCS: A4357

Description Length

Box of 20

Width

9839

68 0z (2000 mL) 12"

9-3/4"

Male Urinary Pouch External Collection Device*

G

Stock No

9873

» Cut-to-Fit, Flextend Skin Barrier

» Thin and Flexible

» No Additional Tape Needed

» Qdor-Barrier Film

» Convenience Drain

> Not Made with Natural Rubber Latex

HCPCS: A4326
Description Length

Box of 10

Width

9873

Male Urinary Pouch 7-1/2"

4-1/2"

Stock No

9811

» Cut-to-Fit, SoftFlex Skin Barrier

» Qdor-Barrier Film

» Convenience Drain

» Tape Strips and Skin Gel Wipe Included
» Not Made with Natural Rubber Latex

HCPCS: A4326
Description Length

Box of 10

Width

9811

Male Urinary Pouch 7-1/2"

4-1/2"

Female Urinary Pouch External Collection Device*

©

9840

» Cut-to-Fit, SoftFlex Skin Barrier
> Qdor-Barrier Film

» Convenience Drain

Box of 10

» Alternative to Indwelling Catheter for Bedridden Females
> Adapt Paste, Tape Strips, and Skin Gel Wipe Included

> Not Made with Natural Rubber Latex

HCPCS: A4328
Stock No Description Length Width
9840 Female Urinary Pouch 7-1/2" 4-1/2"

* Meant to be connected to leg bag or gravity drainage

101



102

Glossary  Gontinence Care

Anti-Reflux: Refers to a tube or collapsible material within a urine
collection device to help prevent urine from re-entering the tubing

Applicator Collar: Found on some Hollister male external catheters; a
plastic guide with notches for the thumb and forefinger to assist proper
placement against the tip of the penis

Bladder: A balloon-like muscular organ which lies in the pelvis and
functions to store and expel urine

Bladder Catheterization: A procedure in which a catheter is passed
through the urethra or stoma into the bladder for the purpose of draining
urine and performing diagnostic tests of bladder or urethral function

Benzalkonium Chloride (BZK): An antimicrobial solution used for
disinfecting the urethral opening prior to inserting an intermittent catheter.
Does not stain skin or clothing. Less likely to cause sensitivity

Catheter (Urinary): A hollow tube inserted through the urethra or a
stoma to the bladder to withdraw urine or administer medication

Closed System: Refers to a "touchless" catheter located within a urine
collection bag. The enclosed catheter is manipulated through the bag,
guided through the protective tip as it is inserted into the urethra or
stoma without being directly touched

Closed System Kit: Closed system catheter includes the catheter located
within the urine collection bag, and usually includes gloves, PVP or BZK
swab sticks, and underpad drape

Collection Bag: A leg bag or bedside bag designed to collect urine by
gravity that is connected by tubing to an indwelling or external catheter,
urinary pouch, or also to wound drainage systems

Color Coded: On Hollister intermittent catheters, the funnel ends are
color and size coordinated so catheters may be consistently ordered
by size or funnel color

Connector: A device that secures the extension tubing to the catheter
or urinary pouch system

Coudeé Tip: A slight bend manufactured in the tip of the catheter which
makes insertion past the prostate easier for some men. A notch at the
funnel end is a guide for alignment during insertion

External Condom Catheter: Device that is secured externally with
various adhesives to the penis shaft for the purpose of urine collection.
Must be connected with tubing to a urine collection bag

Extension Tubing: Tubing that provides the connection between an
external or indwelling catheter and a urine collection bag or leg bag. May
also serve as a connection between an ostomy pouch or wound drainage
collector. Made of latex or vinyl

Eyelet: An oval-shaped hole in the insertion end of the catheter to
facilitate drainage of urine from the bladder. Eyelets are usually two in
number, and may be across from each other or offset. Smooth eyelets
help protect the urethra from insertion trauma




Female Urinary Pouch: A cut-to-fit, one-piece, vinyl pouch with

a flexible synthetic barrier which is attached externally to the female
urethral/vaginal area. The pouch is usually connected to a bedside
collection bag. Recommended for the more immobile female

Firm Catheter: Refers to lesser pliability of a urethral catheter

Flexible: Refers to greater pliability of a urethral catheter or of a skin
barrier found on the external female and male urinary pouches

Flextend Barrier: A skin barrier with special additives that achieve a
stronger adhesive seal and are more resistant to breakdown from fluids.
Skin-prepping agents are not recommended under Flextend Skin Barriers

French Size: Abbreviated Fr, the measuring gauge for the outer
diameter of a straight or indwelling catheter

Funnel: Colored non-insertion end of an intermittent catheter allows for
ease of fluid control. A catheter tipped syringe may be attached at the
funnel for fluid instillation into the bladder. Color corresponds to specific
French size

Gel Reservoir: A small, lubricant-filled flexible device unique to Hollister
built into the Advance Plus touch free intermittent catheter system. The
catheter is evenly coated with gel as it passes through the gel reservoir

Grip Section: A finely ribbed area on the catheter in a closed catheter
system which assists with catheter control for continuous catheter
advancement

Hydrophilic Catheter: A coated catheter that is lubricated with water

Incontinence: Loss of control of bowel and/or bladder

Indwelling Catheter: A flexible tube that remains in the bladder
continuously to drain urine. May be referred to as a Foley catheter

Inner Flap: A thin, latex extra membrane inside Hollister Extended Wear
latex male external catheters. The inner flap rests against the tip of the
penis to prevent urine backwash and undermining of the catheter adhesive

Intermittent Catheter: A flexible tube that is used to empty the bladder
on a regular schedule; used for self-catheterization

Latex: A material made from natural rubber. Red rubber catheters and
some male external catheters are made from latex

Leg Bag Straps: Hold the leg bag in place

Luer End: No funnel on non insertion end. A syringe may be connected
to the Luer end for bladder irrigation or insertion of medication

Lubricant: A water soluble jelly applied to a catheter prior to insertion
which allows for easier insertion and helps minimize urethral irritation

Male External Urinary Pouch: A cut-to-fit, one-piece vinyl pouch with a
synthetic adhesive backing that may be used for the very short penis, or
the flush or retracted penis. Usually attached to a bedside collection bag,
and is recommended more for those with limited mobility

Meatus: The opening of the urethra in both men and women
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Glossary  Gontinence Care

Neurogenic Bladder: An atonic or unstable bladder associated with a
neurological condition, such as diabetes, stroke, or spinal cord injury

Non Latex: A material not made with Natural Rubber Latex; usually vinyl
or silicone for catheters or plastic for collection bags. Minimizes risk of
allergic reaction

Olive Tip: An oval-shaped catheter tip which makes it easier for a female
to find the urethral opening when catheterizing

Pre-Lubricated Catheter: Refers to a catheter which is lubricated by
passing through a gel reservoir, or a lubricated catheter in a closed
system, or a catheter in packaging which contains a lubricant packet
which is ruptured to lubricate the catheter prior to opening the packaging

Protective Tip: A specially designed system on some intermittent
catheters which functions to prevent urethra bacterial contamination

of the catheter. It is inserted into the urethra. The 15 mm length on the
Hollister protective tip helps decrease the risk of introducing bacteria
into the urethra. The tapered tip with multiple slits is designed for
comfortable insertion

PVP: Povidone iodine solution used as an antimicrobial disinfectant applied
to the urethral opening prior to catheter insertion. May stain clothing

Ring Cap: Cap on the protective tip protects the catheter tip. Ring assists
with cap removal especially for those with limited dexterity. Oval cap
design prevents roll away

Sizing Guide: Used for external catheters, these semicircular cutouts help
determine the diameter of the penis in order to guide selection for correct fit

Soft Catheter: A gentle, flexible catheter with limited firmness

SoftFlex Barrier: A flexible synthetic material that will conform to
rounded and some irregular surfaces. Gentle enough to be removed in
24 hours or less

Straight Tip: Refers to the tapered, rounded insertion end of a catheter

Urethra: The natural tube through which urine exits the bladder

Vacuum Relief Valve: A feature on the leg bag tubing that helps prevent
collapse of the tubing, as well as collapse of an external urinary pouch
or catheter

Vented Leg Bag: A special vacuum relief mechanism featured on the
oval kink-resistant tubing and the companion pouch which also features
an air vent. These combined features help to minimize a vacuum in the
leg bag as well as in the tubing. A vacuum is created as the urine cools
outside the body. The vacuum will stall urine drainage through the tubing
and/or prevent the leg bag from emptying completely







A Hollister Technology

Hollister Critical Care
Bowel Catheter Systems

Dedicated to excellence
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General Information

HCPCS Codes Disclaimer

The reimbursement information provided herein is intended to provide
general information concerning coding of Hollister products only. Hollister
does not guarantee coverage or payment for any products. The ultimate
responsibility for proper coding, satisfying reimbursement requirements,
and obtaining reimbursement remains with the provider. Coding and
coverage policies and guidelines are complex, can vary from one carrier
or region to another, and are updated frequently. Providers should check
with their local carriers or intermediaries often and should consult with
counsel, a reimbursement specialist, and/or the DMEGS website for any
coding, coverage, reimbursement, or billing questions.

HCPCS codes shown in this Product Catalog are current as of January 2016.
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Bowel Catheter Systems

ActiFlo Indwelling Bowel Catheter System
with Disposable Odor-Barrier Collection Bag with Filter

Catheter Kit Includes:
- » Catheter with odor-barrier technology (1)
» 2500 mL Disposable Odor-Barrier Collection Bag with Filter
» Hydrocolloid Skin Barriers (2)
> Lubricating Jelly Packets (2)
» Syringe (1)
> 1000 mL Irrigation Bag (1)
> Instruction Booklet (1)
> Not Made with Natural Rubber Latex

> Non Sterile
Stock No Low-Impact Zone Kits/Box
32006 4cm 1
32007 6.cm 1

ActiFlo Indwelling Bowel Catheter System
with Drainable Odor-Barrier Collection Bag

Catheter Kit includes:
I » Catheter with odor-barrier technology (1)
» 3000 mL Drainable Odor-Barrier Collection Bag (1)
: T » Hydrocolloid Skin Barriers (2)
> Lubricating Jelly Packets (2)
> Syringe (1)
» 1000 mL Irrigation Bag (1)
> Instruction Booklet (1)
> Not Made with Natural Rubber Latex

> Non Sterile
Stock No Low-Impact Zone Kits/Box
32004 4cm 1
32005 6.cm 1

InstaFlo Bowel Catheter System
Catheter Kit includes:

= » Catheter with Odor-Barrier Technology (1)
» 2500 mL Disposable Odor-Barrier Collection Bag with Filter (1)
i3 > Syringe (1)
- —

> Instruction Booklet (1)

> Quick Reference Insertion Guide (1)

> Not Made with Natural Rubber Latex

> Non Sterile

Stock No Description Kits/Box
33016 Catheter Kit with Odor-Barrier Technology 1




Bowel Care Accessories

Collection Bag with Filter
» 2500 mL Disposable Odor-Barrier Collection Bag with Filter

E » Activated Carbon Filter
a1 » Top-loading Connector
> Not Made with Natural Rubber Latex
® > Single-Use
Stock No Description Quantity/Box
31009 2500 mL Collection Bag with Filter 5

Collection Bag
> 3000 mL Drainable Odor-Barrier Collection Bag

i > Not Made with Natural Rubber Latex
Stock No Description Quantity/Box
31003 3000 mL Collection Bag* 5

Irrigation Bag

- » 1000 mL Irrigation Bag
» Not Made with Natural Rubber Latex

Stock No Description Quantity/Box
31005 1000 mL Irrigation Bag* 30

* For use with the ActiFlo Indwelling Catheter System only.

Caution: Federal (USA) Law restricts this device to sale by or on the order of a physician. Prior to use of the AnchorFast Guard oral
endotracheal tube fastener, be sure to read the entire product Instructions for Use package insert that accompanies the product.

109



Fecal Collectors

Fecal Collectors

i" 9880 Box of 10
' » Cut-to-Fit Flextend (extended wear) Tapered Skin Barrier
» Odor-Barrier Pouch Film
» Convenience Drain

HCPCS: A4330
Stock No Description Pouch Length
9880 Large 12" (30 cm)
n 9823 Box of 10

» Cut-to-Fit Flextend (extended wear) Tapered Skin Barrier
» Ultra-Clear Pouch Film
> Convenience Drain

HCPCS: A4330
Stock No Description Pouch Length
9823 Medium 10" (25 cm)
* 9822/9821 Box of 10

» Cut-to-Fit SoftFlex (standard wear) Skin Barrier
» Qdor-Barrier Pouch Film
» Convenience Drain

HCPCS: A4330
Stock No Description Pouch Length
9822 Medium 10" (25 cm)
9821 Large 12" (30 cm)
DID YOU KNOW... 1

To view video instructions for product application, visit }
http://www.hollister.com/us/bm/fc/ :
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Anchorfast

Oral Endotracheal Tube Fastener

With a long history of quality and innovation,
you can trust the AnchorFast product.

® Used at over 3,700 hospitals in the United States
® 20 years of demonstrated quality

® Ongoing innovation driven by customer feedback

Learn more at hollister.com/anchorfast
or call 888.740.8999

£ Hollister

CAUTION: Federal (USA) Law restricts this device to sale by or on the order of a physician. Prior to use of the
AnchorFast oral endotracheal tube fastener, be sure to read the entire product Instructions for Use package insert
that accompanies the product.

The Hollister logo and AnchorFast are trademarks of Hollister Incorporated.

© 2016 Hollister Incorporated
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Tube Fasteners

AnchorFast Guard Oral Endotracheal Tube Fastener

. 9800
e > Integrated Tube Protection Sleeve
- » Secures Oral Endotracheal Tubes (5 mm-10 mm inner diameter)

> Helps Optimize Oral Care
> Helps Safeguard Skin Health
» Individually Packaged
» Not Made with Natural Rubber Latex

Stock No HCPCS Description Quantity/Box

9800 A9900* /A9999**  AnchorFast Guard Oral Endotracheal 12
Tube Fastener

“to be used with a rented ventilator **to be used with a patient-owned ventilator

AnchorFast Oral Endotracheal Tube Fastener

9799
P » Secures Oral Endotracheal Tubes (5 mm-10 mm inner diameter)
. ‘ > Helps Optimize Oral Care
> Helps Safeguard Skin Health
» Individually Packaged
» Not Made with Natural Rubber Latex
Stock No HCPCS Description Quantity/Box

9799 A9900* /A9999**  AnchorFast Oral Endotracheal 12
Tube Fastener

“to be used with a rented ventilator **to be used with a patient-owned ventilator

AnchorFast Replacement Neck Band Straps

Stock No HCPCS Description Quantity/Box
9788 — Replacement Neck Band Straps 4

RxOnly Federal (USA) law restricts this device to sale by or on the order of a physician
or other healthcare practitioner licensed under state law to order this product.

DID YOU KNOW... 1

For more information about AnchorFast oral endotracheal tube }
fasteners, visit hollister.com/anchorfast :
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Tube Fasteners

Horizontal Tube Attachment Device (HTAD): Sterile

9781
e » Secures Drains, Tubes, or Catheters (5 Fr-40 Fr)
Parallel to Patient’s Skin
» Tubes Can be Secured at Exit Site, or Distal to Exit Site
> Helps Safeguard Skin Health
» Sterile, Not Made with Natural Rubber Latex
Stock No HCPCS Description Quantity/Box

9781 A5200 Horizontal Tube 5
Attachment Device (HTAD): Sterile

Vertical Tube Attachment Device (VTAD): Sterile

9782
&_ » Secures Drains, Tubes, or Catheters (5 Fr-40 Fr)
Vertical to Patient’s Skin
» Secures Tube at Exit Site
> Helps Safeguard Skin Health
» Sterile, Not Made with Natural Rubber Latex
Stock No HCPCS Description Quantity/Box

9782 A5200 Vertical Tube 5
Attachment Device (VTAD): Sterile

Drain Tube Attachment Device (DTAD): Sterile

9780

» Secures a Variety of Drains or Tubes (10 Fr-24 Fr)
Vertical to Patient’s Skin

» Sterile, Not Made with Natural Rubber Latex

Stock No HCPCS Description Quantity/Box

9780 A5200 Drain Tube 5
Attachment Device (DTAD): Sterile

Feeding Tube Attachment Device (FTAD)

9786
» Secures Nasogastric/Nasointestinal Tubes (5 Fr-18 Fr)
» Butterfly-Shaped FlexWear Skin Barrier
Conforms to Patient’s Nose
> Unique Swivel Clamp Helps Eliminate

Pressure on the Nares
> Not Made with Natural Rubber Latex

Stock No HCPCS Description Quantity/Box
9786 B9998 Feeding Tube 20
Attachment Device (FTAD)

Suction Tube Attachment Device (STAD)

- 9785
» Secures Nasogastric Tubes (12 Fr-18 Fr)
] » Butterfly-Shaped FlexWear Skin Barrier Conforms
to Patient’s Nose

» Unique Swivel Clamp Helps Eliminate Pressure on the Nares
> Not Made with Natural Rubber Latex

Stock No HCPCS Description Quantity/Box
9785 A9999 Suction Tube 20
Attachment Device (STAD)







Hydrofera Blue Ready.

Sel.
Go.

Top 10

Innovation
in Podiatry* from
Podiatry Today

Introducing Hydrofera Blue Ready foam
* Antibacterial
* No hydration

* Up to 7-day wear time

For more information, contact your
Hollister Wound Care representative.
1.888.740.8990 e hollisterwoundcare.com

BLUE %

I e 000

Caution: Federal law restricts this device for sale by or on the order of a physician or licensed healthcare
professional. Refer to Instructions for Use for contraindications, warnings, precautions, and

possible complications.

The Hollister logo is a trademark of Hollister Incorporated. Hydrofera Blue Ready and the Hydrofera Blue
logo are trademarks of Hydrofera, LLC. ©2014 Hollister Incorporated.
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General Information

HCPCS Codes Disclaimer

The reimbursement information provided herein is intended to provide
general information concerning coding of Hollister products only. Hollister
does not guarantee coverage or payment for any products. The ultimate
responsibility for proper coding, satisfying reimbursement requirements,
and obtaining reimbursement remains with the provider. Coding and
coverage policies and guidelines are complex, can vary from one carrier
or region to another, and are updated frequently. Providers should check
with their local carriers or intermediaries often and should consult with
counsel, a reimbursement specialist, and/or the DMEGS website for any
coding, coverage, reimbursement, or billing questions.

HCPCS codes shown in this Product Catalog are current as of January 2016.
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Medicare Utilization Chart

Medicare Usual Dressing Change Frequency
for Wound Care Supplies

The quantity and type of dressings dispensed at any one time must take
into account the current status of the wound(s), the likelihood of change,
and the recent use of dressings. Dressing needs may change frequently
(e.g., weekly) in the early phases of wound treatment and/or with heavily
draining wounds. Surgical dressings must be tailored to the specific
needs of an individual patient. The table below lists some coverage
guidelines and usual dressing change frequencies. The medical necessity
for more frequent dressing changes must be documented in the patient’s
medical record and submitted with the claim.

Per LCD for Surgical Dressings (L33831), NHIC effective 10-1-2015.

Frequency Wound
HCPCS Long Description of Change Condition
A4450  Tape, non-waterproof, based on
per 18 square inches drsg size
A4452  Tape, waterproof, per based on
18 square inches drsg size
A4461  Surgical dressing holder, non-reusable, each
A4463  Surgical dressing holder, reusable, each *
A4465  Non-elastic binder for extremity *
A4490  Surgical stockings above knee length, each
A4495  Surgical stockings thigh length, each *

A4500  Surgical stockings below knee length, each  *

A4510  Surgical stockings full length, each

*
A4649  Surgical supply; miscellaneous *
*

AB010  Collagen-based wound filler, dry
form, sterile, per gram of collagen

A6011  Collagen-based wound filler, gel/paste, *
per gram of collagen

A6021  Collagen dressing, sterile, size *
16 sq in or less, each

AB022  Collagen dressing, sterile, size more *

than 16 sq in but less than or equal
t0 48 sq in, each

A6023  Collagen dressing, sterile, size more *
than 48 sq in, each

AB024  Collagen dressing wound filler, per 6 inches ~ *

AB025  Gel Sheet for dermal or epidermal
application, (e.g., silicone, hydrogel,
other), each

A6154  Wound pouch, each 3/wk

A6196  Alginate or other fiber gelling dressing, 1/day  mod-high exudate
wound cover, sterile, pad size 16 sq in or
less, each dressing

A6197  Alginate or other fiber gelling dressing, 1/day  mod-high exudate
wound cover, sterile, pad size more than
16 sq in but less than or equal to 48 sq in,
each dressing

A6198  Alginate or other fiber gelling dressing, 1/day  mod-high exudate
wound cover, sterile, pad size more than
48 sq in, each dressing

* No established usual maximum, refer to Medicare Utilization Guidelines.



Frequency Wound

HCPCS Long Description of Change Condition

A6199  Alginate or other fiber gelling dressing, 2 units  mod-high exudate
wound filler, sterile, per 6 inches (12 in)/day

A6203  Composite dressing, sterile, pad size 3/wk

16 sq in or less, with any size
adhesive border, each dressing
A6204  Composite dressing, sterile, pad size 3/wk
more than 16 sq in but less than or equal
to 48 sq in, with any size adhesive
border, each dressing
A6205  Composite dressing, sterile, pad size more  3/wk
than 48 sq in, with any size adhesive
border, each dressing

A6206  Contact layer, sterile, 16 sq in or less, 1/wk line the wound
each dressing

A6207  Contact layer, sterile, more than 16 sq in but 1/wk line the wound
less than or equal to 48 sq in, each dressing

A6208  Contact layer, sterile, more than 48 sqin, ~ 1/wk line the wound
each dressing

ABG209  Foam dressing, wound cover, sterile, 3/wk mod-heavy
pad size 16 sq in or less, without adhesive exudate
border, each dressing

A6210  Foam dressing, wound cover, sterile, 3/wk mod-heavy
pad size more than 16 sq in but less than exudate

or equal to 48 sq in, without adhesive
border, each dressing

A6211  Foam dressing, wound cover, sterile, 3/wk mod-heavy
pad size more than 48 sq in, without exudate
adhesive border, each dressing

AG212  Foam dressing, wound cover, sterile, 3/wk mod-heavy
pad size 16 sq in or less, with any size exudate
adhesive border, each dressing

A6213  Foam dressing, wound cover, sterile, 3/wk mod-heavy
pad size more than 16 sq in but less than exudate

or equal to 48 sq in, with any size adhesive
border, each dressing
A6214  Foam dressing, wound cover, sterile, 3/wk mod-heavy
pad size more than 48 sq in, with any exudate
size adhesive border, each dressing
A6215  Foam dressing, wound filler, sterile, per gram 1/day —mod-heavy exudate
A6216  Gauze, non-impregnated, non sterile, 3/day
pad size 16 sq in or less, without
adhesive border, each dressing
A6217  Gauze, non-impregnated, non sterile, 3/day
pad size more than 16 sq in but less
than or equal to 48 sq in, without
adhesive border, each dressing
A6218  Gauze, non-impregnated, non sterile, 3/day
pad size more than 48 sq in, without
adhesive border, each dressing
A6219  Gauze, non-impregnated, sterile, 1/day
pad size 16 sq in or less, with any size
adhesive border, each dressing
A6220  Gauze, non-impregnated, sterile, 1/day
pad size more than 16 sq in but less
than or equal to 48 sq in, with any
size adhesive border, each dressing
A6221  Gauze, non-impregnated, sterile, 1/day
pad size more than 48 sq in, with any
size adhesive border, each dressing

* No established usual maximum, refer to Medicare Utilization Guidelines.
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Frequency Wound
HCPCS Long Description of Change Condition

A6222  Gauze, impregnated with other than 1/day
water, normal saline, or hydrogel, sterile
pad size 16 sq in or less, without
adhesive border, each dressing

A6223  Gauze, impregnated with other than 1/day
water, normal saline, or hydrogel, sterile
pad size more than 16 sq in but less
than or equal to 48 sq in, without
adhesive border, each dressing

A6224  Gauze, impregnated with other than 1/day
water, normal saline, or hydrogel, sterile
pad size more than 48 sq in, without
adhesive border, each dressing

A6228  Gauze, impregnated with water or * Non-Covered
normal saline, sterile, pad size 16 sq in or
less, without adhesive border, each dressing

A6229  Gauze, impregnated with water or * Non-Covered
normal saline, sterile, pad size more than
16 sq in but less than or equal to
48 sq in, without adhesive border,
each dressing

A6230  Gauze, impregnated with water or normal * Non-Covered
saline, sterile, pad size more than 48 sq in,
without adhesive border, each dressing

A6231  Gauze, impregnated, hydrogel, 1/day min-no exudate
for direct wound contact, sterile, pad size
16 sq in or less, each dressing

A6232  Gauze, impregnated, hydrogel, 1/day min-no exudate
for direct wound contact, sterile, pad size
more than 16 sq in but less than or
equal to 48 sq in, each dressing

A6233  Gauze, impregnated, hydrogel, 1/day min-no exudate
for direct wound contact, sterile, pad size
more than 48 sq in, each dressing

AG234  Hydrocolloid dressing, wound cover, 3wk light-mod exudate
sterile, pad size 16 sq in or less, without
adhesive border, each dressing

A6235  Hydrocolloid dressing, wound cover, 3wk light-mod exudate
sterile, pad size more than 16 sq in but
less than or equal to 48 sq in,
without adhesive border, each dressing

A6236  Hydrocolloid dressing, wound cover, 3wk  light-mod exudate
sterile, pad size more than 48 sq in,
without adhesive border, each dressing

A6237  Hydrocolloid dressing, wound cover, 3wk light-mod exudate
sterile, pad size 16 sq in or less, with
any size adhesive border, each dressing

A6238  Hydrocolloid dressing, wound cover, 3/wk  light-mod exudate
sterile, pad size more than 16 sq in but
less than or equal to 48 sq in, with any size
adhesive border, each dressing

A6239  Hydrocolloid dressing, wound cover, 3wk light-mod exudate
sterile, pad size more than 48 sq in, with
any size adhesive border, each dressing

AB240  Hydrocolloid dressing, wound filler, 3wk light-mod exudate
paste, sterile, per ounce
A6241  Hydrocolloid dressing, wound filler, 3wk  light-mod exudate

dry form, sterile, per gram
* No established usual maximum, refer to Medicare Utilization Guidelines.
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Frequency Wound
HCPCS Long Description of Change Condition

A6242  Hydrogel dressing, wound cover, sterile, 1/day min-no exudate
pad size 16 sq in or less, without
adhesive border, each dressing

AB243  Hydrogel dressing, wound cover, sterile, 1/day min-no exudate
pad size more than 16 sq in but less than
or equal to 48 sq in, without adhesive border,
each dressing

AB244  Hydrogel dressing, wound cover, sterile, 1/day min-no exudate
pad size more than 48 sq in, without
adhesive border, each dressing

AB245  Hydrogel dressing, wound cover, sterile, 3/wk min-no exudate
pad size 16 sq in or less, with any size
adhesive border, each dressing

A6246  Hydrogel dressing, wound cover, sterile, 3/wk min-no exudate
pad size more than 16 sq in but less
than or equal to 48 sq in, with any size
adhesive border, each dressing

AB247  Hydrogel dressing, wound cover, sterile, 3/wk min-no exudate
pad size more than 48 sq in, with any
size adhesive border, each dressing

A6248  Hydrogel dressing, wound filler, 1/dayupto  min-no exudate
gel, per fluid ounce 3 0z/mo

A6250  Skin sealants, protectants, moisturizers, *
ointments, any type, any size

A6251  Specialty absorptive dressing, wound 1/day  mod-high exudate

cover, sterile, pad size 16 sq in or less
without adhesive border, each dressing
A6252  Specialty absorptive dressing, wound 1/day  mod-high exudate
cover, sterile, pad size more than 16 sq in
but less than or equal to 48 sq in,
without adhesive border, each dressing
AB253  Specialty absorptive dressing, wound 1/day  mod-high exudate
cover, sterile, more than 48 sq in,
without adhesive border, each dressing

A6254  Specialty absorptive dressing, wound every other mod-high
cover, sterile, pad size 16 sq in or less day exudate
with any size adhesive border, each dressing

A6255  Specialty absorptive dressing, wound every other mod-high
cover, sterile, pad size more than 16 sqin~ day exudate

but less than or equal to 48 sq in, with
any size adhesive border, each dressing

A6256  Specialty absorptive dressing, every other mod-high
wound cover, sterile, more than 48 sq in, day exudate
with any size adhesive border,
each dressing

A6257  Transparent film, sterile, 16 sq in or less, ~ 3/wk min exudate
each dressing
A6258  Transparent film, sterile, more than 3/wk min exudate

16 sq in but less than or equal
10 48 sq in, each dressing

AG259  Transparent film, sterile, more than 3/wk min exudate
48 sq in, each dressing

A6260  Wound cleanser, any type, any size *

A6261  Wound filler, gel/paste, per fluid ounce, 1/day
not otherwise classified

A6262  Wound filler, dry form, per gram, 1/day
not otherwise classified

* No established usual maximum, refer to Medicare Utilization Guidelines.
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Frequency Wound
HCPCS Long Description of Change Condition

AB266  Gauze, impregnated, other than water, 1/day
normal saline, or zinc paste, sterile,
any width, per linear yard

A6402  Gauze, non-impregnated, sterile, 3/day
pad size 16 sq in or less, without
adhesive border, each dressing

A6403  Gauze, non-impregnated, sterile, 3/day
pad size more than 16 sq in but less
than or equal to 48 sq in, without
adhesive border, each dressing

A6404  Gauze, non-impregnated, sterile, 3/day
pad size more than 48 sq in,
without adhesive border, each dressing

A6407  Packing strips, non-impregnated, sterile 3/day
up to 2 inches in width, per linear yard

ABG410  Eye pad, sterile, each

AB411  Eye pad, non sterile, each

AB412  Eye patch, occlusive, each

A6413  Adhesive bandage, first-aid type,
any size each

A6441  Padding bandage, non-elastic, same as ds
non-woven/non-knitted, width greater chg freq
than or equal to three inches and
less than five inches, per yard

* |k | k| ¥

A6442  Conforming bandage, non-elastic, same as ds
knitted/woven, non sterile, width chg freq
less than three inches, per yard

A6443  Conforming bandage, non-elastic, same as ds
knitted/woven, non sterile, width chg freq

greater than or equal to three inches
and less than five inches, per yard

A6444  Conforming bandage, non-elastic, same as ds
knitted/woven, non sterile, width chg freq
greater than or equal to five inches,
per yard

A6445  Conforming bandage, non-elastic, same as ds
knitted/woven, sterile, width less chg freq
than three inches, per yard

A6446  Conforming bandage, non-elastic, same as ds
knitted/woven, sterile, width greater chg freq

than or equal to three inches and
less than five inches, per yard

A6447  Conforming bandage, non-elastic, same as ds
knitted/woven, sterile, width greater chg freq
than or equal to five inches, per yard

ABG448  Light compression bandage, elastic, 1/wk

knitted/woven, width less than three
inches, per yard

A6449  Light compression bandage, elastic, 1/wk
knitted/woven, width greater than or
equal to three inches and less than
five inches, per yard

ABG450  Light compression bandage, elastic, 1/wk
knitted/woven, width greater than or
equal to five inches, per yard

* No established usual maximum, refer to Medicare Utilization Guidelines.
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Frequency Wound
HCPCS Long Description of Change Condition

A6451  Moderate-compression bandage, elastic, 1/wk
knitted/woven, load resistance of 1.25 to
1.34 foot pounds at 50% maximum stretch,
width greater than or equal to three inches
and less than five inches, per yard

AB452  High-compression bandage, elastic, 1/wk
knitted/woven, load resistance greater
than or equal to 1.35 foot pounds at
50% maximum stretch, width greater
than or equal to three inches and less
than five inches, per yard

A6453  Self-adherent bandage, elastic, 1/wk
non-knitted/non-woven, width less
than three inches, per yard

A6454  Self-adherent bandage, elastic, 1/wk
non-knitted/non-woven, width greater
than or equal to three inches and less
than five inches, per yard

A6455  Self-adherent bandage, elastic, 1/wk
non-knitted/non-woven, width greater
than or equal to five inches, per yard

AB456  Zinc paste-impregnated bandage, 1/wk
non-elastic, knitted/woven, width greater
than or equal to three inches and less
than five inches, per yard

A6457  Tubular dressing with or without elastic, *
any width, per linear yard
A6501  Compression burn garment, bodysuit *

(head to foot), customer fabricated

AB502  Compression burn garment, chin strap,
customer fabricated

A6503  Compression burn garment, facial hood, *
custom fabricated

A6504  Compression burn garment, glove to wrist, *
custom fabricated

*

AB505  Compression burn garment, glove to *
elbow, custom fabricated

A6506  Compression burn garment, glove to *
axilla, custom fabricated

A6507  Compression burn garment, foot to knee *
length, custom fabricated

AB508  Compression burn garment, foot to *
thigh length, custom fabricated

A6509  Compression burn garment, upper trunk *

to waist including arm openings (vest),
custom fabricated

A6510  Compression burn garment, trunk, *
including arms down to leg openings
(leotard), custom fabricated

A6511  Compression burn garment, lower trunk *
including leg openings (panty),
custom fabricated

A6512  Compression burn garment, *
not otherwise classified
AB513  Compression burn mask, face and/or *

neck, plastic or equal, custom fabricated

* No established usual maximum, refer to Medicare Utilization Guidelines.
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HCPCS Long Description
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AB530  Gradient compression stocking, below * open venous ulcer
knee,18-30 mm HG, each

A6531  Gradient compression stocking, below * open venous ulcer
knee, 30-40 mm HG, each

A6532  Gradient compression stocking, below * open venous ulcer
knee, 40-50 mm HG, each

AB533  Gradient compression stocking, thigh * open venous ulcer
length,18-30 mm HG, each

A6534  Gradient compression stocking, thigh * open venous ulcer
length, 30-40 mm HG, each

A6535  Gradient compression stocking, thigh * open venous ulcer
length, 40-50 mm HG, each

AB536  Gradient compression stocking, full * open venous ulcer
length/chap style,18-30 mm HG, each

A6537  Gradient compression stocking, full * open venous ulcer
length/chap style, 30-40 mm HG, each

A6538  Gradient compression stocking, full open venous ulcer
length/chap style, 40-50 mm HG, each

AB539  Gradient compression stocking, waist * open venous ulcer
length,18-30 mm HG, each

A6540  Gradient compression stocking, waist * open venous ulcer
length, 30-40 mm HG, each

A6541  Gradient compression stocking, waist * open venous ulcer
length, 40-50 mm HG, each

AB544  Gradient compression stocking, garter belt * open venous ulcer

AB545  Gradient compression wrap, non-glastic, ~ 1/6 mo  open venous ulcer
below knee, 30-50 mm HG, each

A6549  Gradient compression stocking/sleeve, * open venous ulcer
not otherwise specified

A9720  Non-covered item or service

* No established usual maximum, refer to Medicare Utilization Guidelines.



Strength Meets Simplicity.

THE STRENGTH OF A DERMAL TEMPLATE + THE SIMPLICITY OF COLLAGEN.

Finally, there’s a collagen extracellular matrix dressing
available from Day One. Endoform dermal template delivers:

* 90% collagen with an intact, native extracellular matrix
* Pricing similar to standard collagen dressings

» Advanced care accessible to all clinicians

* Cost efficiency through weekly applications’

* Broad-spectrum MMP inhibition®

For more information, contact Hollister at
1.888.740.8999 or www.hollisterwoundcare.com.

1. HCPCS Codes A6021, A6022 collagen dressing.

2. Endoform Dermal Template Instructions for Use.

3. Negron L, Lun S, May BC. Ovine forestomach matrix biomaterial is a broad spectrum
inhibitor of matrix metalloproteinases and neutrophil elastase. Int Wound J. 2012 Nov 1.

Caution: Federal law restricts this device for sale or on the order of a physician or
licensed healthcare professional. Refer to Instructions for Use for contraindications,
warnings, precautions, and possible complications.

Hollister and logo is a trademark of Hollister Incorporated. Endoform is a trademark of
Mesynthes Limited. © 2013 Hollister Incorporated. 922446-1113

LT
2% Hollister QndOform
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Endoform Dermal Template

> 90% collagen with an intact, native extracellular matrix
» Pricing similar to standard collagen dressings

» Advanced care accessible to all clinicians

» Cost efficiency through up to weekly applications’

» Broad-spectrum MMP inhibition?

Stock No HCPCS Size Quantity/Box
529311 A6021 2"x2" (5ecmx5cm) 10
529312 A6021 2" x 2" (5 cmx 5 cm) fenestrated 10
529313 A6022 4’x5” (10 cmx 12.7 cm) 10
529314 AB022 4" x 5" (10 cm x 12.7 cm) fenestrated 10

1. Endoform Dermal Template Instructions for Use.
2. Negron L, Lun S, May BC. Ovine forestomach matrix biomaterial is a broad spectrum
inhibitor of matrix metalloproteinases and neutrophil elastase. Int Wound J. 2012 Nov 1.

Caution: Federal (USA) law restricts this devices to sale by or on the order of a physician
or licensed healthcare professional. Refer to Instructions for Use for contraindications,
warnings, precautions, and possible complications.

2 DID YOU KNOW...

Endoform Dermal Template Education

You can learn more about Endoform dermal template at our website,
www.hollister.com.

The website features:
- A complimentary webcast
- An informative mode-of-action video




Hydrofera Blue Foams

!

> Highly Absorptive Antibacterial Foam

» Broad Spectrum Activity Against Microorganisms Commonly
Found in Wounds, Including MRSA and VRE

» Compatible for Use with Enzymatic Debriders

> Does Not Harm Growth Factors

Hydrofera Blue Classic Foam

Standard Dressings:

Stock No HCPCS Description Quantity/Box
HB2214 AB209 2"x2" 10
HB4414 AB209 4" x 4" 10
HB6614 A6210 6"x6" 10
HBT0906 A6215 9 mm Tunneling Dressing 10 pair

Heavy Drainage Dressings

Stock No HCPCS Description Quantity/Box
HBHD4450 A6209 4" x 4" x 1/2" thick 5
HBHD6675 AB210 6" x 6" x 3/4" thick 5

Dressings with Moisture-Retentive Film Backing

Stock No HCPCS Description Quantity/Box

HBRF4414 A6209 4"x 4" 10

HBRF2258 A6210 2-1/4" x 8" 10

HBRF4475 A6212 4" x 4-3/4" Island Dressing 10
(pad size 2" x 2-3/4")

HBRF2650 AB209 2-1/2" diameter Ostomy Dressing 10

Caution: Federal (USA) law restricts this devices to sale by or on the order of a physician
or licensed healthcare professional. Refer to Instructions for Use for contraindications,
warnings, precautions, and possible complications.

Hydrofera Blue Ready Foam
» No Hydration Required Prior to Application

» Antibacterial Foam Dressing with a Seven Day Wear Time
» Features a Waterproof Backing that Prevents Strikethrough

and Acts as a Barrier to Moisture and Bacteria

Standard Dressings:

Stock No HCPCS Description Quantity/Box
HBRS2520 A6209 25"x 25" 10
HBRS4520 A6210 4"x5" 10
HBRS8820 AB211 8"x8" 10
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FastCast OLS Total Contact Cast System Convenience Kit

» Vascular Management with low-level compression sock

> Infection Management and Prevention with the included
Hydrofera Blue Ready foam and Endoform dermal template
dressings

'\ > Pressure Relief with FastCast OLS total contact cast system
L e

Stock No Product Description
FC0001 FastCast OLS 50“ - 1 Cast Kit
FC0001-8 FastCast OLS 50“ - 8 Cast Kits
FC0002 FastCast OLS 50“ - 5 Cast Kits &1 Med Boot
FC0003 FastCast OLS 50" - 5 Cast Kits &1 Lg Boot
FC0006 FastCast OLS 56 - 1 Cast Kit
FC0006-8 FastCast OLS 56 - 8 Cast Kits
FC0007 FastCast OLS 56" - 5 Cast Kits & 1 Lg Boot
FC0008 FastCast OLS 56" - 5 Cast Kits &1 XLg Boot
FC0011 FastCast OLS Small CAM Boot
FC0012 FastCast OLS Medium CAM Boot
FC0013 FastCast OLS Large CAM Boot
FC0014 FastCast OLS Extra Large CAM Boot
FC0024 FastCast OLS 4" Cast Roll Replacement




Choose Blue.

To overcome key barriers to healing,
choose Hydrofera Blue classic dressings for:

Broad-spectrum ll Rapid wicking
antibacterial and exudate
protection retention

Autolytic

. Edge effect
debridement =

Learn more. Contact Hollister at 1-888-740-8999
or visit www.hollisterwoundcare.com.

Choose a better path for wound bed preparation.
Choose Blue.

LhdroferaBLUE £ Hollister

The Hollister logo is a trademark of Hollister Incorporated.
Hydrofera Blue is a trademark of Hydrofera, LLC. ©2015 Hollister Incorporated.
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Restore Foams

TRIACT technology is an innovative lipido-colloid formulation in select Restore
wound dressings. The unique composition of TRIACT technology provides a moist
wound interface and allows virtually pain-free removal. It also reduces trauma

to delicate tissue upon removal. Dressings with TRIACT technology are designated
with the TRIACT logo on the packaging.

» Stays in Place Due to Micro-Adherent Technology Facilitating
» Easier Application and Reduced Risk of Maceration

> Excellent Conformability

> Available in Several Types of Dressings

Restore Non-Adhesive Foam, Silver

» Non-Adhesive, Non-Occlusive Antimicrobial
Absorbent Dressing with TRIACT

» May Help to Reduce Infection in Moderately to High
Exuding Partial- and Full-Thickness Wounds

» Super-Absorbent Foam Pad Ensures Drainage of
Exudates and Helps Protect the Skin Around the Lesion
from Maceration

'l
-ﬁ‘-‘ » Soft, Semi-Permeable Backing
» Contains Silver Sulfate
Stock No HCPCS Description Quantity/Box
509345 AB209 4"x 4" 10
509346 A6210 6"x8" 10

Caution: Federal (USA) law restricts this device to sale by or on the order of a physician
or licensed healthcare professional. Refer to Instructions for Use for contraindications,
warnings, precautions, and possible complications.

TRIACT Foam with Silicone Border

» TRIACT Technology helps create a moist, wound-healing interface

> TRIACT Technology helps prevent damage to newly formed
tissue during dressing removal

» Silicone border offers virtually pain-free removal

Stock No HCPCS Description Quantity/Box
550762 AB212 4" x 4" with pad size 2.5" x 2.5" 10
550763 AB212 6" x 6" with pad size 4" x 4 10
550764 A6213 6" x 8" with pad size 4" x 6” 10
550765 AB213 8" x 8" Sacral Pad 5" x 5.5” 10

Restore Foam without Border

» Absorbent Foam Dressing with TRIACT Wound Interface Layer
> Requires Secondary Fixation

’/’ » Can be Cut o Size

» Indicated for Moderate to Heavy Exuding Acute and Chronic Wounds
Stock No HCPCS Description Quantity/Box
509380 A6209 2.5"x2.5" 10
509381 AB209 4"x 4" 10
509382 A6210 6"x6" 10

-
509384 A6210 Heel 4.7" x 7.5" 10




Restore LITE Foam without Border

» Thin, Conformable Non-Adhesive Absorbent Dressing

with TRIACT
» Manages Moderate to Light to Moderately Exuding Acute

and Chronic Wounds

Stock No HCPCS Description Quantity/Box
509393 AB209 25"x2.5" 10
509394 A6210 4"x5" 10
509395 A6210 6"x6" 10
509396 A6210 6"x8" 10

Restore Foam with Silicone Border

" » Absorption of moderate to heavy exudate
4 ) > Protection of difficult wound-sites, peri-wound skin and

‘5': . Dbony prominences

» Simple application, easy removal & patient comfort

Stock No HCPCS Description Quantity/Box
520003 AB212 3.5"x 3.5” with pad size 2.5" x 2.5 10
520005 AB212 5"x 6.2" with pad size 3.4" x 4.6” 10
520000 AB213 7" x 7" with pad size 5.5" x 5.5” 10
520001 AB213 7.3"x 7.4 Sacral Pad 6.1" x 5.7" 10

Restore Foam with Silicone without Border

» Absorption of moderate to heavy exudate

> Protection of difficult wound-sites, peri-wound skin and
\/ bony prominences
» Simple application, easy removal & patient comfort

Stock No HCPCS Description Quantity/Box
520023 AB209 25"x2.5" 10
520025 A6210 4"x5" 10
520027 A6211 6.5"x8" 10
L ,p-\d'l
\‘—"’
520020 AB210 Heel 8" x 5” 10

2 DID YOU KNOW...

Epidermolysis Bullosa Resources Available

Hollister has resources available for those diagnosed with
Epidermolysis Bullosa (EB), including:

o A toll-free hotline: 1.888.EBaid4U

 Healthcare Provider and Patient EB Resource Kits
 EB Resource brochure

 Wound Dressing Application and Selection Guide
e Practical cut-out poster
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Restore Contact Layers

Restore Contact Layer FLEX

l{ 1 » TRIACT formulation promotes non-adherence, and helps

prevent disruption of the healing process during dressing

. removal
» Can Be Shaped to Fit Contours of Deep or Irregular Wounds,
and in Difficult Anatomical Locations

> Virtually Pain-Free Dressing Removal for Enhanced Patient
Comfort

» Forms a Gel in the Presence of Exudate to Help Maintain a
Moist Wound Interface

» Dressing’s Gentle Tack Helps Hold Dressing in Place and
Minimizes Trauma to the Wound Bed

» Can Be Used on a Wide Variety of Wound Types, and in

Conjunction with NPWT
Stock No HCPCS Description Quantity/Box
506487 A6206 2"x2" 10
506488 AB207 4"x 5" 10
506489 AB207 6"x8" 10

Restore Contact Layer, Silver

> Non-Adhesive, Non-Occlusive Antimicrobial Wound
Contact Dressing with TRIACT

» May Help to Reduce Infection in Low to Moderately

o Exuding Partial- and Full-Thickness Wounds
.-‘-.. » Shown to be Effective Against Bacteria Most Frequently

Associated with Wound Infections

> Apply Directly to the Wound and Cover with a Secondary Dressing

» Contains Silver Sulfate

Stock No HCPCS Description Quantity/Box
509341 AB207 4"x 5" 10
509342 AB207 6"x8" 10

Caution: Federal (USA) law restricts this device to sale by or on the order of a physician
or licensed healthcare professional. Refer to Instructions for Use for contraindications,
warnings, precautions, and possible complications.



CalciCare and Restore Calcium Alginates

CalciCare Calcium Alginate CALCICARE IS THE
» Composed of a High G (Guluronic Acid)  BedtballzbAUSER W]

Calcium/Sodium Alginate OF RESTORE
> Soft and Conformable, CALCIUM ALGINATE

Highly Absorbent, and Fast Gelling
» Forms a Moist Environment for Optimal Wound Healing
» Non-Woven Pad is Reinforced for Intact Removal

Stock No HCPCS Description Quantity/Box
529938R A6196 2"x2" 10
529937R A6197 4"x 475" 10
529939R A6197 4"x 8" 5
529940R A6199 1"x 18" Rope 5

Faleifara Paleiym Alginate, Silver

» Composed of a High G (Guluronic Acid) Calcium/Sodium
Alginate

» The Dressings are Soft and Conformable, Highly Absorbent,
and Fast Gelling, as Wound Fluid is Absorbed

» Forms a Moist Environment for Optimal Wound Healing

» Non-Woven Pad is Reinforced for Intact Removal

> Releases Silver lons in the Presence of Wound Exudate

» Effective Barrier to Bacterial Penetration

Stock No HCPCS Description Quantity/Box
529967R A6196 2"x2" 10
529968R A6197 4"x 475" 10
529969R A6199 1"x 18" Rope 5

Caution: Federal (USA) law restricts this device to sale by or on the order of a physician
or licensed healthcare professional. Refer to Instructions for Use for contraindications,
warnings, precautions, and possible complications.

Restore Calcium Alginate

> Highly Absorptive

» Made From Calcium Sodium Alginate, Creating Conformable
Protective Gel When in Contact with Exudate

» Forms Moist Wound Interface

» Remains Intact When Saturated so it is Removed in One Piece

Stock No HCPCS Description Quantity/Box
529938 A6196 2"x2" 10
529937 A6196 4" x4 10
529939 AB197 4"x8" 5
529940 A6199 12" Rope 5

Restore Calcium Alginate, Silver

> Releases Silver lons in the Presence of Wound Exudate
» Effective Antimicrobial Agent Against a Broad Spectrum

of Microorganisms
o » Indicated for Moderate to Heavily Exuding Partial- to
.-.“ Full-Thickness Wounds
» Assists in Maintaining a Moist Environment and Allows
Intact Removal
» Contains Silver Sodium Hydrogen Zirconium Phosphate
Stock No HCPCS Description Quantity/Box
529967 A6196 2"x2" 10
529968 A6197 4" x4.75 10
529969 AG199 1" x 12" Rope 5

Caution: Federal (USA) law restricts this device to sale by or on the order of a physician
or licensed healthcare professional. Refer to Instructions for Use for contraindications,
warnings, precautions, and possible complications.
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CalciCare and Restore Calcium Alginates

Restore to CalciCare Conversion Chart

Restore CalciCare
DEE )] Current SKUs Description 2014 SKUs
Restore Calcium 529938 CalciCare Calcium 529938R
Alginate 2"x 2" Alginate 2"x 2"
Restore Calcium 529937 CalciCare Calcium 529937R
Alginate 4"x 4” Alginate 4"x 4.75”
Restore Calcium 529939 CalciCare Calcium 529939R
Alginate 4"x 8" Alginate 4"x 8"
Restore Calcium 529940 CalciCare Calcium 529940R
Alginate, 12" rope Alginate, 18” rope
Restore Calcium 529967 CalciCare Calcium 529967R
Alginate, Silver 2"x 2" Alginate, Silver 2"x 2"
Restore Calcium 529968 CalciCare Calcium 529968R
Alginate, Silver Alginate, Silver
4"x 475" 4" 4.75"
Restore Calcium 529969 CalciCare Calcium 529969R
Alginate, Silver, Alginate, Silver 18” rope
12" rope
New Product Brands!
You'll notice some new product names and other branding updates
in this catalog. There’s more to come, so keep an eye out and we'll
keep you informed as changes evolve.
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Restore Hydrogel

— > Maintains Moist Healing Environment in Partial-
= and Full-Thickness Wounds
7 > Clear, Viscous Gel

» Up to 72-hour Wear Time

Stock No HCPCS Description Quantity/Box
529974 AB248 Amorphous Gel in Tube 3 0z— Non Sterile 12
529972 A6231 Impregnated Gauze Sponge 4" x 4" — Sterile 15

2 DID YOU KNOW...

Partnering for the Prevention and Management

of Skin Tears.

We are proud to support the International Skin Tear Advisory Panel in
the prevention, assessment, and treatment of skin tears. The support of
Hollister has been provided through an unrestricted educational grant.

An ISTAP Skin Tear Resource Kit has been designed to help implement a
systematic approach to the prevention, management, and treatment of
skin tears.

This information is provided for general medical educational purposes
only. More information is available at www.skintears.org.

IAPW
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Restore Hydrocolloids

Restore Hydrocolloid: Sterile

> Conformable Semi-Occlusive Dressing with Flexible Outer Layer

» Maintains Moist Wound Environment

» Manages Minimal to Moderate Exudate in Partial- and
Full-Thickness Wounds

> Available With or Without Tapered Edges, Specialty Shapes

> Includes Disposable Wound Measuring Guide

Stock No HCPCS Description Quantity/Box
519953 AB234 Without Tapered Edges 4" x 4"

519954 AB235 Without Tapered Edges 6" x 8" 3
519955 AB236 Without Tapered Edges 8" x 8" 3
519956 A6234 With Tapered Edges 4" x 4" 5
519963 A6235 With Tapered Edges 6" x 6" 5
519957 A6235 With Tapered Edges 6" x 8" 3
519958 A6236 With Tapered Edges 8" x 8" 3
519959 AB235 With Tapered Edges/Triangle Shaped 17 sq in 5
519965 A6235 With Tapered Edges/Triangle Shaped 26.5sqin 5

Restore Extra Thin Hydrocolloid: Sterile

> Thinner Semi-Occlusive Dressing with Flexible Backing
» Maintains Moist Wound Environment

» Manages Minimal Exudate in Shallow Wounds

> Helps Protect Skin from Friction Injury

> Includes Disposable Wound Measuring Guide

Stock No HCPCS Description Quantity/Box
519921 A6234 4"x 4" 5
519923 AB235 6"x8" 3
519925 AB236 8"x8" 3

Restore Hydrocolloid with Foam Backing: Sterile

> Occlusive Dressing with White Foam Backing
> For Low Friction Areas with Moderate Exudate
> Includes Disposable Wound Measuring Guide

e

Stock No HCPCS Description Quantity/Box
519930 A6234 4" x 4" 5
519932 A6235 6"x8" 3
519935 AB236 8"x8" 3

2  DID YOU KNOW...

Disposable Wound Guides

Disposable Wound Measuring Guides are
included with all Restore Hydrocolloid
Dressings. To order additional Wound
Measuring Guides, please see page 156.




2 DID YOU KNOW...

¢ Web-Based Learning
Management System

” '/\J _EﬂHHe.EliEEI : « Customizable Tracking
& == and Reporting

A smarter way to learn.

¢ |n-Service Videos
¢ Online Tools

Education Modules include:

» Wound Care Foundation Courses > Pressure Ulcer Program
- Moist Wound Healing - Staging
- Wound Assessment - Prevention
- Wound Documentation - Knowledge Assessment
Skin Tear Courses
Vascular Ulcer Courses
Pain
Wound Bioburden

Some Modules available in Spanish

>
>
>
>

137



138

Restore Wound Cleanser and Skin Care

Restore Wound Cleanser
> Helps Remove Particulate Matter and Other Debris

From Wound Bed
- » No-Rinse Alternative to Saline and Harsh
= Antiseptic Cleansers
Stock No HCPCS Description Quantity/Box
529975 AB260 8 0z pump spray 12
529976 AB260 12 0z pump spray 12

Restore Skin Cleanser

» For Use on Intact Skin
» Cleanses Peristomal and Perineal Skin of Urinary
and Fecal Discharge

» Gentle, Non-Irritating

» Must Be Rinsed
Stock No HCPCS Description Quantity/Box
517210 A9270 8 0z (237 mL) Pump Spray 12

Restore Cleanser & Moisturizer

» Effective Skin Protection for People with Urinary and/
or Fecal Incontinence

L] » Cleanser, Moisturizer, Protective Breathable Barrier for Skin
» Dimethicone-Based
> No Rinse
Stock No HCPCS Description Quantity/Box
529977 AB250 7.5 0z (222 mL) Pump Spray 12
529978 AB250 11.5 0z (340 mL) Pump Spray 12

Restore DimethiCreme Skin Protectant

- - » Dimethicone-Based Protective Breathable Barrier
» » Use on Skin or Mucous Membrane Surfaces Exposed
to Harmful Stimuli
» Moisturizes and Protects
> Not for Use Under Adhesive Products

Stock No HCPCS Description Quantity/Box

529979 AG250 40z (118 mL) Tube 12

Restore Skin Conditioning Creme

] » Moisturizes and Soothes Dry, Flaky Skin
= » May be Used Under Adhesive Products

&

Stock No HCPCS Description Quantity/Box

517220 A6250 4 0z (120 mL) Bottle 12




Demonstra‘ted ‘to Innovation award winners'
remove key barriers ZHO‘B - BLUE
to wound heallng w-:mo
When managing bioburden
i riority.
Hydrofera Blue antibacterial foam seee
° Il;/larljages bioburden 2013
© Exudate management 55
Endoform dermal template en d oform
* Broad-spectrum MMP inhibition? dermal template
» |ntact extracellular matrix The strength of a dermal template.
The simplicity of collagen.

For more information, contact your
Hollister Wound Care representative.
1.888.740.8990 e hollisterwoundcare.com

£ Hollister

' Endoform dermal template 2013 innovation awards Podiatry Today and OWM, and Hydrofera Blue Ready foam 2014 innovation
awards Podiatry Today and OWM.

2 Negron L, Lun S, May BC. Ovine forestomach matrix biomaterial is a broad spectrum inhibitor of matrix metalloproteinases and
neutrophil elastase. Int wound J. 2012 Nov 1.

Caution: Federal law restricts this device for sale by or on the order of a physician or licensed healthcare professional.
Refer to Instructions for Use for contraindications, warnings, precautions, and possible complications.

The Hollister logo is a trademark of Hollister Incorporated. Hydrofera Blue and the Hydrofera Blue logo are trademarks of
Hydrofera, LLC. Endoform is a trademark of Mesynthes Ltd. ©2015 Hollister Incorporated.
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Skin Tear Resources

The ISTAP Skin Tear Resource Kit has been designed to help implement
a systematic approach to the prevention, management, and treatment of
skin tears.

Hollister is proud to support the International Skin Tear Advisory Panel in
the prevention, assessment, and treatment of skin tears. The support of
Hollister has been provided through an unrestricted educational grant.

This information is provided for general medical educational purposes only.
More information is available at www.skintears.org I AP

Skin Tears Defined

A wound caused by shear, friction, and/or blunt force resulting in
separation of skin layers. A skin tear can be partial-thickness (separation
of the epidermis from the dermis) or full-thickness (separation of both the
epidermis and dermis from underlying structures.)!

Skin Tear Risk Assessment Pathway?

RISK FACTORS

GENERAL HEALTH

Chronic/critical disease, polypharmacy, impaired
cognitive, sensory, visual, auditory, or nutrition
MOBILITY

History of falls, impaired mobility, dependent
activities of daily living (ADLs), mechanical trauma
SKIN

Extremes of age, fragile skin, previous skin tears

Note: Items above in bold are HIGH RISK factors

Reassess with Implement Skin Tear Risk
change of status Reduction Program.

See Quick Reference Guide

and/or ISTAP Risk Reduction
Program.’

Take special note of visual
impairment, impaired mobility,
dependent ADLS, extremes of
age, and previous skin tears.

[Reassess with change of status )—




Assess and Manage

Skin Tear Decision Algorithm?

m

ASSESS

CONTROL
BLEEDING

CLASSIFY
APPROXIMATE WOUND EDGES (Measure and
Document)
GOALS OF TREATMENT
¢ Treat the cause *Moist wound healing e Protect periwound
e |mplement prevention ¢ Avoid trauma skin
protocol *Manage the pain *Manage exudate

* Avoid infection

ENT OPTIONS in accordance with local wound management protocols

Type 1: No skin loss Type 2: Partial flap loss Type 3: Total flap loss
Linear or flap tear which Flap cannot be Entire wound bed
can be repositioned to repositioned to cover is exposed

cover the wound bed the wound

References:

1 LeBlanc, K., Baranoski, S. et al. Skin Tears: State of the Science: Consensus Statements for the
Prevention, Prediction, Assessment, and Treatment of Skin Tears. Advances in Skin and Wound Care.
2011;24(9Suppl):2-15.

2 Ellman, C. et al. (2013) Sustained Results: A learning management system platform which
empowers and educates bedside staff.

3 LeBlanc K., Baranoski S., et al. International Skin Tear Advisory Panel: A Tool Kit to Aid in the
Prevention, Assessment, and Treatment of Skin Tears Using a Simplified Classification System.
Advances in Skin and Wound Care. 2013;26:459-476.

www.hollister.com Hollister Incorporated
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Epidermolysis Bullosa Resources

Epidermolysis Bullosa (EB) is a rare genetic connective tissue disorder.
There are many genetic and symptomatic variations of EB, but all share
the prominent symptom of extremely fragile skin that blisters and tears
from minor friction or trauma. Internal organs and bodily systems can
also be seriously affected by the disease. EB is always painful, is often
pervasive and debilitating, and is in some cases lethal before the age of
30. EB affects 1 out of every 20,000 live births and those born with it are
often called ‘Butterfly Children’ because as the analogy goes, their skin is
as fragile as the wings of a butterfly. There is no treatment or cure. Daily
wound care, pain management and protective bandaging are the only
options available.’

Hollister has several helpful tools developed to help educate and guide
those in the medical community as well as patients.

e Healthcare Provider EB Resource Kit
e EB Resource brochures
e Wound Dressing Application and Selection Guide

e Practical cut-out poster
» Demonstrates the various ways to cut dressings for
different body parts

e Patient EB Resource Kit
» This new patient-oriented kit is designed to give families an
“EB starter kit” and includes bandage scissors, a handy tip card,
product samples, EB brochures, and more.

e EB Hotline — 1.888.EBaid4U

e Find us on Facebook and Twitter — Search “EB Resource”

Reference: 1. www.debra.org



Glossary « Wound Care

Abrasion: Wearing away of the skin through some mechanical process
(friction or trauma)

Abscess: Accumulation of pus formed in tissue as a result of infection

Alginate: A highly absorptive dressing derived from brown seaweed

Cellulitis: Inflammation of the tissues indicating a local infection;
characterized by redness, edema, and tenderness

Collagen: Protein found in skin and connective tissue

Debridement: Removal of foreign material and devitalized or
contaminated tissue from a wound

Dehiscence: Separation of wound edges

Denude: Removal or loss of superficial skin layers

Dressing: Any of various material used for covering and protecting wounds

Edema: Swelling

Epidermis: Outermost layer of the skin

Erythema: Diffuse redness of the skin

Eschar: Dead tissue

Excoriation: A scratch or abrasion on the skin

Exudate: Wound fluid or drainage

Friction: Rubbing that causes mechanical trauma to the skin

Full-thickness: Tissue destruction extending through the dermis
to involve subcutaneous level and possibly muscle, fascia, or bone

Granulation: Formation of connective tissue and many new capillaries
in a full-thickness wound; typically appears as red and cobblestoned

Hydrocolloid dressing: A category of wound dressings composed

of materials, such as gelatin, pectin, and carboxymethylcellulose, that
provide a moist healing environment and adhere to the skin around
the wound

Hydrogel: Water- or glycerin-based gels, impregnated gauzes, or sheet
dressings. Hydrogels maintain a moist healing environment and absorb
a minimal amount of wound exudate

Hydrophilic: Attracting moisture

Infection: Invasion and multiplication of microorganisms in the body tissues

Maceration: Softening of tissue by soaking in fluids

Necrotic: Devitalized tissue; may appear yellow and moist, gray,
or dark and leathery

Partial-thickness: Wounds that extend through the epidermis and
may involve the dermis; these wounds heal by re-epithelialization

Peri-wound: The area immediately around the wound

Pus: Thick fluid composed of leukocytes, bacteria, and cellular debris

Shear: Sliding of skin over subcutaneous tissues and bones obstructing
cutaneous capillaries, which may lead to ischemia
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Glossary « Wound Care

Pressure Ulcer Stages:

Suspected Deep Tissue Injury: Purple or

maroon localized area of discolored intact skin or g % bl
blood-filled blister due to damage of underlying = =

soft tissue from pressure and/or shear. The area
may be preceded by tissue that is painful, firm,
mushy, boggy, warmer, or cooler as compared
to adjacent tissue.

Deep tissue injury may be difficult to detect in individuals with dark skin
tones. Evolution may include a thin blister over a dark wound bed. The
wound may further evolve and become covered by thin eschar. Evolution may
be rapid exposing additional layers of tissue even with optimal treatment.

Stage I: Intact skin with non-blanchable
redness of a localized area usually over a bony
prominence. Darkly pigmented skin may not
have visible blanching; its color may differ from
the surrounding area.

The area may be painful, firm, soft, warmer, or cooler as compared to
adjacent tissue. Stage | may be difficult to detect in individuals with dark
skin tones. May indicate “at risk” persons (a heralding sign of risk).

Stage II: Partial-thickness loss of dermis
presenting as a shallow open ulcer with a red
pink wound bed, without slough. May also
present as an intact or open/ruptured serum-
filled blister.

Presents as a shiny or dry shallow ulcer without slough or bruising.
This stage should not be used to describe skin tears, tape burns,
perineal dermatitis, maceration, or excoriation. Bruising indicates
suspected deep tissue injury.

Stage III: Full-thickness tissue loss. Subcutaneous
fat may be visible but bone, tendon, or muscle are
not exposed. Slough may be present but does not
obscure the depth of tissue loss. May include
undermining and tunneling.

The depth of a stage Ill pressure ulcer varies by anatomical location. The
bridge of the nose, ear, occiput, and malleolus do not have subcutaneous
tissue and stage Il ulcers can be shallow. In contrast, areas of significant
adiposity can develop extremely deep stage Il pressure ulcers. Bone/
tendons is not visible or directly palpable.

Stage IV: Full-thickness tissue loss with exposed
bone, tendon, or muscle. Slough or eschar may
be present on some parts of the wound bed.
Often include undermining and tunneling.

The depth of a stage IV pressure ulcer varies by anatomical location.

The bridge of the nose, ear, occiput, and malleolus do not have
subcutaneous tissue and these ulcers can be shallow. Stage IV ulcers
can extend into muscle and/or supporting structures (e.g., fascia, tendon,
or joint capsule) making osteomyelitis possible. Exposed bone/tendon

is visible or directly palpable.

Pressure Ulcer Stages as revised and copyrighted by Nat'l Pressure Ulcer Advisory Panel, Feb., 2007



Pressure Ulcer Stages (continued):

Unstageable Pressure Ulcer: Full-thickness tissue
loss in which the base of the ulcer is covered by
slough (yellow, tan, gray, green, or brown) and/or
eschar (tan, brown, or black) in the wound bed.

Further Description: Until enough slough and/

or eschar is removed to expose the base of the wound, the true depth,
and therefore stage, cannot be determined. Stable (dry, adherent, intact
without erythema or fluctuance) eschar on the heels serves as “the
body’s natural (biological) cover” and should not be removed.

Sinus Tract: A course or pathway which can extend in any direction from
the wound base; results in dead space with potential for abscess formation

Slough: Stringy, necrotic tissue; usually yellow, tan, gray, green,
or brown

Strip: Removal of epidermis by mechanical means, usually tape

Ulcer: Loss of epidermis/dermis or mucous membrane with
definite margins

Undermine: Skin edges of a wound that have lost supporting tissue
under intact skin

Wound: A break in the integrity of the skin; an injury to the body which
causes a disruption of the normal continuity of the body structures

Wound Margin: Rim or border of a wound

Skin Structure:

The epidermis, which is the outermost layer of the skin, is characterized
as follows: avascular, varies in thickness (depending on body location),

a dry structure which sheds cells and replaces itself every 4 to 6 weeks;
approximately the thickness of a piece of plastic wrap

The dermis is located directly beneath the epidermis and is
characterized as follows: provides strength and structural support
through a vascular network of connective tissue blood vessels, nerves,
hair, and nails. Sebaceous glands and sweat glands originate from this
layer, which is thicker than the epidermis

Below the dermis is the subcutaneous tissue which is composed

of major vessels, lymphatics, fat, and connective tissue. This area
provides insulation and nutritional support for the skin. Located below
the subcutaneous tissue are fascia, muscles, tendons, and bone. The
thickness of the dermis and subcutaneous layers vary from person

to person and on different parts of the body
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Glossary « Wound Care

Types of Ulcers

Pressure Ulcers: A pressure ulcer is localized injury to the skin and/or
underlying tissue usually over a bony prominence as a result of pressure,
or pressure in combination with shear and/or friction. A number of
contributing or confounding factors are also associated with pressure
ulcers; the significance of these factors is yet to be elucidated.

Venous Ulcers: These are the most common type of lower-leg ulcers
in ambulatory people. The underlying cause involves vein damage or
an incompetent calf muscle pump action which leads to venous
hypertension. As a result, the blood pools in the lower extremities
causing edema and leakage of fibrinogen and other blood products
into the tissues. Trauma to the area or increased pressure within the
tissues results in ulceration.

Arterial Ulcers: Arterial ulcers result from chronic or acute arterial
insufficiency to the skin and subcutaneous tissue of the lower
extremities. The most common cause is a progressive disease:
atherosclerosis. The precipitating event leading to ulceration is
usually trauma, such as a bumped toe or tight shoes. Arterial ulcers
may occur alone or in combination with diabetes, venous stasis, and
numerous other conditions. Multidisciplinary management of these
patients with early intervention and close monitoring is key to
prevention of more serious complications.

Neuropathic Ulcers: Neuropathic ulcers may occur in individuals with
diabetes, spinal cord injury, Hansen’s disease, or other conditions that
result in loss of sensation in the legs and feet. Diabetic foot ulcers are
most commonly caused by peripheral neuropathy and peripheral
vascular disease. Multidisciplinary management of these patients with
early intervention and close monitoring is key to prevention of more
serious complications.

Reference: Miller-Keane Encyclopedia & Dictionary of Medicine, Nursing & Allied Health - Revised Reprint
7th Edition http://www.us.elsevierhealth.com/dictionary/miller-keane-encyclopedia-dictionary-of-medicine-
nursing-allied-health-revised-reprint-hardcover/9781416026044/
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Educational Resources « Ostomy

All of the Hollister educational materials listed below
are available on our website: www.hollister.com

Educational DVDs Literature No
DVD Set: A Guide to Your Ostomy Surgery (English) 921901
DVD 1: A Guide to Your Ostomy Surgery (Spanish) 922224
DVD 2: A Guide to Living with Your Ostomy (Spanish) 922225
Online Education Program available at www.hollister.com
Living with a Stoma available at www.hollister.com

Case Studies (also available online)

For a complete description and current listing, visit the Nursing Education section
found in the Healthcare Professional portion of our website, www.hollister.com.

Accessories Literature No

ARing is Not Just a Ring: Creative Uses of Ostomy Accessories 910704
(online only)

Using the Adapt Barrier Ring for Stomal Bridges/Rods 910701
(online only)

Use of an Antibacterial Foam Ostomy Dressing 922583
for the Management of Peristomal Skin Problems (online only)

Convexity Literature No
Making Sense of Convexity (online only) 907502
Principles and Techniques in the Use of Convexity (online only) 907634
Using Convexity in the Management of 910314
Complex Clinical Challenges (online only)

Developing Patient Assessment Guidelines For Convexity 922581

(online only)

Nursing Issues Literature No

The Successful Journey Back to Health: Implementing Routine 922587
Follow-up Care for Ostomy Patients (online only)

Pediatrics Literature No
Product Adaptations in Pediatric Ostomy Care (online only) 908803

Psychosocial Adaptation Literature No

Associations between Financial Responsibility for Ostomy 910291
Pouching Systems, Pouching System Change Habits and
Peristomal Skin Condition (online only)

Quality of Life and Influencing Factors in Ostomates Less 910777
Than 24 Months Post-Surgery (online only)

Social Isolation: The Association Between Low Life 910778
Satisfaction and Social Connectivity (online only)

An Association Between Continuing Treatment and 910779
Adaptation in Ostomates (online only)

An Association Between Peristomal Skin Condition 910780
and Life Satisfaction in New Ostomates (online only)

The Relationship Between Body Image, Peristomal Skin 921726

Condition and Quality of Life (online only)
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Educational Resources « Ostomy

Skin Barriers Literature No
Formulating Hydrocolloid Skin Barriers for 907661
pH Control (online only)

A New Skin Barrier Technology to Ease Patient Transition 921722

Preliminary Studies on the Skin Biophysics and Ostomy Skin 910286
Barriers. Part 2 — Feasibility of Measuring Peel Force and Skin

Properties Comparing Peristomal to Normal Surround Skin

(online only)

Preliminary Studies on the Skin Biophysics and Ostomy Skin 910288
Barriers. Part 1 — Relationship between Peel Force, Quantitative
Measures of Skin Damage and Subjective Discomfort using the

Abdomen as the Test Site (online only)

Studies on Skin Biophysics and Ostomy Skin Barriers: 910776
Comparison of Peel Force Measurements and Skin Structure
Between Peristomal and Normal Surrounding Skin (online only)

Peristomal Skin and Tape: Stick to the Facts 921714
Stoma Measuring Guide 903515
Instructional Materials Literature No
Understanding Your Colostomy Booklet 907411
Understanding Your lleostomy Booklet 907412
Understanding Your Urostomy Booklet 907413
Understanding Your Colostomy/lleostomy/ 909961
Urostomy Booklet (English) (online only)

Understanding Your Colostomy/lleostomy/ 910130
Urostomy Booklet (Spanish) (onfine only)

Understanding Your Colostomy/lleostomy/ 910813
Urostomy Booklet (Russian) (online only)

Understanding Your Colostomy/lleostomy/ 921793
Urostomy Booklet (Vietnamese) (online only)

What's Right? — Colostomy (English) (online only) 907590
What's Right? — Colostomy (Spanish) (online only) 907242
What's Right? — lleostomy (English) (onfine only) 907602
What's Right? — lleostomy (Spanish) (online only) 907243
What's Right? — Urostomy (English) (online only) 907603
What'’s Right? — Urostomy (Spanish) (online only) 907244
Can They Still Wiggle and Giggle? Coloring Book 907617
The Day | Got My Stoma (online only) 910497

Caring for Your Child With an Ostomy — Pediatric (English) 907778
Caring for Your Child With an Ostomy — Pediatric (Spanish) 922731

Caring for Your Child With an Ostomy — Pediatric 907778 CA-FR
(French Canadian) (online only)
Caring for your Loved One with an Ostomy 911085



Ostomy Care Tips (Pads of 25) Literature No

Adapt Barrier Rings 910395
Aaapt Convex Barrier Rings 921935
Adapt Lubricating Deodorant 907428
Adapt Ostomy Belt (online only) 911082
Adapt Paste 907249
Adapt Stoma Powder (online only) 907255
Colostomy Irrigation (online only) 907254
Using Convexity 907608
Fistula Management (online only) 910398
Lock ’n Roll Microseal Closure (English) 911126
One-Piece Pouching System (English) 910401
One-Piece Pouching System (Spanish) 911172
Oval Cut-to-Fit Skin Barriers (online only) 910707
Patient Anatomy Guide (online only) 910396
Medical Adhesive Spray/Adapt Remover Spray & Wipes 922470
(online only)

Pouchkins One-Piece Pouching System (online only) 907874
Pouchkins Premie & Newborn Pouching System (online only) 907876
Pouchkins Two-Piece Pouching System (online only) 907875
Routine Care of Your Ostomy (English) 910399
Routine Care of Your Ostomy (Spanish) 910800
Adapt No-Sting Skin Protective Wipe (online only) 922471
Stoma Site Selection (online only) 910134
Two-Piece Pouching System (English) 910402
Two-Piece Pouching System (Spanish) 911173
Two-Piece Pouching System with FormaFlex Skin Barrier 911296
Types of Ostomies (online only) 905756
Universal Catheter Access Port (UCAP) (online only) 921709
Lifestyle Booklets Literature No
Skin Care for your Stoma: 3 Easy Steps to Maintaining 907530
Healthy Skin

Good Eating Habits and Good Health with an Ostomy 907531
Sports and Fitness with an Ostomy 907532
Travel with an Ostomy 907533
Love and Sex for People with an Ostomy 907534
Maintaining Personal and Professional Relationships 907535
with an Ostomy

Pregnancy and Childbirth with an Ostomy 907536
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Educational Resources « Ostomy

Professional Organizations:

Wound, Ostomy and Continence Nurses Society (WOCN)
WWW.WOCN.org
1.888.224.9626

Shadow Buddies Item No
Light Skin Tone Girl 905439
Light Skin Tone Boy 905440
Medium Skin Tone Girl 905441
Medium Skin Tone Boy 905442
Dark Skin Tone Girl 905443
Dark Skin Tone Boy 905444
Additional Resources Item No
Choosing your Ostomy Products 922514
Choosing your Ostomy Products (Spanish) 922645
Stoma Model (White Plastic) 858674

Consumer Resources

American Cancer Society (ACS)
WWW.Cancer.org

Brenda Elsagher’s Website:
www.livingandlaughing.com

United Ostomy Associations of America, Inc. (UOAA)
WWW.LI0aa.org

1.800.826.0826

Crohn’s and Colitis Foundation of America (CCFA)
Www.ccfa.org

1.800.932.2423

Inspire

WWW.inspire.com

Friends of Ostomates

www.fowusa.org

Get Your Guts In Gear

www.ibdride.org

1.866.9iGOTGUTS (944.6848)

Shadow Buddies

www.shadowbuddies.org

1.913.642.4646

Youth Rally Committee

www.rallydyouth.org

150



Educational Resources « Continence Care

People First.
Resource Center.

For Educational Materials

www.hollisterpeoplefirst.com/ % HOlliSter

people
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Educational Resources « Bowel Care

Educational Materials Literature No
ActiFlo Pocket Guide 911320
ActiFlo Quick Reference Care Tips 911321
ActiFlo Irrigation Care Tips 911322
Instaflo Quick Reference Insertion Care Tips 911310
InstaFlo Quick Reference Care Tips 911256
InstaFlo Points to Remember 921821
Video Resources Literature No
ActiFio Indwelling Bowel Catheter Instructional DVD 922292
(also online)

Application of Drainable Fecal Collector DVD (also online) 921851
InstaFlo Bowel Catheter Instructional DVD (also onling) 922293
Journal Reprints Literature No

Fecal Containment in Bedridden Patients: Economic Impact 910273
of Two Bowel Catheter Systems (Kowal-Vern et al., 2009)

Clinical Utility and Economic Impact of Introducing 910048
a Bowel Management System (Echols et al., 2007)
The Effect of a Pressure Ulcer Prevention Program 908820

and the Bowel Management System in Reducing Pressure
Ulcer Prevalence in an ICU setting (Benoit & Watts, 2007)

A Nonsurgical Means of Fecal Diversion: 908955
The Zassi® Bowel Management System (Keshava et al., 2007)
Understanding Recent Regulatory Guidelines for 910129

Hospital-Acquired Catheter-Related Urinary Tract
Infections and Pressure Ulcers (Thomas-Hess & Rook, 2007)

Clinical Application of Continent Anal Plug in Bedridden 908819
Patients with Intractable Diarrhea (Kim et al., 2001)

Clinical Poster Reprints Literature No
Odor Barrier Performance of Bowel Catheter Online Only
Collection Bags (Hantke, 2010)

Standardized Practice for the Administration of Rectal Online Only

Lactulose in Hospitalized Patients with Hepatic
Encephalopathy (Tucker, 2009)

Economical and Clinical Advantages of Better Online Only
Bowel Management in Hospitalized Patients
(Downey & Goedvolk, 2009)

The Use of Irrigation with an Indwelling Bowel Catheter Online Only
in a Critical Care Setting (Barnett et al., 2009)
Fecal Containment Using Indwelling Bowel Catheters Online Only

to Potentially Prevent Multidrug-Resistant Organism
Nosocomial Infections (Barnett et al., 2009)

Utilization of Indwelling Bowel Catheters External Online Only
to Intensive Care Unit (ICU) (Koenig et al., 2009)

http://www.hollister.com/us/bm/ibc/clinical_evidence/



Educational Resources « Bowel Care

Clinical Poster Reprints (continued) Literature No

A Nurse-Driven, Evidence-Based Project: How CNS Online Only
Collaborative Partnerships Facilitated the Introduction

and Implementation of an FDA-Cleared Bowel Management

System at One Healthcare Network (Maille & Morrison, 2009)

Comparison of Two Indwelling Bowel Catheters on Online Only
Economic Impact by Number of Bed Linen and Dressing
Changes Per Day (Powers et al., 2009)

Comparison of Economic Impact of Bed Linen Changes Per  Online Only
Day of Two Indwelling Bowel Catheters (Powers et al., 2009)

Using a Catheter-Based Bowel Management System Online Only
to Promote Skin Health (Hughes, 2007)
Managing Fecal Incontinence in a Rehabilitation Patient Online Only

with Neurogenic Bowel (McLean, 2007)

Medication Delivery Via Indwelling Bowel Access Device Online Only
Plays Critical Role in Critical Care (Still & Wilds, 2007)

Utilization and Benefits of an Indwelling Bowel Catheter: Online Only
Achieving Maximum Performance (Zaletel, 2007)

Specialty Organizations
Wound, Ostomy and Continence Nurses Society (WOCN)

WWW.WOCN.0rg
1.888.224.WOCN (9626)

American Burn Association

www.ameriburn.org

1.312.642.9260

Association for Professionals in Infection Control and
Epidemiology (APIC)

WWW.apic.org

1.202.789.1890

Society of Critical Care Medicine (SCCM)
WWW.SCCM.Org

1.847.827.6869

National Pressure Ulcer Advisory Panel
WWW.Npuap.org

1.202.521.6789

American Association of Critical Care Nurses (AACN)
WWW.aacn.org

1.800.899.AACN (2226)

http://www.hollister.com/us/bm/ibc/clinical_evidence/
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Educational Resources » Tube Fasteners

Educational Materials Literature No
AnchorFast Oral Endotracheal Tube Fastener Care Tips 921758
Anchorfast Guard Oral Endotracheal Tube Fastener Care Tips 922222
Video Resources Literature No
How to Apply the AnchorFast Oral Endotracheal Tube 921874
Fastener DVD (also online)

How to Apply the Anchorfast Guard Oral Endotracheal 922223
Tube Fastener DVD

Horizontal Drain Tube Attachment Device: An Alternative Online Only
to Sutures and Tape

Vertical Drain Tube Attachment Device: An Alternative Online Only
to Sutures and Tape

Journal Reprints Literature No
Stable and Secure: Anchorfast Oral Endotracheal 910793
Tube Fastener (Hewitt et al., 2009)

Retrospective Review of the Reduction of Oral Pressure 922832

Ulcers in Mechanically Ventilated Patients
(Zaratkiewicz et al., 2012)

Clinical Poster Reprints Literature No

The Cost of Mechanical Ventilation: Reductions Due 921840
to the Use of a Simple Endotracheal Tube Fastener
(Hewitt et al., 2011)

Alternative Approach to Prevent Lip Pressure Ulcers 911070
in the Intubated Patient (Veneman et al., 2010)
Utilization of AnchorFast Oral Endotracheal Tube Fastener 910991

to Reduce the Incidence of Lip Ulcers (Miller et al., 2009)

Specialty Organizations
American Association for Respiratory Care (AARC)

WWW.aarc.org

1.972.243.2272

Wound, Ostomy and Continence Nurses Society (WOCN)
WWW.WOCN.org

1.888.224.9626

Society of Critical Care Medicine (SCCM)
WWW.SCCM.Org

1.847.827.6869

National Pressure Ulcer Advisory Panel
WWW.npuap.org

1.202.521.6789

American Association of Critical Care Nurses (AACN)

WWw.aacn.org
1.800.394.5995

http://www.hollister.com/us/bm/ibc/clinical_evidence/



Virtually Awesome.

Wound Care
Education

Web-Based Learning Management System
A smarter way to learn.

ConnectEd is a new Web-based education resource from
Hollister Wound Care that is transforming the way bedside nurses
learn about advanced wound care.

Unlike other systems, ConnectEd can be integrated into
existing learning management systems and provides customizable
tracking and reporting documentation.

For more information visit www.HollisterWWoundCare.com/Connect-Ed
or call your Hollister Wound Care representative today.
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Educational Resources « Wound Care

Educational Materials Literature No
Endoform dermal template Brochure 922207
Endform dermal template Application Guide 922350
FastCast OLS Brochure 922780
Restore Wound and Skin Care Family Brochure 911056
The Use and Efficacy of Silver Dressings 910751
Contact Layer Brochure 921818
Wound Dressing Selection Guide/Poster 911292
Foam and Specialty Dressings Brochure 911038
CalciCare Calcium Alginate Brochure 922571
Create the Shape Poster (foam dressing cutting guide) 911146
Skin Tear Algorithm Pocket Card 922438
Skin Tears: State of the Science: Consensus Statements 921822

for the Prevention, Prediction, Assessment, and Treatment
of Skin Tears

The Role of a Silver Releasing Lipido-Colloid Contact Layer in -~ 910548
Venous Leg Ulcers Presenting Inflammatory Signs Suggesting

Heavy Bacterial Colonization: Results of a Randomized

Controlled Study

Use of a New, Flexible Lipidocolloid Dressing on Acute and 921817
Chronic Wounds: Results of a Clinical Study

Hydrofera Blue Classic Brochure 922782
Hydrofera Blue Classic Application Guide 922615
Hydrofera Blue Clinical Monograph 921638/922206
Hyadrofera Blue Inservice Video DVD 921763
Measuring Tools Literature No
Restore Wound Measuring Guide, Small 874366
Restore Wound Measuring Guide, Large 874367
Wound Measuring Guide, 6" ruler 908892
Pain Assessment Scale 910132
ConnectEd Educational Resources Literature No
ConnectEd Brochure 921784
ConnectEd Course Selection Guide 921785

Product Inservice Tools are available through your
Hollister sales representative
Algorithms, Protocols, and Other Educational Tools are available on our website,

www.hollisterwoundcare.com. For a complete description, visit the Educational
Resources portion of our website, or contact your Hollister sales representative.

EB Educational Resources Literature No

Observation of the New Flexible Lipido-Colloid Contact Layer* 922012
in the Local Treatment of Hereditary Epidermolysis Bullosa Lesions

EB Dressing Guide 911071

Contact our special EB Resource hotline at 1.888.EBAIDAU with questions or needs
specific to epidermolysis bullosa (EB). Additional resources including clinical posters
are available on our website, www.hollisterwoundcare.com. For a complete
description, visit the EB Resources portion of our website.



Clinical Poster Reprints

Hydrofera Blue Foam Dressings
Process Improvement: Second Degree Burns Treated

with a Highly Absorbent Bacteriostatic Foam Impregnated

with Methylene Blue and Green

Bacteriostatic Dressing Use in Conjunction with an
Enzymatic Debriding Agent to Facilitate Improved
Wound Outcomes in a Geriatric Population

Case Review of the Clinical Use of an Antimicrobial
PVA Foam Dressing

The Effect of Various Wound Dressings on the Activity
of Debriding Enzymes

A Comparison of Two Antimicrobial Dressings: A Randomized
Prospective Trial Comparing PVA Foam with Two Organic

Pigments to a Silver Based Wound Dressing

Case Study Review: Use of an Absorbent Bacteriostatic
Dressing for Multiple Indications

Wound Care Challenges and Opportunities with Elderly Patients

Restore Foam Dressings

Leg Ulcers and a new Micro-Adherent Absorbent Dressing

Pressure Ulcer Treatment: Changing Formulary,
Changing Practice and Wound Care

Restore Contact Layer FLEX

Benefits of a Flexible Non-Adherent Lipido-Colloid Contact
Layer Used in Conjunction with Negative Pressure Wound

Therapy (NPWT)
Restore Contact Layer
What is the Cost of Pain? A Quantitative Model

Evaluating a New Non-Adherent Contact Layer in the
Treatment of Skin Tears

Simple Changes in Wound Trauma Management Yield
Significant Benefits for Everyone

Using a Novel Contact Layer for the Management of
Epidermolysis Bullosa Skin Lesions

Assessment of a New Contact Layer in the Local
Management of Pediatric Wounds: Results
of a European Clinical Study

Use of Negative Pressure Wound Therapy with a New
Wound Contact Layer: Results of a Clinical Evaluation
Use of a Novel Contact Layer in Wound Care

Clinical Evaluation of a New Contact Layer Dressing

for the Local Management of Acute and Chronic Wounds
The Role of “Touch” in the Assessment of New Wound
Care Dressings

Clinical Evaluation of Non-Adherent Contact Layer and
Foam Dressings with and without Silver for the Local
Management of Acute and Chronic Wounds

Literature No

922066

921788

921884

921636

921644

921789

921790

911075
911208

921788

910489
910483

910487

907990

907984

907982

907978
909916

909918

910644
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Educational Resources « Wound Care

Clinical Poster Reprints (continued) Literature No

Restore Contact Layer, Silver

A Cost Comparison of a Silver, Pain-free Donor Site
Dressing vs. a Traditional Donor Site Dressing

Maximizing Reimbursement for Wound Care is Crucial
to the Survival of the Agency: One Agency’s Success Story

Use of a Contact Layer with Silver Under a Negative
Pressure Dressing

Minimizing Complications During Dressing Changes of a
Bilayer Skin Equivalent in the Treatment of Venous Leg Ulcers

Clinical Evaluation of Non-Adherent Contact Layer and
Foam Dressings with and without Silver for the Local
Management of Acute and Chronic Wounds

Hospital-Acquired Surgical Site Infections: Considering
a Simple, Effective, Versatile Silver Technology
to Improve Patient Care

Restore Foam Dressings

Leg Ulcers and a New Foam Dressing:
Results of Two French Multicenter Clinical Studies

Use of a Novel Foam Dressing with Non-Adherent
Contact Layer in Leg Ulcer Management

Clinical Evaluation of a New Foam Dressing with and
without Adhesive for the Local Management of Acute
and Chronic Wounds

Clinical Trial of a New Foam Dressing for the Local
Management of 10 Donor Sites

Clinical Evaluation of Non-Adherent Foam Dressings
with and without Silver for the Local Management
of Split-Thickness Donor Sites

Clinical Evaluation of Non-Adherent Contact Layer and
Foam Dressings with and without Silver for the Local
Management of Acute and Chronic Wounds

Restore Foam Dressings Silver, Non-Adhesive

Critical Colonization and a New Absorbent Dressing
Impregnated with Silver Salts: Results of a Clinical Study
in the Management of Leg Ulcers

Application of Silver Foam Dressings to Donor Sites in
Immunocompromised Patients Can Enhance Wound Healing

Use of a Non-Adhesive Silver Absorbent Foam Dressing
Underneath an Unna Boot

Clinical Evaluation of Non-Adherent Foam Dressings
with and without Silver for the Local Management of
Split-Thickness Donor Sites

Clinical Evaluation of Non-Adherent Contact Layer and
Foam Dressings with and without Silver for the Local
Management of Acute and Chronic Wounds

Restore Calcium Alginate with Silver

Visualizing the Death of Wound Microorganisms Within
a Silver Alginate Dressing

910472

910485

910278

910469

910644

910654

907986

907980

909915

909917

910689

910644

907992

910275

910317

910689

910644

921762



Index e Stock Number

Clinical Poster Reprints (continued) Literature No
Easy Does It: Evaluation of a Silver Alginate vs. Silver Fiber 910655
Dressing in Cost Effectiveness and Ease of Use

Restore TRIO Absorbent Dressings

Emergency Department Treatment of Low-Exuding 911074
Traumatic Wounds, sutured or otherwise, with

a Ready-to-Apply Lipido-Colloid Dressing

The Role of Ready-to-Use, Lightly Absorbent Dressings with 911078
Non-Adherent Contact Layer as Primary Wound Care Dressing

Clinical Evaluation of a New Absorbent, Non-Adhering 910982
Dressing with and without Adhesive for Local

Management of Acute and Chronic Wounds

Practice Innovation; Skin Tear Treatment that Changes Outcomes 921664

ConnectEd Learning Management System

Assessing Knowledge Retention, Quality Patient Outcomes, 922004
and Empowerment of Nurses in Wound Care and Documentation

via the Use of a Learning Management System

A Novel Approach to Improving Wound Outcomes 911077
Through an Evidence-Based Learning Management System

Other Topics

WOCN Workgroup: Engaging the Power 911207
of Standardization in Wound Care

Specialty Organizations

DebRA of America, Inc. National Pressure Ulcer
www.debra.org Advisory Panel
1.866.332.7276 WWw.npuap.org

The Association for the 1.202.521.6789
Advancement of Wound Care (AAWC) American Diabetes Association

www.aawconline.org www.diabetes.org
1.866.229.9999 1.800.DIABETES (342.2383)
Wound, Ostomy and Continence National Spinal Cord Injury
Nurses Society (WOCN) Association

WWW.WOCN.Org www.spinalcord.org
1.888.224.9626 1.800.962.9629

American Academy of Wound U.S. Department of Health
Management (AAWM) and Human Services Centers
WWW.aawm.org for Medicare & Medicaid Services
1.202.521.0368 www.cms.hhs.gov

American Burn Association National Guideline Clearinghouse
www.ameriburn.org www.guideline.gov
1.312.642.9260 European Wound Management
Wound Healing Society Association

www.woundheal.org Www.ewma.org
1.763.765.2377 +45 7020 03 05
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Index « Stock Number

Stock No Page(s)  Stock No Page(s)  Stock No Page(s)
TOX e 96  1910%............ 25 519923 ......... 136
0 96  1915x............ 27 519925 ......... 136
1120 oo 14 1920x............ 26 519930 ......... 136
1140%. ..o 17 1925 ...t 28 519932 ......... 136
1150%. ..o 18 1930%............ 25 519935 ......... 136
1340%. . ....... 17, 31 1935%. ..o 27 519953 ......... 136
1350%. ... ... .. 19, 31 1940x. . ... 26 519954 ......... 136
139X .. 18, 31 1950X. ..o 28 519955 ......... 136
1410 ..o 16 31003 .......... 109 519956 ......... 136
1420, ..o 15 31005 .......... 109 519957 ......... 136
143%. oo 75 31009 .......... 109 519958 ......... 136
1430, ..o 16 32004 .......... 108 519959 ......... 136
1440%. ... 30 32005 .......... 108 519963 ......... 136
1450%. ..o 30 32006 .......... 108 519965 ......... 136
1460%. . ....... 14,67 32007 .......... 108 520000 ......... 131

1470%. ..o 15 318Xl 76 520001 ......... 131

1480%. ... 17 322l 74 520003 ......... 131

L) G 30 32K 74 520005 ......... 131

1510, ..o 14 327l 75 520020 ......... 131

L740) 15 33016 .......... 108 520023 ......... 131

1530%. ..o 17 332t 75 520025 ......... 131

1540%. . ... ... 18 334x............. 72 520027 ......... 131

1550X. oo 19 340%............. 73 B52931X... ...l 126
1560%. ..o 14 360X............. 74 529937 ......... 133
1580X. ..o 17 366X............. 70 529938 ......... 133
1590%. ..o 19 370%............. 70 529939 ......... 133
1610%. ..o e 15 372 69 529940 ......... 133
1640%. . ...l 16 373t 71 529967 ......... 133
1796 ... 47 3TM . 70 529968 ......... 133
1800 ............ 200 376Xl 69 529969 ......... 133
1801%. ..o 22 3761 ... 57 529972 ......... 135
1810, ..o 21 3774 ... 58 529974 ......... 135
181X 20 3777 ...l 55 529975 ......... 138
1812 .o 21 3778 ... 55,81 529976 ......... 138
1813 .o 200 3795 ......... 56,81 529977 ......... 139
1814, ..o 21 379 ......... 55,81 529978 ......... 139
1815%. ..o 67 3797 ......... 56,81 529979 ......... 139
1816X. ..o 21 3799 ... 57 550762 ......... 130
1817%. o 21 380Xl 71 550763 ......... 130
1818 oo 200 38l 71 550764 ......... 130
1819 ..o 200 38Kl 73 550765 ......... 130
1820%. . ..ov 21 383 71 7. 91

1828X. ..o 200 3BMX...ial 72 716X 75
18282 ........... 57 387Xl T2 T3XK . 91

1829, ..o 200 3Bl 17299 63, 68
18292 ........... 57 390X............. 73 7300 ......... 63, 68
1832¢. oo 22 506487 ......... 132 7331 .. 65
1833%. ..o 23 506488 ......... 132 7Aoo 91

1835X. ..o 23 506489 ......... 132 7700 ... 66
1836X. ..ot 22 509341 ......... 132 77x.oooo 64
1837%. oo 22 509342 ......... 132 7720 o 67
1838X. ..o 23 509345 ......... 130 7723 ... 67
18382 ........... 57 509346 ......... 130 7724 ... ... 68
1839 ..o 23 509380 ......... 130 7728 ... 68
18392 ........... 57 509381 ......... 130 773l 64
18402 ........... 58 509382 ......... 130 7730 ......... 63, 81

18412 ..., 58 509384 ......... 130 7733 ......... 64, 81

1873%. oo 23 509393 ......... 131 7736 ... 65
1875%. oo 23 509394 ......... 131 7737 . 63
1890X. ... 24 509395 ......... 131 7740 ... 68
1891%. ..o 24 509396 ......... 131 7760 .......... .. 63
1892, .o 24 517210 ......... 138 7766 ... 66
1900%. . ..ovovee 25 517220 ......... 138 7767 ... 66
1905%. . oo 27 519921 ......... 136 78x¢.......oil 61



Stock No Page(s)  Stock No Page(s)  Stock No Page(s)
7800 ... 66 8531 ............ 34 9BXKK . 93
7805 ....... .. 61,81  854xx............ 42 9645 ... 99
7806 ......... 61,81 855X............. 38 9655 ............ 99
7815 . 61,81 8551 ............ 34 9K 93
78500 ........... 63  857X............. 4 970X ... 80
78501 ... 63 858X............. 52 97AXK............ 98
7905 .. ... 66  85%............. 52 975XK............ 98
7906 ......... 63,81  861X............. 52 976XX............ 98
7910 ... 66 8631 ............ 35 977X 80
N7 o 64  863K............. 38 9779 ... 65, 80
79300 ........ 61,81 8631 ............ 3% 9780 ........... 114
79301 ... 61 8641 ............ 3B 9781 ... 114
79400 ... 61  864X............. 39 9782 ... 114
79520 ........ 61,81 8651 ............ 3% 9785 ... 114
79530 ........ 61,81  866X............. 44 9786 ........... 114
79540 ........ 61,81  867X............. 4 9788 ... ... 113
T95XK. oo 61 872 ............ 69 9799 ........... 113
796X, .. 61,85  873X............. 70 9800 ........... 113
79601 ....... 61,101 8731 ............ 70 9805 ............ 99
79602 ....... 61,101 874x............. 70 9811 ... 101

79603 ....... 61,101 875%............. 69 9814 ............ 99
80XK. . 39 877Xl 70 9821 ........... 110
80070 ........ 45,80 8770 ............ 65 9822 ........... 110
80110 ........ 45,80 8800 ............ 64 9823 ........... 110
8031 ... 36 8801 ............ 64 9839 ..... 66, 81, 101

8081 ...t 35 88 719840 ........... 101

BIXK. v 39 883XX. .. 39 9873 ... 101

81070 ........ 45,80 88300 ........... 36 9880 ........... 110
81110 ........ 45,80 88302 ........... 37 BOX... 97
8131 ... 36 88AX............ 39 BoxB............ 97
8181 ......... .. 35 88400 ........... 36 FCO0OT ......... 128
821xx. .. ... 43,47,53 88401 ........... 37 FCO024 ......... 128
82100 ........... 46 88402 ........... 37 FCO001-8........ 128
823K 46 88501 ........... 37 FCO002 ......... 128
82300 ........... 46 887XX............ 41 FCO003 ......... 128
82302 ........... 46 88700 ........... 37 FCO006 ......... 128
824X ... 43,53 88800 ........... 37 FCO006-8........ 128
82400 ........... 46 8MX............. 38 FCO007 ......... 128
82402 ........... 46 890X............. 72 FCO008 ......... 128
82500 ........... 46 891X............. 42 FCOO11 ......... 128
826XX. .. 47 895XX....... ... 41 FCO012 ......... 128
8261X. ... 45 896X............. 43 FCOO13 ......... 128
8262XX. . ... ... 43,53 8901 ............ 34 FCOO14 ......... 128
827X . 42,53 89001 ........... 48 HB2214 ......... 127
828X, ......... 44,53 89002 ........... 49  HB4414......... 127
829X, ... 44,53 89003 ........... 49  HB6G14......... 127
8261%......... 45,53 89004 ........... 49 HBTO906 ........ 127
8331 ... 34 89005 ........... 49 HBHD4450....... 127
834X, ... 72 8931 ............ 34 HBHD6675....... 127
8371 ... 34 898X............. 42 HBRS2520 ....... 127
8381 ............ 35 89N 44 HBRS4520 ....... 127
843K, .. 48 90XKX .. 95  HBRS8820....... 127
844X, ... 47 9K 95  HBRF2258 ....... 127
8440 ............ 47 910K .. 98  HBRF2650 ........ 64
8450 ............ 47 920 ...l 98  HBRF4414 ....... 127
8460 ............ 47 93K 93 HBRF4475....... 128
846X. .. ... 47 9342 ..., 100

BATX. .o 48 9343 ........... 100

848X, ... 48 9345 ........... 100

849, ... 48 9346 ........... 100

850X. .. 52 9348 ............ 99

851X, 52 9349 ............ 99

852X, . 52 94K ... 93

853X, ... 38 95K ... 93
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Index ¢ Product Name

Name Page(s)
CHFIO ACCESSOMIES.........ccooovvvve e 109
ActiFlo Catheter Kits with Disposable Odor-Barrier Collection Bags...................... 108
Adapt Odor Eliminator and LUDFCAN..........c.cceviieiiieiiceeee s 63
Adapt OStOMY BEILS ........cvviviieiiciciceies e 63
Adapt SKIN Barrier ACCESSOMES .....vuvvrrrriisiirieriersisesesessssseses s 61
Adapt SKIN BAITIEr PASTE.........cvvevveerereiscsssie s 61
Adapt Stoma Powder.... .63
Adapt Adhesives and REMOVETS............covcvvvievenrinns .63

Advance Plus Pocket Touch Free Intermittent Catheter ... .93
Advance Plus Pocket Touch Free Intermittent Catheter Kit...........cccooovvviivriiennnn, 93
Advance Plus Touch Free Intermittent Catheter ..., 93
AnchorFast Guard Oral Endotracheal Tube Fastener.........c..coovevvrivivvnerniinnns 113
AnchorFast Oral Endotracheal Tube FaStener ... 113
AnchorFast Replacement Neck Band Straps...........ccocviirevrniiineieieiens 113
Apogee Family of Intermittent Catheters..........ccovvviieeiiiiieecceees 96
Apogee HC Hydrophilic Intermittent Catheter ...........cccovvveveiieiieieeieee, 95
Apogee Plus Intermittent Catheter............ocovvvvrireeieiieieeses e 97
Bedside Drainage Collection System with Anti-Reflux Valve...............o........ 66, 101
CalciCare Calcium AIGINATE ............rveveereeeeeeeeeeesseeeee e 133
CalciCare Calcium AlGINALE, SIVET...........ccvvieririieiesiee e 133
CenterPointLock CloSEd POUCHES ............cuiiiiiiiiiecereics s 72
CenterPointLock Drainable POUCKES ..o 71-72
CenterPointLock Flat Skin Barriers with Floating Flanges.............cccovovvininnn. 69-70
CenterPointLock and Karaya 5 Legacy SKUS .... . 16-77
CenterPointLock SOMA CaD ....cvvvvcieiiciceies s 73
CenterPointlock Urostomy Pouches. . 12-73
COlleCtor Bags (OtNEr.........vrierieieiiieieieisieses e 109
Convex Skin Barriers with Floating FIanges. .........ccovcvvvininniniieis 70-71
Drainable POUCH CIAMP ........cvoireeeveeeececceeseseseeeeeessee s 65
Drain Tube AttaChment DEVICE. ........cccvviveiiieieiieeiceiee e 114
Endoform Dermal TEMPIALe...............oovvvvereseeeeeereeseeeeeseesseeeee e 126
Everyday Male External Catheter ..........ccovvreierieirieieiee s 98
Extended Wear Male External Catheter...........coovvvvinrviniieseeeeees 100
EXEENSION TUDING ..ot s 100
Fabric Leg Bag SHaPS.............ovvvveeeisereeeeseeeeeereeseseseeseesseeseeeeesseese e 100
FaSICaSt OLS TCC ..o s 128
FECAI COIBCTONS ... vt 110

Feeding Tube Attachment Device.

Female Urinary Pouch External Collection Device.. 101
Flextend (extended wear) SKin BarTier ..........ccovvvieeiiiieeceeeeneeen e 64
Hollister Universal Catheter ACCESS POM.............c....oirvvveeeessereecieesseereeesssssneens 65
Horizontal Tube AttachmMeNnt DEVICE ...........cveevireiieiieiie e 114
Hydrofera Bl FOAMS ..........cc.ccviiereiiiiiieecseeese e 64,127



Name Page(s)

115taFI0 CAtNELEr Kit..............oooeeeeeeeeeeee e 108
InView Male External CathBterS ..o 98
rrigation PrOGUCES ......cvvveiieiiceicee e 67-68
[MFIQALOr SIBEVE ....vvevvvicviciic e 73
Karaya 5 Closed POUCKES ..........o.....oorreveeeieeseeeeecceeeeeeeeceeess e
Karaya 5 Drainable Pouches.

Karaya 5 UroStomy POUCHES ........ccvviiiriiiieieesst e
Latex-Free EXEENSIon TUDING ............eveveeresiseeeeeseeeeeeseesseeseeeeesseesec e 105
LOOP OStOMY BIAGE ....vvvevvrireisises e 66
M9 Cleaner/DECIYSIAlIZEN ..ot 64
M9 0dOr ElIMINGLOTS. ...cveviviiii e 64
Male Urinary Pouch External Collection DEVICE...........cccovverieeriieisieeicieennas 101
New Image CloSed POUCKES...............coovvvveeieeriereecseeseeeeeeeseeeseec s 22-23
New Image Convex Skin Barriers with Integrated Floating Flanges ............... 17-19
New Image Drainable POUCNES .........c.oviviieieieiceceeeeee e 20-21
New Image Flat Skin Barriers with Integrated Floating Flanges..............c........ 14-19
New Image High Output Drainable POUCKES ..........covviiieiiiicececees e 22
New Image Non Sterile Kits — Drainable.............cccoceveviviiciiiiiceesieseeans 25
New Image Non Sterile Kits — UroStOmY ........c.evvevrvinrienesiie s 26
New Image Sterile Kits — Drainable.............ccovviiiiiiiisecenns 27
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related to:
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Secure Start services: 1.888.808.7456

For dealer, distributor, institution and
pharmacy questions or orders:

1.800.323.4060
FAX 1.847.680.1017
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